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ABSTRAK 
 
 
 

Nama : Rifky Netriady 
Program Studi : Teknik Sipil 
Judul : Kajian Keruntuhan Jembatan Krasak Akibat Kebakaran 

Truk  Tangki Bahan Bakar Dengan Memperhitungkan 
Bentuk Sebenarnya Dari Elemen Diagonal Rangka Utama 
Dan Pengaku Atas Jembatan 
 

 
Pada tanggal 10 Mei 1990, terjadi peristiwa runtuhnya sebuah jembatan di 
atas Kali Krasak akibat kebakaran truk tangki bahan bakar. Sampai saat ini 
masih terjadi kesimpangsiuran tentang mengapa dan bagaimana sebenarnya 
keruntuhan tersebut dapat terjadi.  
Prof. Ir. Sidharta S. Kamarwan, dalam penelitiannya menyimpulkan bahwa 
keruntuhan disebabkan turunnya batas tegangan leleh baja menjadi 50% 
akibat kenaikan temperatur hingga 300 oC yang mengakibatkan struktur 
rangka atas tidak mampu menahan gaya tekan yang terjadi, kemudian 
dilanjutkan oleh Arya Perdana menyimpulkan bahwa  kegagalan struktur 
terjadi pada temperatur rata-rata 1125°C.  
Setelah membaca laporan tersebut, penulis merasa tertantang untuk 
meneruskan hasil penelitian beliau lebih lanjut, yaitu dengan merekonstruksi 
peristiwa tersebut melalui membuat prototype percobaan kemudian dari hasil 
percobaan tersebut dilanjutkan dengan simulasi menggunakan program 
ANSYS V11.0, salah satu program simulasi terbaik berbasis analisa elemen 
hingga.  
Percobaan dengan prototype berbasis pada teori keserupaan dengan 
menggunakan material aluminium dapat memberikan petunjuk bahwa 
deformasi struktur yang terjadi dimulai akibat terjadinya kenaikan temperatur 
pada elemen rangka jembatan yang diikuti dengan buckling pada beberapa 
titik lokasi.  
Kegagalan struktur mulai terjadi pada suhu 600 °C memiliki nilai modulus 
elastisitas sebesar ±62000 Mpa, pada deformasi maksimum, nilai modulus 
elastisitas dari simulasi model jembatan krasak adalah 22000 MPa (11% dari 
Modulus Elastisitas awal). 
Kata kunci: 
Analisa Balik, Buckling, Prototype, Teori Keserupaan, Jembatan Model, 
Jembatan Krasak, Modulus Elastisitas. 
 

 

 
  

Kajian keruntuhan..., Rifky Netriady, FTUI, 2012



 vii 

Universitas Indonesia 

ABSTRACT 
 
 
 

Name : Rifky Netriady 
Study Program : Postgraduate of Civil Engineering 
Judul : The Study Of The Krasak Bridge Collapse Due Fire 

Truck Fuel Tank With Taking Shape Actually From 
Diagonal Element Main Frame And Top Stiffness Of 
Bridge 
 

 
On May 10, 1990, events in the collapse of a bridge Krasak by fire truck fuel 
tank. Until now there is still confusion about exactly why and how the 
collapse could occur. 
Prof. Ir. Sidhartha S. Kamarwan, in his study concluded that caused the 
collapse of the yield stress is drop limit to be 50% due to a rise in temperature 
to 300 ° C which resulted in a frame structure above is not able to withstand 
compressive force occurs, followed by Arya Prime conclude that the failure of 
the structure occurs at temperatures average average 1125 ° C. 
After reading the report, the authors feel challenged to continue his research 
further, by reconstructing events through prototyping experiments and from 
the results of the experiment followed by simulation using ANSYS V11.0 
program, one of the best simulation program based on the finite element 
analysis.  
Experiments with a prototype based on the similarity theory using aluminum 
materials can provide clues that the structural deformation that occurs due to 
the temperature rise begins in order to bridge the element followed by 
buckling at some point locations. 
The failure of the structure began to occur at a temperature of 600 ° C has a 
modulus of elasticity values of ± 62 000 MPa, the maximum deformation, 
modulus of elasticity of simulation models Krasak bridge is 22 000 MPa (11% 
from early Modulus of Elasticity). 
Keyword: 
Retro analysis, Buckling, Prototype, Similitude Theory, Bridge Model, 
Krasak Bridge, Modulus of Elasticity. 
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fy   Tegangan Leleh      MPa 
h   Koefisien Perpindahan Panas     W/m2-K 
Hui   Nilai Kalori Material      MJ/kg 
ΔHc   Nilai Kalori Bersih      MJ/kg 
ΔH   Nilai Kalori Efektif      MJ/kg 
Hv   Ketinggian Ventilasi      m 
IYY   Tahanan Inersia Sumbu Y     m4 
IZZ   Tahanan Inersia Sumbu Z     m4 
k   Konduktifitas Termal      W/m-K 
Kd   Konstanta distribusi beban api 
Lc   Panjang Karakteristik      m 
Leff   Lebar Efektif Web      m 
Lfire   Beban Termal       MJ/m2 
m   Massa        kg 
mc   Persentase Kandungan Air 
md   Persentase Kandungan Air Terhadap Berat Kering 
mi   Massa Bahan Bakar      kg 
n   Rasio Modular 
P   Tekanan       psi 
Q   Tingkat Pelepasan Panas     MW 
R   Jari-jari lingkaran      m 
t   Waktu        s 

Kajian keruntuhan..., Rifky Netriady, FTUI, 2012



 xviii 

Universitas Indonesia 

Δt   Perbedaan Waktu      s 
T   Temperatur       °C 
V   Volume       m3 

Δx   Perbedaan Panjang      m 
Ti   Temperatur Awal      °C 
Tf   Temperatur Fluida      °C 
α   Tingkat Penyebaran Panas     s/m2 
α1   Koefisien Perpanjangan Linear terhadap Suhu  °C-1 
θ   Parameter Euler 
ρ   Massa Jenis       kg/ m3 
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BAB 1 

PENDAHULUAN 

 

1.1. LATAR BELAKANG 

 

Keselamatan dari banyak moda darat yang berbasis struktur penghubung 

merupakan hal sangat penting di perhatikan, terutama terhadap ancaman api. Ini 

telah dibuktikan oleh beberapa bencana, diantaranya yaitu runtuhnya Jembatan 

Kali Krasak sebelah barat pada 10 Mei 1991. Api yang tidak diinginkan adalah 

memiliki daya hancur yang menyebabkan ribuan kematian dan kerugian 

berjumlah jutaan dollar tiap tahun. Keamanan dari suatu tempat terhadap  

kebakaran bergantung pada banyak faktor dalam desain dan konstruksi, termasuk  

di dalamnya harapan bahwa bangunan tersebut dan bagian-bagiannya tidak hancur 

atau menimbulkan penyebaran api. 

Runtuhnya Jembatan Krasak bersumber dari kebakaran sebuah truk tangki 

bahan bakar yang memuat 16.000 liter premix sekitar 50 meter setelah memasuki 

jembatan.  Sehingga jembatan yang bernilai tiga milyar rupian itu lenyap dalam 

20 menit[2]. Meskipun peristiwa ini  sudah diberitakan di media massa, namun 

masih terdapat kesimpang-siuran  peristiwa kebakaran yang sebenarnya terjadi.  

Pembangunan kembali jembatan itu dimulai 23 Mei 1991 dan selesai 2 

Agustus 1991. Diresmikan tanggal 6 Agustus 1991. Biaya perbaikan mencapai Rp  

1,7 Milyar. Jembatan Krasak lama, dengan panjang 224 meter, dibangun tahun 

1976 dan diresmikan 27 Januari 1977, berkonstruksi Callendar Hamilton buatan  

Inggris, seperti ruas jembatan di sisi selatan yang masih ada[3].  

 Berdasarkan penelitian yang telah dilakukan oleh Prof. Ir. Sidharta S. 

Kamarwan dalam laporan singkatnya yang berjudul “JEMBATAN RANGKA 

BAJAPUN DAPAT TERBAKAR DAN RUNTUH”. Laporan tersebut 

menyimpulkan bahwa perilaku keruntuhan Jembatan Krasak disebabkan turunnya 

batas tegangan tegangan leleh baja menjadi 50% akibat kenaikan temperatur 

hingga 300 oC dan dengan berat sendiri dari konstruksi baja mengakibatkan 
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struktur rangka atas tidak mampu menahan gaya tekan yang terjadi sehingga 

kemudian batang tersebut melengkung.  

Pada penelitian kedua yang dilakukan oleh Arya Perdana dalam skripsinya 

yang berjudul “ANALISA BALIK (RETRO ANALYSIS) KERUNTUHAN 

JEMBATAN KRASAK AKIBAT KEBAKARAN TRUK TANGKI BAHAN 

BAKAR” menyimpulkan bahwa  kegagalan struktur terjadi pada temperatur rata-

rata 1125°C.[1] 

Dari beberapa referensi mengenai kebakaran struktur, Thomas W. Eagar 

dan Christopher Musso yang telah melakukan penelitian terhadap keruntuhan 

yang terjadi pada gedung WTC (World Trade Center), menyimpulkan bahwa 

kebakaran yang terjadi menimbulkan kenaikan temperature antara 500°C - 650°C, 

walaupun dari pengalamannya  temperature dapat terjadi dalam batasan 750°C - 

800°C.[2]  

Penelitian lain yang dilakukan Dr. Vytenis Babrauskas, menuliskan 

tentang temperature pada lidah api dan kebakaran (Temperatures in Flames and 

Fires) menyebutkan bahwa temperature api pada kebakaran di ruangan terbuka, 

berada dibawah temperature 900°C, yaitu pada posisi terdekat dari sumber api 

(continuous flame region).[4] 

 

1.2. PERMASALAHAN   

  Permasalahan yang dibahas dalam penulisan ini adalah keruntuhan 

Jembatan Krasak itu sendiri. Penyempurnaan struktur dalam pemodelan simulasi 

dengan memodelkan pengaku pada batang diagonal dan rangka atas jembatan,    

untuk mendapatkan hasil yang lebih mendekati kondisi seharusnya.  

Percobaan terhadap struktur sebenarnya dilakukan dengan suatu 

pendekatan terhadap sebuah jembatan model yang direncanakan sesuai dengan 

teori kesamaan, untuk mendapatkan pola keruntuhan serta seberapa besar 

pengaruh dari kebakaran dalam proses keruntuhan jembatan tersebut.   

 

1.3. TUJUAN PENELITIAN   

Tujuan dari penulisan ini adalah mencari pola keruntuhan Jembatan 

Krasak yang mendekati keadaan sebenarnya melalui simulasi dan percobaan. 
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Simulasi dilakukan berdasarkan data-data historis dari peristiwa keruntuhan 

jembatan tersebut. Hasil dari simulasi ini nantinya akan dibandingkan dengan 

data-data dan dokumentasi historis yang ada.   

 

1.4. PEMBATASAN MASALAH   

Tulisan ini membatasi masalah dalam hal:   

1. Jembatan Krasak runtuh akibat kebakaran (fire).   

2. Kebakaran yang terjadi diasumsikan menghabiskan 1200 liter bahan bakar. 

3. Analisa struktur dilakukan secara nonlinear, baik dari segi sifat material 

ataupun geometrinya.   

4. Percobaan yang dilakukan hanya sebagai pendekatan terhadap kejadian 

sesungguhnya. 

 

1.5. METODOLOGI   

Tahapan-tahapan yang dilakukan penulis dalam melakukan thesis ini adalah 

sebagai berikut:   

1. Studi literatur. Penulis mencari dan mempelajari berbagai macam data 

mengenai hal-hal yang berhubungan dengan kebakaran, yaitu hal-hal yang 

menyebabkan dan diakibatkannya. Hal ini sudah dilakukan pada bab 

sebelumnya, tepatnya pada Bab 2, dari Subbab 2.1 hingga Subbab 2.5. 

2. Studi data historis. Penulis mempelajari informasi-informasi dari 

penelitian sebelumnya, mengenai proses dan kejadian keruntuhan 

Jembatan Krasak sampai sedetail mungkin serta data yang berhubungan 

dengan dimensi struktur Jembatan Krasak dan beban truk tangki 

bermuatan 16000 liter premix. Dimana data-data tersebut akan 

dimanfaatkan dalam melakukan modelisasi struktur dan keadaan Jembatan 

Krasak pada kondisi yang semirip mungkin dengan aslinya. Data detail 

dimensi Jembatan Krasak hasil pengukuran secara langsung pada lokasi 

akan dibahas pada Bab 3, Subbab 3.2. Untuk data dimensi truk tangki 

bermuatan 16000 liter premix akan dibahas pada Bab 3, Subbab 3.3. 
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3. Perencanaan model dengan menentukan skala setiap parameter struktur 

berdasarkan ketentuan dari teori kesamaan yang akan dibahas pada Bab 3, 

Subbab 3.5. 

4. Melakukan pengujian statik terhadap jembatan model. 

5. Menghitung beban lalu lintas saat terjadinya kebakaran, dan beban termal 

yang dihasilkan dari proses pembakaran yang dinyatakan dengan gambar 

gradien temperatur pada tiap elemen profil rangka baja yang mengalami 

kenaikan suhu. Data pembebanan ini akan dibahas pada Bab 3, Subbab 

3.5.  

6. Melakukan analisa struktur terhadap jembatan model menggunakan 

bantuan program ANSYS v11.0 sebagai program simulasi guna 

mengetehui prilaku struktur berupa hubungan tegangan regangan yang 

terjadi dan pola deformasi rangka alumunium struktur dari jembatan model 

berdasarkan data yang diperoleh dari hasil pengujian. Hasil simulasi ini 

akan ditampilkan pada Bab 4 

7. Melakukan analisa struktur terhadap prototype jembatan menggunakan 

bantuan program ANSYS v11.0 sebagai program simulasi guna 

mengetehui prilaku struktur berupa hubungan tegangan regangan yang 

terjadi dan pola deformasi rangka baja struktur dari Jembatan Krasak. 

Hasil simulasi ini akan ditampilkan pada Bab 4 

8. Kesimpulan. Penulis membahas dan menyimpulkan hasil poin 1 sampai 7 

di atas. Hal ini akan disajikan pada Bab 5. 

 

1.6. SISTEMATIKA PENULISAN   

 

Laporan evaluasi ini terdiri atas lima bab, dan diharapkan dapat 

menjelaskan serta membuktikan secara teoritis mengenai perilaku keruntuhan 

Jembatan Krasak sampai sedetail mungkin. Laporan ini akan terdiri dari beberapa 

bagian seperti berikut ini: 

Bab I:  Pendahuluan berisi Latar Belakang, Permasalahan, Tujuan Penelitian, 

Pembatasan Masalah, Metodologi, dan Sistematika Penulisan. 

Bab II:  Studi Pustaka terdiri dari Teori Api dan Panas, Efek Api serta Panas 
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terhadap Struktur Baja, Literatur Jembatan  Krasak, Analisa dari 

Penelitian Sebelumnya, serta Hipotesis  Keruntuhan Jembatan Krasak. 

Bab III: Metodologi Penelitian akan membahas mengenai Prosedur Analisa, Data  

Dimensi Struktur Jembatan Krasak, Dimensi Truk Tangki Bahan Bakar, 

Perencanaan Jembatan Model, Perhitungan Pembebanan Pada Simulasi, 

Data Masukan, serta  Parameter yang Akan Dievaluasi dalam penelitian 

ini.   

Bab IV : Hasil Percobaan dan Simulasi serta Analisa berdasarkan data keluaran 

program ANSYS yang berupa Deformasi Struktur, Hubungan Tegangan-

Regangan profil yang ditinjau.. 

Bab V :  Kesimpulan dan Saran berisi kesimpulan dari analisa struktur Jembatan 

Krasak akibat kebakaran serta saran untuk pengembangan lebih lanjut 

pada studi perilaku struktur jembatan akibat kebakaran. 
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BAB 2 

STUDI PUSTAKA 

 

2.1. API DAN PANAS [5]  

2.1.1. Bahan Bakar   

2.1.1.1. Material   

Sebagian besar bahan bakar pada bangunan yang terbakar adalah material 

organik yang berasal dari tumbuh-tumbuhan, binatang, ataupun produk minyak 

(petrochemical). Material bahan bakar tersebut bisa terdapat pada bagian dari 

struktur bangunan tersebut, material pembungkus, atau bagian-bagian lain, baik 

yang permanen ataupun sementara.   

 

2.1.1.2. Nilai Kalori   

Tingkat pelepasan panas pada suatu reaksi pembakaran dapat bergantung 

pada sifat alami material yang terbakar, besar api, serta jumlah udara yang  

tersedia. Nilai kalori atau panas dari suatu pembakaran adalah jumlah panas yang  

dilepaskan selama pembakaran suatu unit bahan bakar sampai habis. Sebagian  

besar bahan bakar yang berupa benda padat, cair, ataupun gas memiliki nilai  

kalori antara 15 sampai 50 MJ/kg. Nilai kalori bersih ΔHc (MJ/kg) untuk sejumlah 

bahan bakar dapat dilihat pada Tabel 2.1 di bawah ini.  

 

Tabel 2.1. Nilai Kalori Material Yang Dapat Terbakar (Combustible) [5] 

Liquids MJ/kg Gases MJ/kg  

Gasoline 44 Acetylene 48 

Diesel Oil 41 Butane 46 

Linseed Oil 39 Carbon Monoxide 10 

Methanol 20 Hydrogen 120 

Parafin Oil 41 Propane 46 

Spirits 29 Methane 50 

Tar 38 Ethanol 27 

Benzene 40 
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Solids MJ/kg Plastics MJ/kg  

Anthracite 34 ABS 36 

Asphalt 41 Acrylic 28 

Bitumen 42 Celluloid 19 

Cellulose 17 Epoxy 34 

Charcoal 35 Melamine Resin 18 

Chlotes 19 Phenolformaldehyde 29 

Coal, Coke 31 Polyester 31 

Cork 29 Polyester, fibre-reinforced 21 

Cotton 18 Polyethylene 44 

Grain 17 Polysthylene 40 

Grease 41 Petroleum 41 

Kithen Refuse 18 Polyisocyanurate foam 24 

Leather 19 Polycarbonate 29 

Linoleum 20 Polypropylene 43 

Paper, Cardboard 17 Polyurethane 23 

Parafin wax 47 Polyurethane foam 26 

Foam Rubber 37 Polyvinylchloride 17 

Rubber Isoprene 45 Urea formaldehyde 15 

Rubber Tire 32 Urea formaldehyde foam 14 

Silk 19 
  

Straw 16 
  

Wood 19 
  

Wool 23 
  

Particle Board 18 
  

 

2.2.   PEMBAKARAN [5]  

2.2.1. Proses Kimia   

Dalam bentuk yang paling sederhana, proses pembakaran material organic 

merupakan reaksi kimia eksotermik yang melibatkan proses oksidasi dari 

hidrokarbon yang menghasilkan uap air dan karbondioksida. Sebagai contoh, 

reaksi kimia untuk pembakaran sempurna dari propana dapat dituliskan:   

C3H8 + 5O2 → 3CO2 + 4H2O 

Bentuk ini merupakan suatu penyederhanaan dari proses kimia. Sebenarnya, 

terdapat banyak faktor yang mempengaruhi reaksi kimia tersebut, seperti  
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temperatur, tekanan dan ketersediaan material. Dalam situasi pembakaran, sering 

dijumpai proses pembakaran yang tidak sempurna, mengakibatkan terjadinya 

produksi gas karbonmonoksida (CO) atau karbon padat (C), sebagai sisa partikel 

pembakaran atau asap. Reaksi kimia yang terjadi akan berubah seiring perubahan 

kondisi pembakaran.   

 

2.2.1.1. Perubahan Fase dan Proses Dekomposisi   

Pada suhu kamar, beberapa bahan bakar akan berwujud gas, namun 

sebagian besar akan berbentuk padat ataupun cair. Gas dapat bercampur dengan 

udara untuk terbakar secara langsung tanpa terjadinya perubahan fase, akan tetapi, 

bahan bakar berbentuk padatan dan cairan harus berubah dahulu menjadi fase 

udara sebelum dapat terbakar.  

Untuk sebagian besar cairan, perubahan fase menjadi fase gas akibat suatu 

pemanasan disebut dengan evaporasi. Sedangkan untuk sebagian polimer, proses 

dekomposisi termal menyebabkannya berubah menjadi sesuatu yang lebih mudah 

menguap.  Sebagian besar bahan bakar padat akan mencair apabila dipanaskan, 

menghasilkan cairan yang dapat berubah menjadi fase gas melalui proses 

evaporasi ataupun dekomposisi termal. Sedangkan beberapa bahan bakar padat 

lainnya, seperti jenis kayu, dapat terdekomposisi termal secara langsung dari fase 

padat menjadi fase gas. Proses dekomposisi termal tersebut dinamakan dengan 

pirolisis.   

 

2.2.1.1. Pencampuran dalam Api   

Proses pembakaran untuk setiap material akan membutuhkan ketersediaan 

oksigen untuk menghasilkan reaksi oksidasi. Proses pembakaran yang paling 

efisien adalah hasil pencampuran antara bahan bakar berbentuk gas dengan 

oksigen ataupun udara yang mengandung oksigen sebelum sumber bahan bakar 

tersebut mulai terbakar (seperti dalam pembakaran bunsen). Proses pembakaran 

akan terjadi dengan sangat cepat apabila bahan bakar gas tersebut tercampur 

dengan proporsi yang tepat (seperti dalam ruang pembakaran mesin). Pembakaran 

tidak akan terjadi apabila kekurangan ataupun kelebihan oksigen untuk suatu 

kondisi temperatur dan tekanan tertentu.    
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2.2.1.2.Difusi Pada Pembakaran   

Pada sebagian besar kebakaran pada bangunan, ada yang dinamakan 

dengan proses pencampuran awal pembakaran (premixed burning), dan tingkat  

pembakaran akan selalu bergantung pada proses pencampuran udara dengan  

bahan bakar berbentuk gas yang ada. Lokasi pembakaran akan selalu terdapat  

pada tempat dimana terjadi pencampuran gas tersebut. Pencampuran tersebut  

biasanya diatur oleh daya angkat dan pergolakan hasil pergerakan-pergerakan  

konfektif dari lidah api dan hasil pembakaran lainnya di atas api.     

 

2.2.2. Tahapan-Tahapan Pada Kebakaran [6]  

Terdapat 4 tahapan penting pada proses terjadinya kebakaran. Tahapan 

tersebut dapat dilihat pada Gambar 2.1 di bawah ini.   

 

 

 

 

 

 

 

 

 

 

Gambar 2.1. Tahapan-Tahapan Dalam Perkembangan Kebakaran [6] 

 

Tahapan pertama adalah fase penyalaan awal (incipient ignition), dimana 

terjadi pemanasan bahan bakar potensial. Tahapan selanjutnya adalah fase 

perkembangan (growth), dimana mulai terlihat lidah api hasil pembakaran.  

Selama pertumbuhan api, sehingga api mencapai temperatur yang cukup tinggi 

(sekitar 600°C), api akan berkembang secara sempurna dan mencapai suatu fase 

yang dinamakan kondisi penyalaan (flashover), dimana menandakan kedatangan 

fase ketiga, yaitu fase pembakaran (burning). Pada fase ini, temperatur dan 

perubahan panas yang terjadi sangatlah besar, terjadi pada seluruh permukaan 

Waktu Flashover Ignition 

Temperatur 

Incipient Growth Decay Burning 
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yang terkena api, serta ketersediaan ventilasi akan menentukan pelepasan panas  

yang terjadi. Bagian ini merupakan tahapan paling berbahaya yang dapat  

berakibat fatal pada elemen-elemen bangunan. Setelah sekian waktu, bahan bakar  

dan kebakaran yang terjadi pada akhirnya akan ‘capai’, dan api pun lama-

kelamaan akan mulai menghilang dalam fase selanjutnya, yang dinamakan dengan  

periode penurunan (decay). Fase penurunan ini biasanya terjadi pada saat 70% 

bahan bakar yang tersedia sudah terpakai.    

Dapat terlihat bahwa kebakaran yang terjadi pada suatu tempat akan 

dengan sendirinya menghilang atau berhenti (extinguish). Bagaimanapun juga 

penyebarannya harus dicegah semaksimal mungkin, karena api dapat dengan 

terus-menerus menyebar ke segala arah, baik vertikal ataupun horizontal. 

Penyebaran ini akan diikuti dengan pengulangan siklus api, yaitu penyalaan 

(ignition), perkembangan (growth), pembakaran (burning), dan penurunan  

(decay).   

 

2.2.2.1. Temperatur dan Waktu Kebakaran   

Temperatur maksimum yang dapat dicapai pada suatu pembakaran dinamakan 

temperatur api adiabatik (adiabatic flame temperature). Nilai teoritis dari 

temperatur maksimum ini dapat tercapai apabila hasil pembakaran  dipanaskan 

dari suhu awalnya oleh panas yang dilepaskan oleh reaksi kimia  pembakaran 

tanpa ada nilai yang hilang (losses) sama sekali. Pada pembakaran  secara umum, 

nilai temperatur api adiabatik ini dapat tercapai pada sedikit daerah  tengah 

pembakaran, akan tetapi, temperatur rata-rata dari pembakaran secara  

keseluruhan akan sangat di bawahnya.   
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Gambar 2.2. Grafik Hubungan Waktu Dan Temperatur Pada Kebakaran [6] 

 

Nilai maksimum dari temperatur dan waktu suatu kebakaran pada suatu 

bangunan bergantung pada beberapa hal, termasuk didalamnya jumlah dan tipe 

bahan bakar yang tersedia, kondisi ventilasi, tipe penutup struktur, dan kondisi 

cuaca. Pada kebakaran biasa, seperti pada perkantoran dan perumahan atau tempat 

tinggal lainnya, temperatur maksimum yang dapat dicapai akan sulit untuk 

melebihi 815°C, meskipun nilai maksimum tersebut dapat bervariasi hingga 

1093°C dalam keadaan tertentu. Temperatur maksimum ini hanya akan bertahan 

selama 10 hingga 20 menit pada fase puncak pembakaran.    

 

Tabel 2.2. Hubungan Beban Api dan Waktu Pembakaran [6] 

Average Fire Load 
(psf) 

Average Fire 
Load (kg/m²) 

Equivalent Fire 
Endurance (Hours) 

5 24,4 0,5 
7,5 36,6 0,75 
10 48,8 1 
15 73,2 1,5 
20 97,6 2 
30 146,5 3 
40 195,3 4,5 
50 244,1 6 
60 292,9 7,5 
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2.2.2.2.Beban Api dan Radius Penyebarannya   

Beban api adalah jumlah semua material yang mudah terbakar 

(combustible material) dalam suatu ruangan. Secara tradisional, hal ini biasa 

diekspresikan dalam berat ekuivalen terhadap kayu struktural dalam suatu 

bangunan per luasan lantai bangunan. Berat sebenarnya dari combustible material 

ini disesuaikan menjadi berat ekuivalen kayu, berdasarkan potensi panas material 

ini apabila dibandingkan dengan potensi panas normal dari api. Selain itu, 

pengukuran beban api secara modern dilakukan dengan menentukan potensi panas 

dari isi bangunan per luasan lantai bangunan tersebut (MJ/m2).    

Beban api yang terjadi dapat ditentukan dengan ukuran ruangan dan 

kondisi  alam di sekitarnya, serta jumlah dan susunan bahan combustible tersebut. 

Yang dikatakan beban api diantaranya adalah seluruh material combustible, 

termasuk perabotan kayu, peralatan, serta komponen struktural yang bersifat 

combustible lainnya.  

Dalam keadaan sebenarnya, beban api yang terjadi pada suatu bangunan  

merupakan hasil keseluruhan dari penambahan perabotan serta peralatan lainnya  

yang ditempatkan setelah pembangunan selesai, dimana keberadaannya kurang  

dipastikan, sehingga perhitungannya dilakukan secara kurang akurat.  Material  

combustible ini dapat diklasifikasikan menjadi beberapa tipe. Pembagian tersebut 

biasa dilakukan terhadap nilai potensi panas, besaran kalori  bersih, ataupun 

pemanasan yang diperlukan dalam pembakaran.  

Satuan yang  digunakan adalah energi panas per berat atau massa (MJ/kg). 

Kayu biasa  digunakan dalam pedoman nilai yang digunakan, yaitu sebesar 16 

sampai 18 MJ/kg. Plastik memiliki nilai yang lebih besar, yaitu 24 hingga 40 

MJ/kg. Produk-produk hasil minyak bumi bervariasi antara 27 sampai 46 MJ/kg.   

Bangunan perkantoran konvensional memiliki material combustible, 

diantaranya kayu dan plastik dengan potensi panas sekitar 16 hingga 40 MJ/kg  

dan kepadatan beban api untuk ruang perkantoran adalah 30 kg/m2, menghasilkan  

total nilai potensi panas sebesar 480 hingga 1200 MJ/m2 luas lantai bangunan.  

Pada gudang dan perpustakaan, nilai ini dapat berlipat ganda hingga dua kalinya.    
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2.2.2.3. Transfer Panas ke Struktur di Sekitarnya   

Perpindahan panas secara umum melibatkan tiga proses, yaitu: konduksi, 

konveksi dan radiasi, yang dapat terjadi secara terpisah atau bersama-sama 

tergantung pada keadaan. 

Konduksi adalah mekanisme perpindahan panas pada bahan padat. Bahan 

yang baik menyalurkan panas, panas ditransfer dengan melibatkan interaksi dari 

elektron bebas. Pada bahan yg sulit menyalurkan panas, panas disalurkan melalui 

getaran mekanis dari kisi molekuler. Konduksi panas adalah faktor penting dalam 

kunci kontak permukaan padat, dan dalam perlawanan api dari hambatan dan 

anggota struktural. 

Dalam kondisi yang kuat (stabil), perpindahan panas melalui konduksi 

berbanding lurus dengan perubahan suhu antara dua titik dan konduktivitas 

termal, , i.e. [5] 

ℎ̇=dθ/dx        (2.1) 

dimana ℎ̇ adalah aliran panas per satuan luas (W/m2),  adalah Konduktivitas 

termal (W/mK), θ adalah temperatur (°C), dan x adalah jarak dalam arah aliran 

panas (m). 

Transfer panas satu dimensi dengan konduksi tanpa pelepasan panas internal, 

diatur dalam persamaan berikut: 

  ��� ��� = (1 �⁄ ) (�� ��⁄ )⁄⁄       (2.2) 

Dimana, t adalah waktu (s) dan α = ρc adalah diffusivitas termal (m2/s). 

Persamaan ini dapat diselesaikan dengan menggunakan analitis, grafik ataupun 

metode numerik. 

Konveksi adalah perpindahan panas melalui pergerakan cairan, baik gas 

atau cairan. Untuk kondisi tertentu, perpindahan panas sebanding dengan 

perbedaan suhu antar bahan, sehingga aliran panas per satuan luas dapat dihitung 

dengan menggunakan:[5] 

ℎ̇ = ��∆�        (2.3) 

Dimana, αc koefisisen perpindahan panas konveksi (W/m2K) dan ∆θ perbedaan 

temperature antara permukaan benda padat dan cairan (°C).  
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Table 2.3 Koefisien Perpindahan Panas Secara Konveksi[7] 

  αc (W/m2K) 

Exposed sides   

the standard temperature-time curve is used  25 

the external fire curve is used 25 

the hydrocarbon temperature-time is used 50 

the simplified fire models are used  35 

the advanced fire models are used 35 

Unexposed side of separating members 

the radiation effects are not included  4 

the radiation effects are included  9 

 

Radiasi adalah perpindahan energi oleh gelombang elektromagnetik yang 

dapat berjalan melalui ruang hampa atau melalui transparan padat atau cair. 

Radiasi adalah mekanisme utama untuk perpindahan panas dari bahan bakar api 

ke permukaan, dari asap panas untuk membangun objek dan dari gedung yang 

terbakar ke sebuah gedung yang bersebelahan. Aliran panas per satuan luas dapat 

dihitung sebagai [5] : 

ℎ̇ = Φ��[(��273)� − (��273)�]     (2.4) 

Dimana, Φ adalah faktor konfigurasi yang merupakan ukuran berapa banyak dari 

emitor adalah 'dilihat' oleh permukaan penerima. ε adalah Emisivitas resultan dua 

permukaan dan dapat dihitung sebagai  � = 1 (1 ��⁄ + 1 ��⁄ − 1)⁄  

 adalah konstanta Stefan-Boltzmann dan nilainya  = 5,67x10-8 W/m2K4. θe 

adalah temperatur pemancaran pada permukaan (°C) dan θr adalah suhu dari 

penerimaan pada permukaan (°C). 

 

2.2.2.4. Massa Termal dan Inersia Termal   

Massa termal biasa digunakan dalam mengklasifikasikan suatu kapasitas 

efektif suatu pemanasan ataupun pemanasan spesifik efektif (effective specific 

heat). Pemanasan efektif spesifik adalah jumlah energi per satuan massa atau  

berat  material yang diperlukan untuk menaikkan temperatur sebesar satu satuan  
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(biasa ditulis dalam J/[kg°C]). Dengan cara yang sama, kapasitas pemanasan 

efektif dimana biasa dikatakan sebagai pemanasan pada volume tertentu, adalah 

jumlah energi per satuan volume material yang diperlukan untuk menaikkan 

temperatur sebesar satu satuan (biasa ditulis dalam J/[m3°C]). Penurunan sifat ini 

merupakan hasil dari kepadatan dan efek pemanasan spesifik dari material.    

Sifat turunan lainnya adalah inersia termal, yang merupakan hasil dari sifat 

konduktifitas termal, kepadatan dan efek pemanasan spesifik (biasa ditulis dalam 

W2s/[m4°C2]). Material dengan nilai inersia termal yang tinggi memiliki tingkat 

ketahanan yang lebih tinggi, dikarenakan temperatur yang tidak mudah naik. Pada 

sebagian besar material konstruksi, besar nilai efek pemanasan spesifik, kapasitas 

panas, dan konduktifitas termal, seluruhnya bergantung pada temperatur, 

sebagaimana dalam penurunan sifat inersia termal. Besaran dari sifat  termal ini 

akan berubah secara signifikan terhadap tingkat perubahan temperatur  yang 

terjadi, yaitu pada 40 sampai 1100°C, dikarenakan sebagian besar material  

mengalami perubahan sifat kimiafisik (physiochemical) pada tingkat perubahan  

temperatur diatas. Sifat termal ini juga sangat sensitif terhadap metode ujicoba 

yang dilakukan serta tingkat percepatan pertambahan suhu yang terjadi.  

Bagaimanapun juga, sangat mungkin untuk menemui nilai dari sifat material  

terhadap termal yang berbeda-beda pada dalam literatur yang berbeda.   

 

2.2.3. Kurva Temperatur dan Model Api 

Ketika berhadapan dengan rambatan api dan yang berhubungan dengan 

api, seringkali proses rambatan api ini diabaikan pada suatu perencanaan, 

meskipun pada umumnya akibat dari rambatan api ini adalah yang paling penting 

bagi kehidupan manusia karena pada tahap ini api akan menghasilkan gas-gas 

beracun dan dapat mencapai suhu 100ºC dan banyak lagi. Untuk memilih model 

yang mendekati dengan proses rambatan api ini, rambatan api ini perlu 

didefinisikan. Berikut ini adalah alternatif terburuk yang mungkin terjadi,  sejauh 

lokasi dan jumlah beban rambatan api yang memungkinkan[8].. Misalnya : 

 Pada ruangan yang kecil diasumsikan api berkembang sepenuhnya 
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 Pada ruangan yang luas, minimal dapat digunakan 2 asumsi, baik beban 

api terdistribusi seragam penuh ataupun lokal tergantung pada lokasi 

kemungkinan beban api. 

 Untuk elemen yang terletak di luar gedung, api yang masuk melalui 

jendela dan pintu akan dipertimbangkan sebagai sumbernya. 

Sebuah desain api harus dinyatakan sebagai hubungan antara temperatur, waktu 

dan ruang lokasi, yang dihubungkan menjadi[8] : 

 Kurva nominal temperature-waktu yang seragam dalam suatu ruangan. 

 Suatu rambatan api yang nyata baik dikelompokkan dalam hal parameter 

api terbuka, dengan rumus analisis untuk kebakaran lokal, atau dengan 

pemodelan dengan computer. 

 

2.2.3.1. Kurva Temperatur Nominal-Waktu 

Kurva temperature nominal-waktu merupakan serangkaian kurva, di mana 

tidak ada parameter fisik yang diperhitungkan. Ketahanan terhadap api yang lebih 

spesifik banyak ditentukan dalam peraturan bangunan internasional yang 

berdasarkan tes, maka disepakati secara internasional kurva temperatur yang 

terdefinisikan dalam ISO834 (atau Eurocode 1 Bagian 2-2). 

Hal yang menjadi petimbangan terhadap ketahanan struktur terhadap api 

yaitu eksternal, dan temperatur atmosfer yang cenderung lebih rendah pada waktu 

tertentu (yang berarti bahwa suhu bahan bangunan akan lebih dekat sesuai suhu 

api), seperti kurva "External Fire" dapat digunakan. Dalam kasus di mana 

penyimpanan bahan hidrokarbon membuat kebakaran sangat parah, sebuah kurva 

"Hydrocarbon Fire" juga diberikan. Rumus untuk menggambarkan kurva ini 

diberikan sebagai berikut[7]: 

Untuk kurva temperature standar-waktu: 

θg = 20+345log10(8t+1)       (2.5) 

Untuk kurva external fire: 

θg = 660(1-0,687e-0.32t -0,313e-3,8t)+20     (2.6) 

Untuk kurva hydrocarbon fire: 

θg = 1080(1-0,325e-0,167t -0.675e-2,5t)+20     (2.7) 
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Berdasarkan ketiga persamaan diatas diperoleh kurva temperature-waktu seperti 

gambar 2.3. 

 

Gambar 2.3 Kurva Temperature Nominal Terhadap Waktu 

 

2.2.3.2. Beban Api (Fire load density) 

Fire load density didefinisikan sebagai jumlah total pembakaran energi per 

unit luas lantai dan merupakan sumber perkembangan api. Beban api terdiri dari 

komponen-komponen bangunan seperti dinding dan langit-langit lapisan, dan isi 

bangunan seperti furnitur. Nilai karakteristik beban api kerapatan ini diperoleh 

dari: 

qf.k = [ΣMk.iHuiΨ1]/A        (2.8) 

dimana : 

Mk.i  : bahan mudah terbakar [kg]. 

Hui  : nilai kalori bersih [MJ/kg]. 

Mk.i Hui  :  jumlah total energi yang terkandung dalam material dan pelepasan 

dengan asumsi pembakaran yang sempurna. 

Ψl  : faktor pilihan untuk mengakses api dilindungi beban. Misalnya dengan 

memasukkannya ke dalam kabinet. 

A  : luas lantai [m2]. 
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2.2.3.3. Laju Pelepasan Panas (RHR) 

Perhitungan RHR (Rate of heat release) berbeda dari ventilasi pengendali 

api untuk mengendalikan api pada bahan bakar. Pengendalian api bahan bakar 

merujuk pada kasus dimana selalu ada cukup oksigen untuk mempertahankan 

pembakaran. Menurut Kawagoe (1958), tingkat pembakaran  �̇ [kg/s] dapat 

dihitung sebagai [9] 

�̇ = 0,092 Av√Hv       (2.9) 

dimana; 

Av adalah luas bukaan (m2)  

Hv adalah tinggi bukaan (m).  

Persamaan ini berasal dari penelitian untuk kamar dengan satu 

pembukaan. Meskipun penelitian tersebut menunjukkan bahwa tingkat 

pembakaran tergantung pada bentuk ruangan dan lebar jendela ke dinding, 

persamaan ini berdasarkan perhitungan pasca kebakaran yang dilakukan.  

Penyesuaian ventilasi mengendalikan tingkat panas yang dilepaskan (MW) untuk 

pembakaran tetap dihitung sebagai [5]: 

Qvent = �̇ Hui        (2.10) 

waktu kebakaran dapat dihitung dengan rumus berikut: 

tb = E/Qvent        (2.11) 

Dimana E adalah kandungan energi bahan bakar yang tersedia untuk pembakaran 

(MJ). Selain itu, jumlah ventilasi dalam api kompartemen dijelaskan oleh faktor 

pembukaan O (m0.5) yang diberikan oleh : 

O = Av√Heq/At        (2.12) 

dimana Heq adalah tinggi rata-rata jendela pada semua dinding (m) dan pada luas 

keseluruhan (dinding, langit-langit dan lantai, m2). Jika rumus ini dikalikan 

dengan gravitasi g, maka diperoleh kecepatan aliran gas melalui bukaan. 

Penelitian menunjukkan bahwa jika bukaan ventilasi diperbesar, suatu 

kondisi yang akan dicapai di luar yang tingkat pembakaran akan tetap pada 

ukuran pembukaan dan akan ditentukan bukannya oleh permukaan dan 

karakteristik pembakaran bahan bakar. Untuk pengontrolan api oleh bahan bakar, 

durasi api dapat diasumsikan sebagai 25 menit untuk memperlambat laju 

pertumbuhan api, 20 menit untuk laju pertumbuhan menengah dan 15 menit untuk 
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laju pertumbuhan yang cepat. RHR dapat dihitung sebagai : 

Qfuel = E / tlim        (2.13) 

Ketika durasi waktu tidak diketahui, RHR diperkirakan dari informasi tentang 

bahan bakar dan suhu di kompartemen kebakaran. Pada Eurocode saat ini [7], RHR 

secara implisit dihitung menggunakan Av√Heq 

 

2.2.3.4. Kehilangan Panas 

Kehilangan panas (heat loose) pembakaran merupakan faktor penting 

dalam perkembangan suhu pembakaran. Kehilangan panas terjadi pada batas-

batas tertentu melalui konveksi dan radiasi dan oleh aliran ventilasi [7]. Cara yang 

paling populer untuk memodelkan kehilangan panas ke kompartemen batas-batas 

adalah melalui konsep “inersia termal”, b, dari bahan dinding, yaitu : 

b = √ρc        (2.14) 

dimana:   

 adalah konduktifitas panas (heat conductivity) [W/mK]. 

c adalah kapasitas panas (heat capacity) [J/kgK]. 

ρ adalah massa jenis [kg/m3]. 

 

2.2.3.5. Parametric temperature-time curves 

Saat ini Eurocode[5] memberikan sebuah persamaan untuk kurva parameter 

temperature-waktu dengan beberapa kombinasi bahan bakar, bukaan ventilasi dan 

bahan pelapis dinding. Persamaan temperature Θg (ºC) untuk fase pemanasan 

seperti berikut: 

Θg = 1325(1-0,324e-0,2t*-0,204e-1.7t*-0,472e-19t*)+20   (2.15) 

Dimana t* adalah waktu fiktif (jam) yang didapat dari: 

t* = t x Γ        (2.16) 

dimana t adalah waktu (jam) dan: 

Γ = (O/b)2/(0,04/1160)2      (2.17) 

Dalam kasus kompartemen dengan O = 0,04 m0,5 dan b = 1160 J/m2s0,5K, kurva 

parameter hampir persis kurva ISO. Suhu udara maksimum terjadi pada: 

t* = t*max        (2.18) 

dimana: 
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����
∗ = ���� × Γ        (2.19) 

dengan, 

���� = ���[(0,2 × 10�� ��.� ο⁄ ); ����]     (2.20) 

Waktu tmax bersesuaian dengan temperatur maksimum dari tlim dalam kasus api 

bahan bakar terkontrol. Jika tmax = (0,2x10-3 x qt.d/O), api itu dikendalikan 

ventilasi. Ketika tmax = tlim, t* maka rumus temperatur digantikan oleh : t* = t x Γlim 

dengan: 

Γlim = (Olim/b)2/(0,04/1160)2      (2.21) 

dimana:  

Olim = 0,1x10-3 x qt.d/tlim      (2.22) 

Jika, O > 0,04 dan qt.d < 75 dan b < 1160, �lim harus dikalikan dengan k, dimana: 

k = 1+ [(O-0,04)/0,04] x [(qt.d -75)/75] x [(1160-b)/1160]  (2.23) 

Hal ini disebabkan oleh kenyataan bahwa pengaruh bukaan masih hadir ketika api 

dikontrol bahan bakar. [7] berdasarkan referensi tingkat kerusakan sama dengan 

625ºC per jam untuk api dengan durasi kurang dari setengah jam, menurun sampai 

250ºC selama api dengan durasi lebih dari dua jam. Kurva suhu dalam periode 

pendinginan diberikan oleh : 

Untuk, t* ≤0.5  : Θg = Θmax – 625 (t*-t*
max·x)  

Untuk, 0.5 < t* ≤ 2 : Θg = Θmax – 250(3-t*
max) (t

*-t*max·x)  

Untuk, t* > 2  : Θg = Θmax – 250 (t*-t*
max·x)  

dimana:  t* = t·Γ; tmax = (0.2·10-3·qt.d/O)·Γ  

x = 1.0, jika, tmax > tlim ,  

x = tlim·Γ/t*
max , jika, tmax= tlim 
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2.3.   TINGKAT KETAHANAN STRUKTUR BAJA TERHADAP API [6]  

2.3.1. Pengertian Ketahanan Terhadap Api (Fire Resistance)   

Ketahanan terhadap api adalah durasi yang dibutuhkan suatu struktur 

untuk mempertahankan stabilitas, bentuk, dan perubahan termperaturnya, nilai ini 

biasanya didapat dari hasil percobaan. Percobaan ini dilakukan dengan standar 

tingkatan api untuk percobaan. Standar tingkatan api ini biasanya diberikan dalam 

jumlah jam dan memberikan hasil berupa kemampuan sruktur buatan untuk 

menahan api dan perbandingannya dengan struktur dengan model lain. Terdapat 

urutan kerja pengetesan dan evaluasi untuk balok, kolom, dinding, lantai, dan 

atap, serta elemen-elemen ini biasanya diuji cobakan untuk menahan beban api 

selama 1 hingga 4 jam.   

 

2.3.2. Efek Temperatur Tinggi Terhadap Struktur Baja   

Baja merupakan bahan tahan api. Baja merupakan bahan tidak mudah 

terbakar dengan tingkat ketahanan tinggi serta sifat-sifat struktur lain yang tinggi.  

Akan tetapi, efek dari pemanasan yang terus-menerus akan terlihat pada setiap  

material, seperti kerusakan, dan distorsi. Lendutan struktural akibat pemanasan  

yang lama dapat mencapai beberapa inci, bahkan kaki, dimana lendutan yang  

terjadi ini sangat besar apabila dibandingkan dengan lendutan elastik yang biasa  

terjadi dan diperhitungkan dalam desain struktur. Tekuk dan torsi juga dapat  

terjadi pada suhu tinggi.   Pada suhu tinggi, baik kuat lentur dan tarik dari suatu 

struktur baja akan menurun, sebagaimana penurunan yang terjadi pada modulus 

elastisitasnya.  Secara umum, baja akan menyisakan kekuatan dan kekakuannya 

sebesar 50 persen nilai sebenarnya pada kondisi suhu sebesar 593°C. Hal ini 

sebanding  dengan yang terjadi pada pengurangan kekuatan dan kekakuan pada 

beton normal.  Pada suhu 704°C, baja akan menyisakan sekitar 20 persen dari 

kekuatan dan kekakuannya. Titik suhu keruntuhan akan berkisar pada 1204°C. 

Perilaku kekuatan dan kekakuan baja terhadap perubahan suhu dapat dilihat pada 

Gambar  2.4 di bawah ini.    
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Gambar 2.4. Pengaruh Kenaikan Suhu Pada Kekuatan dan Modulus Elastisitas  

Struktur Baja [7] 

 

Gambar 2.4 didapat dari penelitian beberapa material secara  kecil dan 

terpisah, yang dipanaskan secara merata di keseluruhan penampang  

melintangnya. Suhu yang terjadi pada penampang tersebut tidak akan benar-benar 

sama dengan suhu api. Berkaitan dengan hal ini, ada banyak kasus dimana 

pemanasan secara merata pada profil baja ini tidak terjadi dalam suatu kebakaran.   

Sebagai contoh, pada lantai komposit dengan kebakaran yang terjadi di bawahnya, 

maka baja komposit di bawahnya yang bersuhu paling tinggi adalah  bagian 

bawah, atau bottom flange, yaitu bagian yang paling dekat dengan api.  Sedangkan 

bagian terdingin yaitu di bagian paling atas, atau top flange, bagian yang 

bersentuhan dengan lantai beton. Untuk kejadian kebakaran seperti ini, dimana 

bagian bottom flange sudah mencapai suhu yang cukup untuk mengurangi 

sebagian besar kekuatan dan kekakuannya, sedangkan bagian top flange dapat 

lebih dingin dan dibawah titik kritis bagi baja. Di beberapa kasus percobaan,  

bagian top flange dapat lebih dingin dengan perbedaan hingga 400°C  

dibandingkan dengan bagian bottom flange dengan 2 jam percobaan kebakaran.   
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Pengurangan suhu ini berlaku selama suhu pada baja tidak melebihi 700°C selama 

20 menit. Baja dengan kerusakan seperti itu, walaupun berdeformasi besar, namun 

masih dapat mengembalikan sifat-sifat sebelum kebakaran pada kondisi-kondisi 

tertentu. Bagaimanapun juga, suhu tinggi dan waktu sentuh yang lama akan 

menyebabkan proses annealing (pemanasan diikuti pendinginan secara perlahan-

lahan untuk mengembalikan kekuatannya) serta pengurangan kekuatan lelehnya.    

Dapat dikatakan dengan pasti bahwa baja struktural tidak akan meleleh 

akibat kebakaran, walaupun kejadian sedemikian sangatlah mungkin secara teori,  

seperti yang terjadi pada tungku pembakaran baja. Kebakaran tidak akan  

mencapai titik leleh baja, yaitu sekitar 1500°C.   

 

2.3.3. Efek Kebakaran pada Sambungan Baja   

Beberapa percobaan kebakaran yang telah dilakukan akhir-akhir ini 

menunjukkan bahwa sambungan pada struktur baja juga dapat meleleh, dimana  

hasil percobaan ini sangat bertentangan dengan beberapa studi analisis dan  

pengamatan pada kejadian-kejasdian kebakaran yang sudah terjadi pada bangunan  

dengan struktur portal baja. Sambungan baja biasanya memiliki material yang  

lebih banyak pada pelat, siku, baut, dan elemen-elemen sambungan lainnya  

daripada batang profil yang disambungnya, yang menyebabkan nilai tambah bagi  

ketahanan terhadap kebakaran. Selain itu, yang paling penting, sambungan di 

ujung batang profil biasanya cukup jauh dari sentuhan api dan penyebaran panas,  

menyebabkan panas dari api untuk tersebar pada lantai, balok dan kolom yang  

tidak mungkin terjadi secara simultan, melainkan secara berangsur-angsur. Sudah  

merupakan hal umum bahwa suhu akan bertambah secara cepat menuju pada  

batang profil baja dibandingkan dengan sambungan di ujung batang, kecuali letak  

kebakaran yang sangat dekat dengan ujung batang tersebut.  

Hal lain yang tidak kalah pentingnya adalah gaya akibat suhu pada sistem 

struktur portal yang terjadi pada sambungan dan batang profil akibat perilaku  

tekan ataupun tarik akibat kebakaran dan setelahnya, yaitu pada fase pendinginan.  

Gaya dan momen lentur pada portal yang mengalami peningkatan suhu akan  

semakin bertambah secara dramatis pada suatu peristiwa kebakaran, walaupun  

beban gravitasi yang dilayani oleh struktur tersebut tetap sama. Sebagai contoh, 
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balok terkekang yang mengalami kenaikan suhu akan berdeformasi menjadi  

bertambah panjang, serta gaya tekan akan terjadi akibat arah deformasi struktur di  

sekelilingnya, dikombinasikan dengan momen lentur dan gaya geser yang terjadi  

akibat beban layan. Sebagaimana kebakaran semakin bertambah besar, sedangkan  

sifat struktur baja semakin menurun, balok struktur akan mengalami lendutan  

besar, yang akan meningkatkan gaya tarik pada serat bawah baja profil.  

Pertambahan gaya ini harus dapat diterima dan dipindahkan oleh sambungan  

batang. Biasanya, pertambahan gaya dan deformasi akibat kebakaran ini tidak  

terlalu diperhitungkan dalam desain struktur konvensional dari berbagai material  

apapun, dimana balok hanya didesain untuk tahan terhadap momen.    

 

2.3.4. Perilaku Struktur Baja Dalam Kebakaran [6]  

Dalam kondisi kebakaran, suhu dalam baja akan meningkat, 

mengakibatkan baik terjadinya ekspansi termal batang dan penurunan sifat 

mekaniknya. Tingkat kerusakan yang dihasilkannya bergantung dari beberapa 

faktor, baik dari tipe baja yang digunakan ataupun kondisi proteksi yang 

dimilikinya. Durasi dan kondisi alamiah pada titik sentuh baja dengan kebakaran 

akan mempengaruhi penyebaran kenaikan suhu pada penampang baja.   

Pertambahan suhu dalam batang profil baja dapat ditentukan dengan 

prinsip perpindahan panas (heat transfer). Sebagai konsekuensi, harus 

diperhatikan bahwa suhu pada batang profil baja tidak akan sama dengan suhu api 

pada kebakaran yang terjadi. Baja dengan proteksi akan mengurangi pertambahan 

suhu lebih besar dibandingkan dengan baja polos. Selain itu, efek pemanasan akan 

semakin berkurang seiring dengan bertambahnya jarak dengan api, kondisi 

ventilasi pun mempengaruhi pertambahan suhu, dimana ventilasi akan membantu 

mendinginkan batang baja dengan menyebarkan suhu ke lingkungan di sekitarnya.  

Hal lain yang juga berpengaruh adalah waktu pemanasan, dimana suhu tinggi 

dengan waktu sebentar akan lebih tidak merusak apabila dibandingkan dengan 

pertambahan suhu normal dengan waktu yang lebih lama. Hal ini merupakan 

bagian dari proses perpindahan panas yang bergantung kepada alam, intensitas 

api, durasi kebakaran, jarak api dengan batang profil baja, tipe dan sifat serta 

bentuk penampang baja, tipe dan sifat material proteksi api, serta kondisi termal 

Kajian keruntuhan..., Rifky Netriady, FTUI, 2012



BAB II. STUDI PUSTAKA  25 

RIFKY NETRIADY  07 06 172 582 

Universitas Indonesia 

dan struktur di lingkungan sekitarnya.    

Secara umum, efek api terhadap sifat dan kondisi metalurgis dari baja struktur 

hanya bersifat sementara, yaitu pada saat material baja mengalami  kenaikan suhu. 

Dikarenakan baja secara umum relatif memiliki komposisi  campuran karbon 

yang rendah, baja struktur biasanya dapat mengembalikan sifat-sifat awal sebelum 

terjadi kebakaran, pada proses pendinginan, hanya apabila  pertambahan suhu 

tidak mencapai 700 °C selama 20 menit.   

 

2.3.4.1. Fenomena Lain yang Terjadi pada Baja dalam Suhu Tinggi   

Akibat pertambahan panjang disertai dengan pengurangan kekuatan dan 

kekakuan baja karena efek pertambahan suhu, efek pengekangan pada ujung  

perletakan batang, ketidaksempurnaan pemasangan, pembengkokan, ataupun 

pemusatan gaya, akan mengakibatkan tekuk, baik pada bagian flange ataupun  

web, juga tekuk pada keseluruhan batang, dengan suhu di atas 315°C. Dengan  

pengekangan sempurna pada batang, proses ini akan terjadi lebih cepat, yaitu pada  

suhu 120°C. Efek tekuk akan sangat mungkin terjadi pada suhu 650 sampai 

760°C, dimana kekuatan dan kekakuan baja hanya tinggal 50 persen nilai awal.  

Pengalaman sebelum-sebelumnya dari pembengkokan (curving) dan pelurusan  

(sraightening) akibat api menunjukkan bahwa tekuk dapat terjadi secara tiba-tiba,  

baik pada rentang suhu seperti diatas, ataupun lebih. 

Akibat tambahan dari distrorsi tekuk pada batang profil, baja akan  

mengalami pertambahan lendutan vertikal dan rotasi selama terjadinya kebakaran  

akibat beban layan berupa beban mati dan beban hidup. Dalam kondisi kebakaran,  

baik dalam percobaan atau kecelakaan, lendutan yang terjadi baik pada batang  

ataupun sistem lantai baja dapat mencapai besaran yang signifikan. Kebakaran  

yang sebenarnya akan menghasilkan lendutan yang bervariasi antara beberapa  

inci, hingga pada beberapa kasus dapat mencapai 3 sampai 4 ft, dimana lendutan  

ini melebihi batasan layan normal yang harus diantisipasi dalam suatu bangunan.  

Dalam setiap desain, harus selalu diperhatikan bahwa tujuan utama dari suatu  

perhitungan desain struktur adalah untuk menghasilkan bangunan yang tahan  

terhadap keruntuhan akibat bencana alam, meskipun struktur tersebut mengalami  

kehancuran, baik struktural ataupun nonstruktural yang sedemikian besar.  
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Bagaimanapun juga, bangunan yang didesain sedemikian rupa terhadap kebakaran  

pun masih dapat mengalami kerusakan struktural dan nonstruktural yang sangat  

besar dalam suatu peristiwa kebakaran.   

Harus diperhatikan bahwa deformasi yang sedemikian besar bukanlah 

indikator utama bahwa struktur baja tersebut telah mengalami pemanasan hingga  

suhu diatas 700°C, dengan data-data bahwa peristiwa tekuk pada baja dapat  

terjadi pada suhu yang lebih rendah daripada itu, bergantung pada besaran beban  

yang sebenarnya terjadi. Bagaimanapun juga, dan yang paling penting, hal 

sebaliknya pun berlaku, yaitu baja yang tidak berdeformasi besar dan dianggap  

masih bisa diperbaiki kemungkinan tidak mengalami pemanasan hingga 700°C.   

Apabila baja dipanaskan hingga suhu yang sangat tinggi, akan sangat mungkin 

terjadi perubahan penampilan luar dan warna. Bila suhu pemanasan tidak 

mencapai sekitar 700°C, lapisan yang disebut sebagai tightly adherent mill scale 

akan tetap tersisa, menyebabkan warna baja akan tetap normal. Pada suhu  yang 

lebih tinggi dari 700°C dan lebih dari 20 menit, permukaan baja akan  terlihat 

teroksidasi dan berbintik-bintik, dengan sejumlah erosi dan pengurangan  

ketebalan penampang baja. Penampilan dari baja yang terbakar secara signifikan 

yaitu berwarna abu-abu muda atau putih, akan tetapi dapat juga berwarna sesuai 

dengan bahan bakarnya, seperti hitam untuk sisa pembakaran.   

 

2.3.4.2. Hal-hal yang Terjadi pada Fase Pendinginan Pasca Kebakaran   

Baja akan berkontraksi (contract) pada saat pendinginan. Apabila 

deformasi inelastis terjadi pada saat kebakaran dan akibat beban kerja serta 

pengekangan  termal sebelumnya, struktur baja akan mengalami sisa deformasi 

secara permanen  dan tidak akan kembali ke bentuk awalnya. Perubahan 

geometris akibat kebakaran  dan pendinginan akan mengakibatkan beberapa 

sambungan baja mengalami  kegagalan tarik.   

 

 

 

 

 

Kajian keruntuhan..., Rifky Netriady, FTUI, 2012



BAB II. STUDI PUSTAKA  27 

RIFKY NETRIADY  07 06 172 582 

Universitas Indonesia 

2.4. LITERATUR JEMBATAN KRASAK   

2.1.1.  Jembatan Krasak Secara Umum   

2.4.1.1.Data Teknis   

Berikut ini adalah data-data umum mengenai spesifikasi Jembatan Krasak:   

 Panjang Total: 224 m   

 Bentang Terpanjang : 120 m   

 Lebar : 1,00 + 7,00 + 1,00 m   

 Tipe Bangunan Atas : Jembatan Rangka Baja Callendar Hamilton   

 Tipe Bangunan Bawah: Pondasi Langsung dan Sumuran   

 Lokasi : Km 19 dari Yogyakarta ke arah Magelang   

 Waktu Pembangunan : 1974 – 1976 [10]  

 Gambaran mengenai lokasi Jembatan Krasak dapat dilihat di bawah ini:  

 

 

Gambar 2.5. Peta Lokasi Jembatan Krasak [10] 

 

Sedangkan sketsa dari Jembatan Krasak dapat dilihat seperti di bawah ini:   

 

 

Gambar 2.6. Sketsa Jembatan Krasak [10] 
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Jembatan Krasak merupakan salah satu tipe Jembatan Callendar Hamilton 

(CH) dengan bentang terpanjang di Indonesia. Jembatan CH mulai digunakan di 

Indonesia pada pertengahan tahun tujuh puluhan dan merupakan jembatan rangka  

baja hasil produksi Balfour Beaty di Inggris. Terdapat dua tipe dari jembatan CH  

ini, yaitu through-type dan deck-type. Rangka baja pada tipe pertama berada di  

atas lantai jembatan, atau sering disebut juga dengan lantai bawah, sedangkan  

untuk tipe kedua bagian rangka baja dipasang di bawah lantai jembatan atau  

sering disebut juga dengan lantai atas. Pada umumnya jembatan CH yang banyak  

dipasang di Indonesia adalah dari tipe pertama. Jembatan Krasak pun merupakan  

tipe yang pertama tersebut, yaitu through-type.   

Pada dasarnya jembatan CH terdiri dari rangkaian panel-panel rangka 

batang, dimana tiap panel mempunyai  panjang 15 feet (4,58 meter). Panjang  

jembatan CH yang umum dijumpai merupakan rangkaian dari 7, 8, 9, 10, dan 11  

panel. Berbeda dengan Jembatan Krasak, dikarenakan bentangnya yang cukup  

besar, maka digunakan panel dengan panjang 8 meter, serta merupakan gabungan  

dari 13 panel (sisi Magelang) dan 15 panel (Sisi Yogyakarta), sehingga memiliki  

bentang total 104 meter dan 120 meter. Sambungan-sambungan dilaksanakan  

dengan menggunakan baut dan mur, sehingga tidak diperlukan pekerjaan  

pengelasan atau pemotongan ditempat. Rangka baja yang besar dan panjang dapat  

di-demontase sedemikian rupa sehingga merupakan bagian-bagian yang kecil dan  

ringan. Untuk mencegah baja dari serangan korosi, maka semua elemen baja  

diberi lapisan seng (Zn) dengan cara hot dip galvanized coating sehingga baja  

akan terlindung dari korosi untuk jangka waktu minimal 15 tahun.  

Semua bagian-bagian utama dari baja untuk jembatan CH terbuat dari high 

yield steel (HYS) yang memenuhi British Standard Specification BS 4630 Grade 

50B atau 55C dengan batas leleh 3550 kg/cm2 dan 4500 kg/cm2. Sedangkan  

bagian-bagian sekundernya terbuat dari mild yield steel (MYS) yang memenuhi  

BS Specification 4630 Grade 43A dengan batas leleh 2550 kg/cm2, untuk lebih  

lengkapnya dapat dilihat pada Tabel 2.3 di bawah ini[12].   
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Tabel 2.4. Tegangan Leleh Profil Baja Struktur Jembatan Krasak [12] 

Grade  

Tensile  
Strength  

Yield Stress Min  

Up to and  
including 
16 mm  

Over 16 mm 
and including  

25mm  

Over 25 mm  
and including  

40 mm  

Over 40 mm  
and including  

63 mm  

Over 63 mm  
and including  

100 mm  

N/mm2  N/mm2  N/mm2  N/mm2  N/mm2  N/mm2  

43 A   430/510  255 245 240 230 225 

50 B   490/620  355 345 345 340 325 

55 C   550/700  450 430 415  -   -  

 

 

2.4.1.2.Bagian-Bagian Jembatan Callendar Hamilton [11]  

Bagian-bagian jembatan (bridge elements) CH direncanakan sedemikian 

rupa sehingga dapat memenuhi hal-hal sebagai berikut:   

 Bagian-bagian jembatan distandarisasi sehingga merupakan bagian-bagian 

standar yang tidak banyak macamnya.   

 Bagian-bagian jembatan ini dapat disetel sedemikian rupa, sehinnga dapat 

dibangun sebuah jembatan secara ekonomis, sesuai dengan bentang serta 

kekuatan yang dikehendaki.   

 Bagian-bagian jembatan itu dapat dibuat dengan mudah serta murah 

dengan menggunakan bahan-bahan standar yang mudah diperoleh, dapat 

dibuat dengan ketelitian serta keseragaman yang tinggi.   

 Bagian-bagian jembatan itu ringan, sehingga dengan mudah dapat di 

angkut.   

 Seluruh jembatan dengan mudah dapat disetel serta dipasang lengkap 

tanpa menggunakan tenaga-tenaga yang khusus harus dididik untuk  

pekerjaan tersebut, sehingga tenaga buruh setempat, dengan sedikit  

bimbingan, dapat melaksanakan pemasangan jembatan tersebut.   

 Berbagai macam lantai kendaraan dapat di pasang pada kendaraan ini.   

 Semua bagian jembatan memperoleh pengolahan sedemikian rupa 

sehingga terlindung terhadap serangan korosi.   

 Jembatan sewaktu-waktu dengan mudah dapat di demontase tanpa 

menimbulkan kerusakan-kerusakan pada bagian-bagiannya.  
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Bagian-bagian jembatan Callender Hamilton dibuat dari baja (Hot Rolled 

Structural Steel) yang diolah oleh British Steel Corporation. Bahan-bahan berupa  

pelat baja, angles, dan sebagainya harus memenuhi British Standard Specification  

BS-4360 Weldable Structural Steels. Semua bahan-bahan untuk bagian-bagian  

jembatan harus diuji sebelum digunakan dan harus disertai test certificates yang  

menyatakan bahwa bahan-bahan itu memenuhi persyaratan yang diminta,  

mendapat persetujuan para pemeriksa bahan-bahan yang khusus diangkat oleh  

Balfour – Beatty, untuk kemudian dipakai sebagai bahan baku bagi bagian-bagian  

jembatan CH.   

 Bagian-bagian utama dari jembatan Callender Hamilton, seperti:   

 Angles (top chord, bottom chord, diagonal chord).   

 Angle cleats.   

 Leg Plates.   

 Crossbearers.   

 Crossbearer cleats.   

 Stringers. Harus dibuat dari High Yield Steel (HYS) yang memenuhi 

British Standard Specification BS 4360 Grade 50 B atau Grade 55 C.   

 Bagian-bagian sekunder, seperti:   

 Redundant Angles (Horisontal, diagonal)   

 Batten Plates   

 Redundant Gusset Plates   

 Crossbearer Diaphragms, harus dibuat dari Mild Steel yang memenuhi 

British Standard Specification BS 4360 Grade 43 A.   

 

2.4.2.  Sifat Material Jembatan Krasak   

Secara umum, sifat material Jembatan CH sudah disebutkan di bagian 

sebelumnya, yaitu dengan nilai rata-rata sebagai berikut:   

o Modulus Elastisitas (Es) : 200.000 MPa[7]   

o Tegangan Leleh (fy) : 450 MPa [12]  

o Tegangan Ultimate (fu) : 700 MPa [12]  

o Massa Jenis : 7850 kg/m3 [7] 

Akan tetapi, dikarenakan analisa yang dilakukan pada tulisan ini 
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menggunakan variasi suhu sebagai bebannya, maka sifat material yang digunakan 

juga akan bervariasi sesuai dengan suhu batang baja pada saat itu. Selain itu, 

analisa profil baja terhadap suhu memerlukan beberapa input lain dari sifat 

material baja, yaitu koefisien perpanjangan linear terhadap suhu (α1), 

konduktifitas termal (k), serta kapasitas panas (Cp). Nilai dari sifat material 

tersebut terhadap perubahan suhu dapat dilihat seperti berikut ini:   

 

2.4.2.1.   Kondisi Tegangan-Regangan (stress-strain) Baja [7].   

Hubungan antara tegangan-regangan (stress-strain) baja yang bervariasi  

terhadap perubahan suhu. Pada penelitian sebelumnya yang dilakukan Arya 

Perdana, menggunakan kurva hubungan tegangan-regangan  yang dapat dilihat 

pada Gambar 2.7, dimana kurva hubungan tegangan-regangan yang akan penulis 

gunakan (mengacu pada Eurocode 1) adalah sama seperti Gambar 2.8 di bawah 

ini:   

 

Gambar 2.7. Grafik Hubungan Tegangan-Regangan Baja Akibat Pertambahan 

Temperatur[1] 
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Gambar 2.8. Grafik Hubungan Tegangan-Regangan Baja Akibat Pertambahan 

Temperatur[7]  

 

Dari grafik tersebut, jelas terlihat bahwa kekuatan profil baja akan  

menurun seiring dengan bertambahnya suhu. Pada aplikasinya terhadap  program 

yang digunakan untuk analisa, nilai stress pada grafik ini akan  dikali dengan 

besaran tegangan leleh (fy) baja, untuk  mendapatkan hubungan nilai tegangan-

regangan yang sebenarnya.   

 

2.4.2.2. Perpanjangan Linear Baja terhadap Suhu (∆l /l)[7] 

Nilai ini merupakan sifat material yang menunjukkan nilai  perpanjangan 

material akibat efek pemanasan batang baja. Berdasarkan  Eurocode 3, bagian 

1.2[7], perpanjangan akibat temperatur (thermal strain) di definisikan dalam fungsi 

temperatur dan dapat ditentukan dengan persamaan berikut:  

∆l /l = 1,2x10-5 θa + 0,4x10-8 θa
2- 2,416x10-4   (20°C ≤ θa < 750°C)   (2.24) 

∆l /l = 1,1x10-2      (750°C ≤ θa ≤ 860°C)   (2.25) 

∆l /l = 2x10-5 θa - 6,2x10-3     (860°C < θa ≤ 1200°C)   (2.26) 
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dimana, l merupakan panjang saat suhu 20°C; ∆l adalah pertambahan panjang 

akibat kenaikan suhu, dan θa adalah temperature baja. Gambar 2.9 di bawah ini 

akan menunjukkan  hubungan nilai perpanjangan termal baja terhadap perubahan 

suhu yang  terjadi pada profil baja.   

 

Gambar 2.9. Grafik Hubungan Perpanjangan (Thermal Strain) Baja Akibat Pertambahan 

Temperatur 

 

2.4.2.3. Konduktifitas Termal Baja (k)  [7]  

Sifat material ini menunjukkan kemampuan material untuk memindahkan  

panas secara konduksi yang dapat dihitung dengan persamaan berikut: 

a = 54-3,33x10-2·θa    (20°C ≤ θa ≤ 800°C)   (2.27) 

a = 27,3     (800°C ≤ θa ≤ 1200°C)   (2.28) 

Gambar 2.10 di bawah ini akan menunjukkan hubungan nilai konduktifitas 

termal baja terhadap perubahan suhu yang digunakan pada penelitian sebelumnya 

menunjukkan bahwa kenaikan suhu dan nilai konduktivitas berbanding lurus, 

dimana berbeda dengan kurva yang pada Gambar 2.11 yang berbanding terbalik.   

0

2

4

6

8

10

12

14

16

18

20

0 200 400 600 800 1000 1200

E
lo

n
g

at
io

n
 ∆

L
/L

 [
x1

0
-3

]

Temperatur [°C]

Kajian keruntuhan..., Rifky Netriady, FTUI, 2012



BAB II. STUDI PUSTAKA  34 

RIFKY NETRIADY  07 06 172 582 

Universitas Indonesia 

  

Gambar 2.10. Grafik Hubungan Konduktifitas Termal Baja Akibat Pertambahan 

Temperatur [1] 

 

 

 

Gambar 2.11. Grafik Hubungan Konduktifitas Termal Baja Akibat Pertambahan 

Temperatur [7] 
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2.4.2.4. Kapasitas Panas Baja (Ca)
 [7]  

Sifat material ini menunjukkan kemampuan material untuk menyerap  

panas dari lingkungan di sekitarnya, nilai dari kapasitas panas  menunjukkan 

jumlah energi yang dibutuhkan untuk menghasilkan satu  unit kenaikan suhu.  

Specific Heat pada baja (J/kgK) dapat ditentukan mengikuti persamaan: 

 

ca = 425 + 7,73x10-1θa – 1,69x10-3xθa
2 + 2,22x10-6xθa

3    (20°C ≤ θa < 600°C) 

ca = 666 + 13002 / (738 - θa)                                          (600°C ≤ θa < 735°C) 

ca = 545 + 17820 / (θa - 731)      (735°C ≤ θa < 900°C) 

ca = 650        (900°C ≤θa < 1200°C) 

Variasi kapasitas panas terhadap temperature pada Gambar 2.13, 

menunjukkan nilai kapasitas panas mengalami perubahan yang sangat jauh dalam 

kisaran 700-800°C, yang meningkat tajam ke nilai "tak terbatas" pada sekitar 

735°. Nilai dari kapasitas panas baja dapat dilihat pada  Gambar 2.13.  Sedangkan 

pada penelitian sebelumnya ditunjukkan pada Gambar 2.12 

 

Gambar 2.12. Grafik Hubungan Kapasitas Panas Baja Akibat Pertambahan Temperatur [1] 
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Gambar 2.13. Grafik Hubungan Kapasitas Panas Baja Akibat Pertambahan Temperatur [7] 

 

2.4.3.  Sifat Material Jembatan Model   

2.4.3.1. Kondisi Tegangan-Regangan (stress-strain) Aluminium [17].   

Untuk mengetahui hubungan antara tegangan-regangan (stress-strain) 

pada aluminium yang bervariasi  terhadap perubahan suhu, penulis mengambil 

informasi dari salah satu jurnal sebagai acuan maupun pendekatan seperti  yang 

dapat dilihat pada Gambar 2.14. 

 

Gambar 2.14. Grafik Hubungan Tegangan-Regangan Aluminium terhadap Temperatur [17] 

Kajian keruntuhan..., Rifky Netriady, FTUI, 2012
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2.4.3.2. Perpanjangan Linear terhadap Suhu (∆l /l) Aluminium[18] 

Nilai ini merupakan sifat material yang menunjukkan nilai  perpanjangan 

material akibat efek pemanasan batang aluminium terhadap waktu yang dapat 

dilihat pada tabel 2.5. 

Tabel 2.5. Perpanjangan Linear Aluminium (Thermal Expansion) [18] 

 

 

2.4.3.3. Konduktifitas Termal Aluminium (k) [18]  

Sifat material ini menunjukkan kemampuan material untuk memindahkan  

panas secara konduksi yang dapat dilihat pada tabel 2.6. 

 

2.4.3.4. Kapasitas Panas Aluminium (Ca)
 [18]  

Sifat material ini menunjukkan kemampuan material untuk menyerap  

panas dari lingkungan di sekitarnya, nilai dari kapasitas panas  menunjukkan 

jumlah energi yang dibutuhkan untuk menghasilkan satu  unit kenaikan suhu yang 

dapat dilihat pada tabel 2.6. 

Tabel 2.6. Konduktifitas dan Kapasitas Panas Aluminium [18] 

 

 

2.5. ANALISA DARI PENELITIAN SEBELUMNYA [1]  

2.5.1. Penelitian Prof. Ir. Sidharta S Kamarwan 

Penelitian sebelumnya ini dilakukan oleh Prof. Ir. Sidharta S Kamarwan 

dalam laporan singkatnya yang berjudul “JEMBATAN RANGKA BAJAPUN 

DAPAT TERBAKAR DAN RUNTUH”. Pada laporan tersebut, beliau 

menuliskan perilaku keruntuhan Jembatan Krasak sebagai berikut: ”Penyebab 

runtuhnya jembatan dapat dipastikan oleh timbulnya kebakaran di Jembatan, yang 

mengakibatkan naiknya temperatur pada  badan Jembatan. Kenaikan temperatur 

ini menyebabkan batang-batang baja memuai dan sekaligus menurunkan batas 

Temperature ( C ) 20 100 200 300 400 500 600 650

Thermal Expansion (10-6/C) 22 25.4 26.5 27.8 29.9 32.5 35.5 37.2

Temperature (C) -173 -73 27 127 327

Thermal Conductivity, k (W/m-K) 65 163 177 186 186

Specific Heat, c (J/kg-K) 473 787 875 925 1042

Kajian keruntuhan..., Rifky Netriady, FTUI, 2012
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leleh dan batas elastisitas baja. Akibat memuainya batang, maka akan timbul 

deformasi, baik ke arah memanjang ataupun arah melintang dari jembatan. 

Pemuaian ke arah panjang jembatan mengakibatkan timbulnya kenaikan tegangan 

normal pada tiap-tiap batang, dan pada saat yang bersamaan, justru tegangan leleh 

ijinnya menurun.    

Akibat bertambahnya gaya aksial pada baja, terutama batang tepi atas  dan 

turunnya tegangan ijin, akan mengakibatkan batang tepi ini mengalami  tekuk. 

Apabila batang ini mulai mengalami tekuk, maka segera timbul pula  gaya lentur 

(momen sekunder) yang semakin melemahkan fungsi batang-batang dalam rangka 

baja ini. Selanjutnya, muai ke arah melintang akan  mengakibatkan deformasi 

melintang pada jembatan, yaitu bagian yang  paling banyak terkena api, yang 

menimbulkan gaya tekan dengan arah tegak  lurus rangka utama jembatan. Gaya 

lateral pada jembatan ini menambah  timbulnya gaya lentur pada rangka batang 

utama, yang tentunya semakin  memperlemah fungsi batang tepi atas yang bersifat 

tekan ini. Secara  keseluruhan mempercepat deformasi, yang mengakibatkan 

runtuhnya  jembatan.   

Dari diagram 2 dan 3 serta rumus-rumusnya dapat diketahui bahwa  

apabila temperatur akibat minyak yang terbakar dari tangki itu  mengakibatkan 

kenaikan temperatur hingga 300 derajat saja sudah cukup  untuk menurunkan 

batas tegangan leleh baja menjadi 50%, dan dengan berat  sendiri dari konstruksi 

baja dan sekaligus deformasi yang timbul akan  menyebabkan batang tepi atas 

tidak mampu lagi menahan gaya tekan yang  kemudian menyebabkan batang 

tersebut melengkung. Apabila batang  tersebut melengkung sedikit saja, 

menyimpang dari sumbu batangnya, maka  hal tersebut akan menimbulkan lentur, 

serta selanjutnya batang tepi tersebut,  yang tidak direncanakan untuk menahan 

beban lentur, maka akan segera  melemah, dan akibat proses penjalaran panas, 

pada khususnya batang tepi  atas, akan diikuti oleh menurunnya tegangan batas 

leleh batang atas  tersebut, maupun batang lainnya yang berdekatan, dan 

selanjutnya diikuti  olehnya timbulnya tegangan lentur yang terjadi pada batang-

batang, yang lazimnya hanya diutamakan untuk menahan gaya aksial, maka 

jembatan itu  secara perlahan-lahan menurun dan akhirnya runtuh.   
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Di lapangan pada tanggal 10 Mei 1991, masih terdapat kerangka  jembatan 

yang ambruk tersebut. Jembatan yang terbakar adalah jembatan  sisi Semarang, 

yang panjangnya 88 m. Bagian yang runtuh adalah pangkal  jembatan yang 

menumpang pada abudment sisi Semarang. Sedangkan  perletakan jembatan yang 

menumpang pada pilar tengah bersandar pada  tiang tersebut.    

Batang tepi atas jembatan yang terbakar kelihatan hangus, dan dalam  

keadaan kacae dan bengkok tidak karuan. Sedangkan batang tepi bawah  terlihat 

lurus saja. Pada bagian jembatan ini tampak bangkai truk tangki  yang terguling 

dan yang tegak. Dilaporkan bahwa setelah api padam,  ternyata di dalam tangki 

masih menyimpan 1700 liter minyak yang  tertinggal tidak terbakar. Dilaporkan 

pula bahwa tidak benar terjadi ledakan,  mungkin yang terjadi hanya ‘ngobos’.    

Laporan ini dapat diterima, mengingat tutup tangki terbuka, sehingga  

tidak akan timbul tekanan besar di dalam truk tangki. Jadi tentunya tidak  terjadi 

ledakan. Bila terdengar letusan, hal itu mungkin disebabkan oleh ban  truk itu 

yang meletus. Tapi bukan meledak, yang memerlukan daya lebih  besar. 

Seandainya timbul ledakan, tentunya tangki itu akan pecah atau  peyot, yang 

ternyata tangki dari truk tersebut dalam keadaan baik.   

Hal itu semua menguatkan dugaan bahwa ambruknya jembatan tersebut  

bukan disebabkan oleh ledakan, aka tetapi lebih disebabkan oleh tingginya  

temperatur yang menyebabkan timbulnya deformasi pada seluruh tubuh  jembatan 

dan turunnya tegangan leleh Elastisitas bahan, yang melebihi batas  yang 

direncanakan, sehingga secara jelas jembatan tersebut oleh berat  sendiri dan 

beban truk tersebut berangsur-angsur runtuh. Saksi mata  mengungkapkan 

turunnya badan jembatan tersebut 15 sampai 20 menit.”   

 

2.5.2 Penelitian Oleh Arya Perdana 

Penelitian yang dilakukan oleh Arya Perdana dengan melakukan simulasi 

pemodelan dengan model 2D dan 3D, menyimpulkan bahwa penggunaan Model 

2D untuk menganalisa perilaku struktur akibat kenaikan suhu kurang tepat untuk 

dilakukan, dikarenakan perilaku struktur yang terjadi pada Model 2D hanya 

mendekati keadaan sebenarnya, baik nilai ataupun pola keruntuhannya, sampai 

Kajian keruntuhan..., Rifky Netriady, FTUI, 2012
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pada keadaan sebelum runtuh, lebih tepatnya sampai sekitar menit ke-190, atau 

±1075 °C.  

Proses keruntuhan yang terjadi berbeda jauh dengan kondisi pada Model 3D, 

yang disebabkan hilangnya sejumlah elemen yang mengalami kenaikan suhu pada 

Model 2D, yaitu pada pengaku transversal atas. 

 

2.6. STRUKTUR MODEL[15] 

Struktur model merupakan suatu struktur yang disederhanakan secara 

signifikan dengan tidak mengurangi atau menghilangkan sifat-sifat penting pada 

prilaku struktur yang sebenarnya atau disebut sebagai Prototype. Penyederhanaan 

struktur model harus direncanakan berdasarkan ketentuan hubungan persamaan 

(similitude requirements) struktur model terhadap struktur prototype. 

Struktur model dapat dibagi menjadi tiga bagian, antara lain: 

1. True models, dimana kesamaan dari keseluruhan model dapat dipertahankan 

(complete similarity). Seperti faktor skala berikut: 

 

2

2

,        1

,      

,            1

Q l E

l E
M l

a

E

S S S S

S S
S S S

S

S S S





 

 

 

 

 

dimana,  

SQ : skala faktor gaya 

Sl  : skala faktor panjang 

SE : skala faktor modulus elastisitas 

S : skala faktor regangan 

S : skala faktor tegangan 

S : skala faktor lendutan 

Sa : skala faktor percepatan 

SM : skala faktor massa 

Sv : skala faktor angka poison 
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Model dan prototype memiliki kesamaan bentuk dan prilaku seperti gambar 

dibawah ini:  
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2. Adequate models, dimana kesamaan dari beberapa parameter model dapat 

dipertahankan. 

3. Distorted models,  dimana satu atau lebih parameter model tidak terpenuhi. 

 

2.6.1. Skala Model 

Hubungan perbandingan panjang dalam menyamakan posisi dan setara. 

Alternatif setiap panjang pada prototype menghasilkan faktor yang konstan disebut 

skala. Penyederhanaan model struktur dengan skala tertentu dilakukan dengan 

mengecilkan ukuran dari dimensi struktur tanpa menghilangkan sifat dan 

karakteristik terpenting dari struktur prototype. 

(P1/P2) = (B1/B2) = D1/D2) = (H1/H2) skala 1/100 

Persamaan ini selalu ide dasar utama untuk metode membuat suatu persanaan, jika 

P = B + H + (B2 + H2)
1/2 

Dapat diperlihatkan seperti berikut ini ; 

 

 

Catatan : jika persamaan diatas betul kemudian 

 

Selanjutnya   ---- (OK) 

Dalam bentuk umum A + B + C + D + ----------------- = 0 
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Am/Ap = Bm/Bp = Cm/Cp = Dm/Dp = ---------- 

m = model ; p = prototype 

Dimana A, B, C dst adalah suku persamaan koreksi dimensi. 

Tujuan Dari Skala Model 

1. Verifikasi model analisa terhadap hasil percobaan.  

2. Mengetahui prilaku sistem struktur secara keseluruhan. 

3. Mempelajari prilaku struktur dengan kombinasi jenis elemen yang 

berbeda.  

Tabel 2.7. Faktor Skala Pada Model Statik Elastis[15] 

Kuantitas Dimensional Faktor Skala 

Propertis Bahan 

Tegangan,  FL-2 SE 

Modulus Elastisitas, E FL-2 SE 

Angka Poisson,  -- 1 

Berat Jenis,  FL-3 SE/SL 

Regangan,  -- 1 

Geometri 

Dimensi Linear, l L SL 

Displacement,  L SL 

Area, A L2 SL
2 

Momen Inersia, I L4 SL
4 

Beban 

Beban Terpusat, Q F SESL
2 

Beban Merata, w FL-1 SESL 

Beban Area, q FL-2 SE 

Momen, M atau Torsi, T FL SESL
3 

Gaya Geser, V F SESL
2 
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Tabel 2.8. Faktor Skala Pada Model Thermal[15] 

Kuantitas Dimensional 
True 

Model 

Kesamaan 
pada Material 

dan Suhu 

Distorted 
Skala 

Regangan 

Tegangan,  FL-2 SE 1 SSθSE 

Regangan,  -- 1 1 SSθ 

Modulus Elastisitas, E FL-2 SE 1 SE 

Angka Poisson, u -- 1 1 1 

Koef. linear expansion,  θ-1 S 1 S 

Thermal diffusivity, D L2T-1 SD 1 SD 

Dimensi Linear, l L SL SL SL 

Displacement, d L SL SL SL 

Temperatur, θ θ 1/S 1 Sθ 

Time, t T SL
2/SD SL

2 SL
2/SD 

 

 

2.7. PERHITUNGAN TRANSFER PANAS DENGAN PENDEKATAN 

METODE ELEMEN HINGGA[16]
 

 

Dalam bagian ini akan dibahas perumusan dari perhitungan transfer panas 

dari beban termal yang bervariasi terhadap lokasi dan waktu (unsteady heat 

transfer). Sebagai contoh, diasumsikan terjadi efek pendinginan pada butiran baja 

bulat, seperti dalam Gambar 2.9 berikut ini: 

 

Gambar 2.15. Peristiwa Pendinginan Butiran Baja Kecil[16]
 

 

Nilai variabel termofisik (thermophysical variables) yang akan 

mempengaruhi hasil solusi terdapat pada gambar di atas. Dikarenakan butiran baja 

bulat yang relatif sangat kecil tersebut, maka perubahan temperatur terhadap 
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waktu di dalam butiran tersebut dapat diabaikan. Sehingga dapat didapatkan 

rumusan dari proses perubahan suhu terhadap waktu dengan rumus berikut ini: 

. . . .

in out gen storedE E E E          (2.29) 

Serta dalam permasalahan ini, kondisi batasnya adalah: 

. .

in gen 0E E          (2.30) 

Selain itu, perpindahan panas secara konveksi yang terjadi antara butiran tersebut 

dan fluida di sekitarnya dirumuskan dengan persamaan berikut ini: 

 
.

out fE hA T T          (2.31) 

Sedangkan besaran energi yang tersimpan (Estored) merepresentasikan penurunan 

energi termal dari butiran tersebut dikarenakan efek pendinginan, yang 

dirumuskan dengan: 

.

stored

dT
E cV

dt
        (2.32) 

Persamaan 2.30, 2.31, dan 2.32 apabila disubstitusi dengan Persamaan 2.29 akan 

menjadi: 

   f

dT
hA T T cV

dt
         (2.33) 

Dengan mengasumsikan bahwa proses pendinginan terjadi di tempat yang 

sangat besar, sangat masuk akal untuk mengkondisikan bahwa termperatur dari 

fluida di sekelilingnya tidak akan berubah terhadap waktu. Hal ini menyebabkan 

nilai Tf dalam Persamaan 2.33 menjadi konstan. Sehingga Persamaan 2.33 akan 

menjadi persamaan diferensial tingkat satu dan untuk menyelesaikannya, akan 

dianggap nilai Θ = T(t) – Tf, serta dengan memisahkan variabelnya dan 

mengintegrasinya, akan didapat hasil: 

0
ln

i

t
id cV d cV

hA cV dt t
dt hA hA





 


 
       

     (2.34) 

Sehingga waktu yang dibutuhkan butiran tersebut untuk mencapai temperatur 

tertentu dapat dirumuskan dengan: 

ln
i f

f

T TcV
t

hA T T

 



       (2.35) 
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Selanjutnya apabila kita ingin mengetahui temperatur dari butiran tersebut pada 

waktu tertentu, Persamaan 2.35 dapat diubah menjadi seperti berikut ini: 

exp
i f

f

T T hA
t

T T cV

  
  

  
       (2.36) 

Untuk permasalahan transient, kita dapat juga menghitung jumlah panas yang 

dipindahkan pada fluida (atau dikeluarkan dari benda padat tersebut) dalam waktu 

t tertentu. Hal ini dapat dihitung dengan: 

 
0

t

fQ hA T T dt          (2.37) 

Dengan mensubstitusikan T – Tf pada Persamaan 2.36 kepada Persamaan 2.37 

serta mengintegrasinya, akan didapatkan: 

  1 expi f

hA
Q cV T T t

cV




  
     

  
     (2.38) 

Dalam menghadapi analisa perpindahan panas secara transient, terdapat dua 

besaran tanpa dimensi (dimensionless), yaitu angka Fourier dan angka Biot, yang 

dapat sangat membantu. Angka Biot dapat menyatakan besar tahanan termal dari 

suatu benda padat (solid) yang mengalami pendinginan (dapat pula pemanasan) 

relatif terhadap tahanan termal dari proses pendinginan (atau pemanasan) dari 

fluida di sekitarnya. Angka Biot dapat didefinisikan dengan rumus berikut: 

solid

chL
Bi

k
         (2.39) 

Dimana Lc adalah panjang karakteristik (characteristic length) dari suatu 

benda, serta dapat pula didefinisikan sebagai rasio dari volume suatu benda 

terhadap luas permukaan yang terbuka (exposed). Nilai dari angka Biot yang 

cukup kecil (Bi < 0,1) mengindikasikan bahwa tahanan termal dari benda padat 

tersebut dapat diabaikan dan sebagai konsekuensinya distribusi temperatur di 

dalam benda padat tersebut akan sama di setiap titik.  

Variabel penting selanjutnya adalah angka Fourier, yang merupakan 

parameter waktu tanpa dimensi (dimensionless). Angka ini menyatakan nilai 

kecepatan konduksi (rate of conduction) dalam suatu benda padat secara relatif 

terhadap kecepatan penyimpanan termal (rate of the thermal storage). Angka 

Fourier didefinisikan dengan: 
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2
c

t
Fo

L


          (2.40) 

Dimana α adalah tingkat penyebaran panas serta setara dengan α = k/ρc. Nilai dari 

tingkat penyebaran panas ini merepresentasikan seberapa baik material tersebut 

dalam kemampuannya mengkonduksikan panas apabila dibandingkan dengan 

kemampuannya menyimpan panas. Sehingga material dengan tingkat penyebaran 

panas yang kecil akan bersifat lebih baik dalam menyimpan energi termal 

dibandingkan dengan mengkonduksikannya. 

Formulasi elemen hingga untuk permasalahan ini menuju pada bentuk 

formula umum (general form) berikut ini: 

[K]{T} = {F}         (2.41) 

[matriks konduktifitas]{matriks temperatur} = {matriks beban termal} 

Untuk kondisi permasalahan transient, harus diikutsertakan perhitungan 

penyimpanan energi termal, yang akan merubah bentuk Persamaan 2.41 menjadi: 

[C]{T’} + [K]{T} = {F}       (2.42) 

[matriks simpanan panas] + [matriks konduktifitas]{matriks 

temperatur} = {matriks beban termal} 

Dalam perhitungan untuk memperoleh solusi, pada titik diskrit (discrete 

point) waktu tertentu, berdasarkan sistem formula pada Persamaan 2.42, harus 

dilakukan prosedur integrasi terhadap waktu. Pemilihan langkah waktu (time step) 

yang terlalu kecil akan menghasilkan perubahan hasil yang kurang akurat 

(spurious oscillation) dalam perhitungan solusi temperatur yang mengakibatkan 

hasil yang tidak bermakna (meaningless). Sebaliknya, apabila langkah waktu yang 

digunakan terlalu besar, maka gradien temperatur tidak dapat dihitung secara 

akurat. Kita dapat menggunakan angka Biot (
solid

h x
Bi

k


 ) dan angka Fourier 

(
 

2

t
Fo

x





) terhadap langkah waktu yang masuk akal (reasonable). Nilai Δx 

dan Δt masing-masing merepresentasikan nilai tengah panjang elemen dan 

langkah waktu. Untuk permasalahan dimana Bi < 1, maka ukuran langkah waktu 

dapat diperkirakan dengan mengeset angka Fourier setara dengan mengatur nilai b 

yang nilainya berkisar antara 0,1 hingga 0,5 seperti diperlihatkan di bawah ini: 
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 
2

t
Fo b

x


 


        (2.43) 

Dapat diperoleh besaran Δt, dengan: 

 
2

x
t b




  , dimana0,1 0,5        (2.44) 

Untuk permasalahan dengan Bi > 1, maka besar langkah waktu dapat diperkirakan 

dengan perkalian angka Fourier dan Biot seperti di bawah ini:  

2
solid

( )( )
( )

t h x
Fo Bi b

x k

    
      

      (2.45) 

Dapat diperoleh besaran Δt, dengan: 

   solidx k x c
t b b

h h





 
   , dimana 0,1 ≤ b ≤ 0,5   (2.46) 

ANSYS menggunakan skema Euler dalam integrasi waktu seperti di bawah ini: 

         1 11p p p pT T t T t T              (2.47) 

Pada Persamaan 2.47, θ merupakan parameter Euler. Solusi temperatur dapat 

diperoleh untuk langkah waktu p + 1 berdasarkan data nilai temperatur pada 

langkah waktu sebelumnya p, dimulai dari waktu t = 0, sesuai dengan langkah 

waktu p = 0, dimana nilai temperatur awal diketahui. Untuk skema implisit, yang 

mutlak stabil, besaran nilai dari θ dibatasi antara 
1

1
2

  . Apabila 
1

2
  , skema 

integrasi yang dilakukan biasa disebut dengan Crank-Nicolson. Skema tersebut 

menyediakan hasil yang akurat untuk sebagian besar masalah perpindahan panas 

secara transient. Apabila θ = 1, teknik integrasi yang dilakukan dinamakan 

“Backward Euler” dan merupakan kondisi standar (default setting) pada ANSYS. 

Dengan mensubstitusi Persamaan 2.47 pada Persamaan 2.22, maka: 

               

Setara matriks FSetara matriks K

p 1 p p11 1
C K T F C T T

t t 1



 
   

     
    



    (2.48) 

Sistem formula dari Persamaan 2.28 dapat diselesaikan untuk memperoleh 

temperatur nodal pada titik waktu diskrit tertentu. Beban termal dapat 

diaplikasikan baik secara tiba-tiba (stepped), atau menanjak (ramped) dalam 

program ANSYS. Selain itu, dalam mencapai nilai konvergensi dalam persamaan 
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nonlinear, digunakan Metode Full Newton-Rhapson. Persamaan dasar yang 

digunakan adalah: 

   1 1 1 0n n nR R u P u f           (2.49) 

Persamaan tersebut dapat dinyatakan dalam ekspansi deret Taylor dengan 

mengambil dua suku pertamanya yaitu ( 1 ) ( ) 

   1
1 1

1

i

i i i
n n n

n

R
R u R u u

u

 



 
   

 
      (2.50) 

Dimana i merupakanhitungan integrasi yang dimulai dari 

1
i
n nu u           (2.51) 

Dan 

T

R P
K

u u

 


 
         (2.52) 

Dengan KT adalah matriks Jacobian atau dalam struktur dikenal sebagai matriks 

kekakuan yang berhubungan dengan arah tangensial. Dengan mendistribusikan 

Persamaan 2.49 hingga Persamaan 2.52 di atas, maka diperoleh: 

1
i i i
T n nK u R            (2.53) 

1
1 1

i i i i
n n n n nu u u u u
              (2.54) 

1

i
i k
n n

k

u u


            (2.55) 

Langkah-langkah perhitungan metode iterasi Full Newton-Raphson : 

a. Perhitungan data awal 

 0 0 1
1                                    j

i i s s i T ii
u u f f R p k k

      


 

b. Perhitungan data iterasi 

1.  j j j
Tk u R u   


 

2.  1
1 1

j j j
i iu u u
     

3.   1j i j j
s s T Tf f f k k u     


 

4.  1j j jR R f      
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BAB 3 

METODOLOGI PENELITIAN 

 

3.1. PROSEDUR ANALISA UMUM 

Tulisan ini merupakan sebuah penelitian terhadap struktur Jembatan 

Krasak dengan suatu pendekatan dengan model berskala berdasarkan ketentuan 

dari teori kesamaan (similitude theory) yang kemudian dilanjutkan dengan proses 

simulasi menggunakan bantuan program ANSYS v11.0 sebagai program simulasi. 

Proses penelitian itu sendiri dilakukan sesuai dengan urutan pada Gambar 3.1. 

Adapun tahapan yang harus dilakukan pada saat menjalankan penulisan ini 

adalah: 

1. Studi literatur. Penulis mencari dan mempelajari berbagai macam data 

mengenai hal-hal yang berhubungan dengan kebakaran, yaitu hal-hal yang 

menyebabkan dan diakibatkannya. Hal ini sudah dilakukan pada bab 

sebelumnya, tepatnya pada Bab 2, dari Subbab 2.1 hingga Subbab 2.5. 

2. Studi data historis. Penulis mempelajari informasi-informasi dari 

penelitian sebelumnya, mengenai proses dan kejadian keruntuhan 

Jembatan Krasak sampai sedetail mungkin serta data yang berhubungan 

dengan dimensi struktur Jembatan Krasak dan beban truk tangki 

bermuatan 16000 liter premix. Dimana data-data tersebut akan 

dimanfaatkan dalam melakukan modelisasi struktur dan keadaan Jembatan 

Krasak pada kondisi yang semirip mungkin dengan aslinya. Data detail 

dimensi Jembatan Krasak hasil pengukuran secara langsung pada lokasi 

akan dibahas pada Bab 3, Subbab 3.2. Untuk data dimensi truk tangki 

bermuatan 16000 liter premix akan dibahas pada Bab 3, Subbab 3.3. 

3. Perencanaan model dengan menentukan skala setiap parameter struktur 

berdasarkan ketentuan dari teori kesamaan yang akan dibahas pada Bab 3, 

Subbab 3.5. 

4. Melakukan pengujian statik terhadap jembatan model. 
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5. Menghitung beban lalu lintas saat terjadinya kebakaran, dan beban termal 

yang dihasilkan dari proses pembakaran yang dinyatakan dengan gambar 

gradien temperatur pada tiap elemen profil rangka baja yang mengalami 

kenaikan suhu. Data pembebanan ini akan dibahas pada Bab 3. 

6. Melakukan analisa struktur terhadap jembatan model menggunakan 

bantuan program ANSYS v11.0 sebagai program simulasi guna 

mengetehui prilaku struktur berupa hubungan tegangan regangan yang 

terjadi dan pola deformasi rangka alumunium struktur dari jembatan model 

berdasarkan data yang diperoleh dari hasil pengujian. Hasil simulasi ini 

akan ditampilkan pada Bab 4 

7. Melakukan analisa struktur jembatan krasak menggunakan bantuan 

program ANSYS v11.0 sebagai program simulasi guna mengetahui 

prilaku struktur berupa hubungan tegangan regangan yang terjadi dan pola 

deformasi rangka baja struktur dari Jembatan Krasak. Hasil simulasi ini 

akan ditampilkan pada Bab 4 

8. Kesimpulan. Penulis membahas dan menyimpulkan hasil poin 1 sampai 7 

di atas. Hal ini akan disajikan pada Bab 5. 

 

3.1.1. Proses Penelitian 

 

Model Percobaan

Pembebanan

Output Hasil

Mulai

Pola Keruntuhan

Evaluasi Terhadap Sumber
Peristiwa Keruntuhan

Kesimpulan

Selesai

Evaluasi Terhadap
Penelitian Sebelumnya

Simulasi Model Simulasi Krasak

GeometriKarakteristik
Material

Waktu

Temperatur

Regangan

Lendutan
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Gambar 3.1. Proses Penelitian 

3.1.2. Alur Pembebanan 

Alur proses dalam analisa perilaku struktur ditunjukkan seperti Gambar 

3.2 yang terdiri dari tiga model komponen penting, yaitu:  model api, model 

perpindahan panas dan pemodelan struktur. Model Api dapat berupa kurva 

temperatur nominal dan kurva parameter temperatur. Untuk elemen struktur 

sederhana dengan tertentu akan menghasilkan suatu model perpindahan panas 

yang dapat digunakan secara langsung untuk menilai apakah temperatur kritis 

sudah terlewati.  

 

 

 

Gambar 3.2. Alur Perhitungan Kapasitas Beban Suatu Struktur Terbuka Terhadap Api [5] 
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3.2. GEOMETRI STRUKTUR JEMBATAN KRASAK 

3.2.1. Profil Baja Pada Struktur Jembatan Krasak   

3.2.1.1. Umum   

Secara keseluruhan, bagian-bagian pada Jembatan Krasak terdiri dari 3 

bagian, yaitu bagian diagonal (sisi barat dan timur), bagian bawah (dek), serta  

bagian atas (pengaku). Ketiga bagian dari Jembatan Krasak tersebut akan dibahas 

lebih lanjut pada  subbab selanjutnya dari tulisan ini. Pembahasan akan dilakukan 

mengenai profil  yang digunakan dalam setiap bagian, dimensi 

 

3.2.1.2. Bagian Diagonal   

 

Gambar 3.3. Penamaan Profil Baja Jembatan Krasak Bagian Diagonal 

 

 

Gambar 3.4. Potongan Melintang Profil Balok 

 

720

720

720

200

200

30

20200

720
20030

200

200

30

20200

720

200

20030

20

20

20

20

20

200

20
200

20

200

200

30

20
200

200

200

Plat Kopel t=10mm

Spasi =1330mm

30

20 200

30 200

200

200

Lu
a
r

D
a
la

m

30

720

20

Kajian keruntuhan..., Rifky Netriady, FTUI, 2012



BAB III. METODOLOGI PENELITIAN  53 

RIFKY NETRIADY  07 06 172 582 

Universitas Indonesia 

 

 

Gambar 3.5. Potongan Melintang Profil Bracing Dan Redundant 

 

3.2.1.3.Bagian Bawah   

Berikut ini adalah penamaan dari profil-profil baja yang ada pada 

Jembatan Krasak bagian bawah:   

 

 

Gambar 3.6. Penamaan Profil Baja Jembatan Krasak Bagian Bawah 
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Gambar 3.7. Potongan Melintang dan Tabel Data Profil 1, Profil 2, dan Profil 3 

 

3.2.1.4.Bagian Atas   

Berikut ini adalah penamaan dari profil-profil baja yang ada pada 

Jembatan Krasak bagian atas:   

 

Gambar 3.8. Penamaan Profil Baja Jembatan Krasak Bagian Atas 
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Gambar 3.9. Potongan Melintang Profil I 

 

 

Gambar 3.10. Potongan Melintang Profil II

 

Gambar 3.11. Potongan Melintang Profil III 

 

3.2.2. Struktur Jembatan Model  

Struktur jembatan model direncanakan dengan skala geometri 1:17 yang 

ditentukan berdasarkan ketersediaan jenis dan ukuran profil yang tersedia di 

pasaran, seperti yang ada pada tabel 3.1. 

Tabel 3.1. Skala Jembatan Model 

Profil Prototype Profil Model 

Tipe 
Skala 1 : 1 Skala 1 : 17 

Tipe 
Skala 1 : 1 

A (m2) 
Iyy = Izz 

(m4) 
A (mm2) 

Iyy = Izz 
(m4) 

A (mm2) 
Iyy = Izz 

(m4) 

L 100x10 0,0019 1,80E-06 6,5744 2,155E+01 L 7x0,5 6,750 3,216E+01 

L150x15 0,00427 9,11E-06 14,7751 1,091E+02 L 10x0,6 11,640 1,144E+02 

L200x20 0,0076 2,88E-05 26,2976 3,448E+02 L 13,5x0,7 18,410 3,323E+02 
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Gambar 3.12. Rangka Model bagian Atas 

 

Gambar 3.13. Rangka Model bagian Samping 

 

Gambar 3.14. Rangka Model Bagian Bawah 

 

3.3. DATA DIMENSI TRUK TANGKI [13]  

Dimensi dari truk tangki bahan bakar diperlukan untuk menentukan 

elemen-elemen mana saja yang mengalami efek kenaikan suhu (kebakaran). Data 

dimensi yang diperlukan adalah mengenai letak tangki bahan bakar yang diangkut 

oleh  truk tersebut. 

Gambar 3.15. Truk Tangki Bahan Bakar 16000 Liter [13] 
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Gambar 3.15. Truk Tangki Bahan Bakar 16000 Liter [13] 

 

Data selengkapnya mengenai dimensi truk bahan bakar dapat dilihat pada 

Tabel 3.1 berikut:   

Tabel 3.2. Dimensi Truk Tangki Bahan Bakar [13] 

 

Keterangan Dimensi (mm) 

Jarak Sumbu Roda 4130+1300 

Total Panjang 8480 

Total Lebar 2460 

Total Tinggi 2695 

Lebar Jejak Depan 1925 

Lebar jejak Belakang 1855 

Julur Belakang 1795 

  

Berdasarkan data tersebut, maka dapat ditentukan panjang tangki bahan 

bakar terhadap skala panjang yaitu: 

mod

mod

6000
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mm
L





 

 

3.4. DATA PEMBEBANAN PADA JEMBATAN KRASAK   

3.4.1.  Beban Gravitasi   

Perhitungan berat sendiri dari profil baja pada Jembatan Krasak maupun 

jembatan model dapat dilakukan dengan sendirinya oleh program ANSYS v11.0. 

Berat masing-masing  profil akan sesuai dengan massa jenis dikali dengan luas  

penampang dan bentang panjang masing-masing profil.  

800
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Berat sendiri untuk profil baja ditentukan sebesar 7850 kg/m3 dan untuk 

profil aluminium sebesar 2702 kg/m3. Untuk berat dari truk  tangki yaitu 20 

Ton[13] diskalakan menjadi 20/173 Ton atau ekivalen dengan berat 4 kg, yang akan 

didistribusikan pada nodal di sekeliling  lokasi berhentinya truk tersebut. 

Sedangkan untuk perhitungan berat total beton yang digunakan pada 

Jembatan Krasak, sebelumnya diperlukan perhitungan volume dari total beton  

yang digunakan. Apabila melihat pada potongan melintang dari beton di bawah  

ini:   

 

Gambar 3.16. Potongan Melintang Struktur Pelat Jalan Beton 

 

maka didapat luas penampang beton yang digunakan adalah 2,032 m2. 

Dengan  bentang Jembatan Krasak yang mencapai 104 m, maka total volume dari 

beton  yang digunakan pada Jembatan Krasak adalah 211,328 m3. Selanjutnya 

apabila  diketahui berat jenis beton adalah 2400 kg/m3 , maka total berat beton 

mencapai  507187,2 kg. Beban ini selanjutnya akan dibagi faktor skala berat (Sw = 

173), menjadi 103,2 kg yang akan didistribusikan secara merata pada balok 

memanjang untuk memudahkan input dan analisa pada model jembatan.   

 

3.4.2.  Beban Termal   

Dalam penentuan beban termal yang  terjadi pada peristiwa kebakaran 

Jembatan Krasak, maka dibutuhkan data pengamatan peristiwa kebakaran 

tersebut. Data tersebut terdiri dari 2 hal, yaitu data yang berasal dari media masa 

dan data hasil wawancara dengan saksi  mata. Dari kedua sumber tersebut, 

beberapa kesimpulan yang dapat diambil mengenai peristiwa kebakaran pada 

Jembatan Krasak adalah:  

 Kebakaran bermula dari truk tangki (tidak gandeng) premix berkapasitas 

16000 liter yang terbakar di tengah bentang.  

 Kebakaran terjadi selama 8 jam, dengan sekitar 2 jam awal mencapai suhu 
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puncaknya. 

 Sisa premix sejumlah 4000 liter menandakan jumlah premix yang 

digunakan sebagai bahan bakar adalah 12000 liter. 

 Efek peningkatan suhu hanya terjadi  pada batang tepi atas jembatan, batang 

bawah masih dalam kondisi normal dan lurus.  

Dari sejumlah kesimpulan tersebut, maka beban termal yang terjadi pada peristiwa 

kebakaran Jembatan Krasak dapat dihitung dengan rumusan seperti berikut[14].  

Beban termal rata-rata dalam suatu ruangan: 

 
1

( )fire i ui i d d
f

L m H F F K
A

 
   
 
 

   (3.1) 

dimana:  

Lfire  = Beban Termal (MJ/m2).  

Af   = Luas Ruangan yang Terbakar (m2). 

mi   = Massa Bahan Bakar (kg).  

Fi   = Faktor Pembakaran {combustion}.  

Fd   = Faktor distribusi beban api.  

Kd  = Konstanta distribusi beban api.  

Hui  = Nilai Kalori Material (MJ/kg). 

Berdasarkan Gambar 3.15,  dapat dihitung besaran  Af  dengan mencari luas 

permukaan dari bahan bakar sebanyak 16000 liter. Dengan perhitungan luas 

permukaan sederhana, maka didapat Af = 2,43 m x 6 m = 14,58 m2.  

 Massa bahan bakar didapat dengan mengalikan jumlah bahan bakar yang terbakar  

dengan massa jenisnya (gasoline = 737,22  kg/m3). Berdasarkan pengamatan saksi 

mata, kebakaran terjadi selama 8 jam, sehingga jumlah bahan bakar yang  

terbakar per jamnya adalah seperdelapan dari jumlah total bahan bakar yang  

terbakar. Sehingga didapat:  

31
737, 22 / 12000 0,001 / 1105,83

8
im kg m L m L kg      

 

Parkinson[14] dalam beberapa datanya menyatakan berturut-turut nilai Fi = 0.7; Fd 

= 1; dan Kd = 1,65, untuk kondisi asumsi tidak seluruh ruangan terbakar, distribusi  

merata, serta tercapai kondisi api 90% puncak (90th Peak).  
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Selanjutnya berdasarkan Tabel 2.1, didapat nilai kalori premix (dianggap sebagai 

gasoline) yaitu 44 MJ/kg.  

Berdasarkan nilai-nilai tersebut di atas, dapat dihitung besar beban api:  

2

2

1
1105,83 44 / 0.8 1 1.65 3828 /

14,58
fireL kg MJ kg MJ m

m
        

Selanjutnya dari beban termal tersebut, dihitung nilai dari faktor ventilasi (Fv) 

dapat dihitung dengan persamaan:  

v v
v

t

A H
F

A
          (3.2) 

dimana: 

Fv  = Faktor Ventilasi (m0,5). 

Av = Luas Ventilasi (m2).  

Hv  = Ketinggian Ventilasi (m).  

At  = Luas Permukaan Ruangan selain Ventilasi (m2).  

  

Berdasarkan gambar tangki pada Gambar 3.15, didapat data tutup tangki 

berdiameter 0,8 m sebanyak 2 buah. Sehingga luas ventilasi (Av) adalah:  

2 23 0,8 1vA m m     

Ketinggian ventilasi (Hv) dari permukaan bahan bakar yaitu 0,8 m.  

Sedangkan luas permukaan ruangan selain ventilasi (At) yaitu 26,084 m2. 

Dengan mengetahui tiga nilai di atas, didapat nilai faktor ventilasi (Fv):  

2
0,5

2

1 0,8
0,034

26,084
v

m m
F m

m


   

Selanjutnya untuk mendapatkan grafik hubungan waktu-temperatur dari api yang 

terdapat pada kompartemen tangki bahan bakar, maka perlu dihitung hubungan  

waktu-temperatur yang terjadi pada profil baja struktur jembatan yang berada di  

sekitar sumber api.  

Perhitungan tersebut dilakukan dengan mengikuti teori Lie[14] dengan rumus 

pendekatan sebagai berikut ini: 

 

  (3.3) 

Sedangkan untuk fase penurunan (decay), Lie mengusulkan rumus pendekatan 

     
0,3 2

0,1 0,5

0,6 3 12 600
250(10 ) 3 1 1 4v vF F t t t t

t v
v

T F e e e e C
F

                 
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sebagai berikut: 

600 1t

t
T T

 
    

 
            (3.4) 

dimana: 

 1/2
330

fire t

v v

L A

A H
              (3.5) 

Dari persamaan (3.3) dan (3.4) maka dapat diperoleh grafik hubungan waktu-

temperatur dari api yang terdapat pada kompartemen tangki bahan bakar, yang 

kemudian digunakan untuk mendapatkan grafik hubungan waktu-temperatur pada 

baja dengan menggunakan program ANSYS sebagai program simulasi, sehingga 

gabungan dan kedua grafik tersebut diperoleh sebagai berikut:  

 

Gambar 3.17. Grafik Perbandingan Temperatur Gas dan Temperatur Baja 

 (Lfire = 3828 MJ/m2) 

 

Sedangkan untuk mendapatkan data mengenai temperatur api yang terjadi 

pada model jembatan, dapat diperoleh melalui pengujian terhadap model jembatan 

dengan menggunakan volume bahan bakar yang dapat di hitung dengan 

menggunakan skala volume  (Sl) seperti berikut:   
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3.5. PROSES PEMODELAN JEMBATAN KRASAK 

Tahapan yang dilakukan dalam perencanaan model adalah sebagai berikut: 

1. Mendefinisikan permasalahan dari percobaan yang dilakukan. 

a. Respon struktur yang diinginkan. 

b. Mekanisme keruntuhan yang terjadi. 

2. Menentukan skala model 

Tabel 3.3. Faktor Skala Pada Jembatan Model 

Spesifikasi Kuantitas Dimensi 
Skala 
Model 

Baja Aluminium 
Skala 

Prototype 

Properties 
Material 

Tegangan,   FL-2 SSθSE 
  

2,857 

Regangan,  - SSθ   
0,498 

Modulus elastisitas, E FL-2 SE 200.000 70.000 2,857 

Poisson ratio,  - 1 
  

1 

Berat jenis,  FL-3 SSθSE /Sl 7.850 2.702 0,168 

Geometri 

Dimensi linear, l L Sl   
17 

Displacement,  L SaSθ Sl   
17 

Area, A L2 Sl
2 

  
289 

Moment Inertia, I L4 Sl
4 

  
83521 

Thermal 

Coefficient of linear 
expansion,  

θ-1 S 1,17E-05 2,35E-05 0,498 

Thermal diffusivity, D L2T-1 SD 1,479E-05 8,518E-05 0,174 

Temperature, θ θ 1/S   
2 

Gaya Concentrated load, Q F SaSθSESl
2 

  
825,714 

 
3. Menentukan material yang akan digunakan sebagai model, yaitu material 

yang tersedia di pasaran. 

4. Menentukan syarat similitude (similitude requirements), bisa sebagai 

model yang benar (true model) atau sebagai model yang menyimpang 

(distorted model). 

5. Perencanaan dan pembuatan model. 

6. Menyiapkan peralatan yang akan digunakan untuk pengambilan data 

informasi prilaku dan respon struktur model. 

7. Merekam respon yang terjadi sebagai data tambahan. 
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3.6. DATA MASUKAN 

Untuk menghasilkan proses keruntuhan yang serupa dengan peristiwa 

kebakaran yang sudah terjadi, maka diperlukan suatu analisa secara 3 dimensi 

dengan memperhitungkan bentuk sebenarnya dari elemen diagonal rangka utama 

dan pengaku atas jembatan. 

 

3.6.1.  Model Struktur  

Pemodelan struktur yang dilakukan dalam simulasi ini dibagi menjadi dua 

tipe, yaitu:  

1) Simulasi model Jembatan Krasak, dari struktur rangka baja yang berada 

pada sisi bagian timur (jalur  Magelang-Yogyakarta). Bagian tersebut 

digunakan karena mengalami pembebanan gravitasi dan termal terbesar, 

yaitu karena truk tangki berhenti dan terbakar pada bagian tersebut.  

2) Simulasi model skala, merupakan model skala dari bahan alumunium  

berskala geometri 1:17 dari ukuran Jembatan Krasak sebenarnya dimana 

pembebanan gravitasi juga merupakan skala dari beban sebenarnya dan 

untuk beban termal mengacu pada hasil percobaan. 

 

3.6.2.  Dimensi Struktur  

Dimensi struktur yang dijadikan sebagai data masukan dalam program 

ANSYS v11.0, baik profil baja, sambungan dan perletakannya, adalah sesuai 

dengan dimensi yang terdapat pada Subbab 3.2. Dalam tulisan ini, struktur yang 

dimodelkan yaitu struktur baja pada Jembatan Krasak dan struktur alumunium 

pada Jembatan Model. Data geometri yang dijadikan sebagai data masukan, yaitu:  

•  Bentuk potongan penampang  

•  Ketebalan Profil  

•  Lebar Profil  

•  Tinggi Profil  

Struktur pelat (slab) jalan beton pada Jembatan Krasak dimodelkan sebagai beban 

yang terdistribusi merata pada balok atau gelagar melintang. 
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3.6.3.  Sifat Material  

Sama halnya dengan dimensi struktur, data masukan berupa sifat material 

pun dapat ditemukan pada bab sebelumnya pada tulisan ini, tepatnya pada Subbab  

2.4.2 dan 2.4.3. Data sifat material yang dijadikan sebagai masukan, yaitu:  

•  Modulus Elastisitas (Es)  

•  Tegangan Leleh (fy) dan Tegangan Ultimate (fu)  

•  Massa Jenis (kg/m3)  

•  Kurva hubungan tegangan-regangan (stress-strain)  

•  Koefisien perpanjangan linear terhadap suhu (α)  

•  Konduktifitas Termal (k)  

•  Kapasitas Panas (CP)  

 

3.6.4.  Pembebanan  

Sesuai dengan hasil pembahasan pada Subbab 3.4, pembebanan yang 

terjadi pada peristiwa keruntuhan Jembatan Krasak hanya terdiri dari beban 

gravitasi, baik dari struktur jembatan itu sendiri ditambah dengan beban  truk 

tangki, serta beban termal sesuai dengan Gambar 3.17 untuk simulasi Jembatan 

Krasak dan Gambar 4.4 dan 4.5 untuk simulasi Model Skala. 

Selain itu, batasan dan asumsi yang diberikan pada beban termal ini 

adalah:  

a. Dalam keterangan saksi mata disebutkan bahwa peristiwa kebakaran yang 

terjadi memakan waktu sekitar 8 jam. Namun grafik beban termal hanya 

mencapai waktu 6 jam. Hal ini disebabkan keterbatasan referensi, sehingga 

diasumsikan suhu yang terjadi antara  jam ke-6 hingga jam ke-8 memiliki 

gradien penurunan yang sama. 

b. Beban termal dilakukan dalam satuan menit, untuk memudahkan 

pembacaan hasil analisa struktur. Satuan menit dianggap nilai tengah dari 

satuan jam dan satuan detik. 

c. Lokasi pembebanan termal ini dilakukan berdasarkan referensi dari foto 

setelah kejadian runtuhnya Jembatan  Krasak seperti pada Gambar 3.18 

berikut:  
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Gambar 3.18. Foto Jembatan Krasak Setelah Runtuh [3] 

 

Berdasarkan Gambar 3.18, dapat diambil kesimpulan bahwa peristiwa kebakaran 

terjadi pada segmen ke-6 dan ke-7 dihitung dari pilar tengah jembatan. Atau untuk 

lebih jelasnya dapat dilihat pada Gambar 3.19  

berikut ini:  

 

 

Gambar 3.19. Lokasi Pembebanan Termal Pada Jembatan Krasak  

  

3.7. PARAMETER YANG AKAN DI EVALUASI  

Parameter yang akan dievaluasi dari  hasil analisa struktur dalam setiap 

langkah pembebanan (loadstep) adalah:  

a)  Deformasi Struktur.  

b)  Hubungan tegangan-regangan struktur.  

Sehingga dari dua parameter inilah pola keruntuhan akibat kebakaran dapat  

ditampilkan serta dianalisa lebih lanjut. 
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BAB 4 

HASIL SIMULASI DAN ANALISA 

 

4.1. HASIL SIMULASI 

4.1.1. Jembatan Model 

Jembatan model merupakan penyederhanaan dari Jembatan Krasak atau 

struktur sebenarnya (prototype) dengan skala geometri 1:17. Mekanisme tumpuan 

yang digunakan pada model ini ekivalen dengan Jembatan Krasak yaitu 

mekanisme tumpuan sendi-rol pada ke-dua ujung jembatan. Sedangkan untuk 

mekanisme sambungan antara batang menggunakan 2 (dua) paku klem (riffet) 

sebagai pendekatan terhadap mekanisme sambungan pin-joint yang juga 

didefinisikan pada program simulasi ANSYS v11.0. 

Berikut ini terlihat tampilan Jembatan Model dimana pada sisi kiri merupakan 

tumpuan roll dan sisi kanan dengan tumpuan tipe rol.  

 

Gambar 4.1. Struktur Jembatan Model (Skala 1:17) 

 

4.1.2. Uji Statik  

Uji statik dilakukan pada jembatan model yaitu untuk memastikan 

mekanisme sambungan antara join sudah bekerja dengan baik. Berikut merupakan 

hasil uji statik yang dilakukan pada titik setengah bentang jembatan, yang 

merupakan titik yang berpeluang besar akan mengalami deformasi vertikal akibat 

berat gravitasi dari struktur jembatan itu sendiri, seperti yang terlihat pada gambar 

4.2. Uji statik yang dilakukan dengan pemberian beban sebesar 12,7 kg yang 
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nilainya ekivalen dengan berat benda uji beton berbentuk silinder ukuran 15 cm x 

30 cm. 

 

Gambar 4.2. Posisi Beban dan Dial Gage pada Uji  Statik 

 

Tabel 4.1 Hasil Uji Statik 

Posisi 
Beban 

Bacaan Dial Gage 

Tanpa Beban (Awal) Dengan Beban Tanpa Beban (Akhir) 

 
[mm] [mm] [mm] 

1 0.00 -0.11 0.00 

2 0.00 -0.19 0.00 

3 0.00 -0.28 0.00 

4 0.00 -0.36 0.00 

5 0.00 -0.43 0.00 

6 0.00 -0.64 -0.01 
 

 

4.1.3. Gambaran Rangka Batang Yang Ditinjau 

4.1.3.1. Posisi Rangka Yang Mengalami Kebakaran 

Pada percobaan yang dilakukan terhadap jembatan model ini, rangka yang 

mengalami perubahan temperatur berada diantara segmen ke-6 dan ke-7 yang 

terdiri dari rangka atas dan rangka samping seperti terlihat pada gambar 4.3. 

berikut ini. 

 

 

Gambar 4.3. Posisi Rangka Yang Mengalami Kenaikan Temperatur 
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4.1.3.2. Penyebaran Suhu Pada Rangka Batang 

Pada jembatan model ini, kebakaran yang terjadi mengakibatkan 

terjadinya kenaikan temperatur pada masing-masing rangka batang dan sebagai 

gambaran sederhana maka penulis menyajikan gambar peta distribusi temperatur 

pada rangka atas dan rangka samping yang memiliki temperature lebih tinggi, 

seperti terlihat pada gambar 4.4 dan gambar 4.5 yang merupakan penyebaran 

temperatur hasil pengamatan pada menit ke-30 sampai menit ke-45 untuk rangka 

batang atas jembatan, sedangkan penyebaran temperatur  yang terjadi pada rangka 

batang samping terjadi pada menit ke-35 sampai dengan menit ke-45. Dari data 

pengamatan tersebut, diketahui nilai temperatur terbesar yang terjadi pada rangka 

atas adalah sebesar 244 oC, sedangkan pada rangka samping penyebaran 

temperatur relative sama pada setiap batangnya dengan niali temperatur terbesar 

yaitu berkisar pada 63 oC yang terletak pada gelagar memanjang dari jembatan 

model. Sedangkan untuk keseluruhan pengukuran temperatur mulai menit ke-1 

sampai dengan menit ke-95 dapat dilihat pada lampiran E. 

 

 

Gambar 4.4. Penyebaran Suhu (oC) Pada Rangka Atas  

 

 

Gambar 4.5. Penyebaran Suhu (oC) Pada Rangka Samping  
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4.1.4. Deformasi 

4.1.4.1. Deformasi Percobaan Jembatan Model dan Simulasi Model 

Deformasi yang terjadi pada jembatan model ini, ditinjau besar 

perpindahan terhadap arah z (UZ) dari satu nodal dalam tiap jenis modelisasi 

struktur yang dilakukan. Nodal tersebut terletak pada bagian tengah dari segmen 

yang mengalami kebakaran seperti yang diuraikan pada subbab 4.1.3.2 pada 

gambar 4.4 dan gambar 4.5. 

 

Gambar 4.6. Nodal Peninjauan Deformasi 

 

Data nodal yang akan diamati dari percobaan jembatan model ini 

disamakan dengan penomoran nodal pada model simulasi yaitu  nodal 283, karena 

dianggap mengalami perpindahan terbesar akibat kombinasi beban gravitasi dan 

beban temperatur yang terjadi. Grafik perpindahan pada arah z (gravitasi) dapat 

dilihat pada Gambar 4.7 hingga Gambar 4.9. 

 

 

 

Gambar 4.7. Perpindahan Nodal 283 arah Z (Percobaan Jembatan Model) 
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Pada jembatan percobaan ini telah terjadi deformasi awal akibat berat pelat 

lantai jembatan dan beban truk beserta muatannya dengan nilai penurunan sebesar 

1,52 mm. Pada angka menit ke-60, atau tepatnya pada nilai temperatur sebesar 

244 oC penurunan bertambah menjadi 1,8 mm, dimana ini merupakan temperatur 

terbesar yang terjadi pada rangka batang atas jembatan, dan pada angka menit ke-

95, atau tepatnya nilai temperatur 367 oC pada gelagar memanjang, 

mengakibatkan struktur jembatan model mengalami penurunan yang signifikan 

yaitu sebesar 35,0 mm, yang ditandai dengan terjadinya buckling yang sangat 

besar pada balok utama atas atau elemen nomor 2446 dan 2380 berdasarkan 

penomoran elemen pada model simulasi. Secara visual terlihat bahwa terjadi 

kerusakan struktur seperti yang terlihat pada gambar 4.12. 

Sedangkan pada model simulasi, terlihat prilaku deformasi yang berbeda 

dengan model percobaan, dimana pada saat terjadinya peningkatan nilai 

temperatur tidak diikuti dengan penambahan nilai penurunan, namun terjadi 

sebaliknya yaitu pada angka menit ke-30 penurunan berkurang 9% terhadap 

penurunan awal akibat pengaruh berat sendiri struktur dan beban truk pada nilai 

7,5 mm menjadi 6,8 mm. Berikut ini adalah grafik perpindahan arah z (gravitasi) 

pada nodal 283.  

 

 

Gambar 4.8. Perpindahan Nodal 283 arah Z (Simulasi Jembatan Model) 
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4.1.4.2. Deformasi Pada Jembatan Krasak (Prototype) 

Pada Jembatan Krasak ini, deformasi yang  ditinjau merupakan besar 

perpindahan terhadap arah z (UZ) dari satu nodal dalam tiap jenis modelisasi 

struktur yang dilakukan. Nodal tersebut terletak pada bagian tengah dari segmen 

yang mengalami kebakaran. Data nodal yang akan ditampilkan dari model ini 

adalah pada nodal 283. Pada model ini, simulasi terhenti pada angka menit ke-53, 

atau tepatnya pada suhu berkisar antara 681 °C. Pada menit tersebut  solusi yang 

dihitung melalui simulasi sudah tidak bersifat konvergen. Hal ini dikarenakan 

bentuk struktur dan kondisi material yang sudah tidak memungkinkan untuk 

dianalisa lebih lanjut. Dengan kata lain, struktur Jembatan Krasak  dalam simulasi 

ini sudah mengalami keruntuhan. Grafik perpindahannya dapat dilihat pada 

Gambar 4.9. 

 

Gambar 4.9. Perpindahan Nodal 283 arah Z (Simulasi Jembatan Krasak) 

 

Pada gambar 4.9. diatas terlihat bahwa di menit ke 34,07 terjadi kenaikan 

pada struktur  sebesar 22,6 cm dimana pada saat tersebut nilai temperatur yang 

pada rangka baja yang terbakar yaitu sebesar 511 oC, dan dengan terjadinya 

peningkatan temperatur sejalan dengan berjalannya waktu maka pada menit  ke-

52 Jembatan Krasak mulai mengalami deformasi yang besar  hingga menit ke-53  

atau tepatnya pada nilai temperatur 681,6 oC yang ditandai dengan penurunan 

sebesar 185,3 cm. Pada menit tersebut  solusi yang dihitung melalui simulasi 
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material yang sudah tidak memungkinkan untuk dianalisa lebih lanjut. Dengan 

kata lain, struktur Jembatan Krasak  dalam simulasi ini sudah mengalami 

keruntuhan. Berikut ini gambaran hasil simulasi dari prilaku deformasi terhadap 

lama waktu terjadinya kebakaran : 

Pada menit ke-34 (T = 511 °C, UZ-283 = 22,6 cm) 

 

Gambar 4.10. Kondisi Jembatan Krasak pada Menit ke-34 (Simulasi Jembatan Krasak) 

Pada menit ke-53 (T = 681,60 °C, UZ-283 = 185,3 cm)  
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.032897
.040749

.0486
.056452

NODAL SOLUTION

STEP=2
SUB =212
TIME=34.0698
UZ       (AVG)
RSYS=0
DMX =.088968
SMN =-.014213
SMX =.056452

1

MN

MX X
Y

Z

MODEL_KRASAK                                                                    

-2.91577
-2.5918

-2.26782
-1.94385

-1.61987
-1.2959

-.971925
-.64795

-.323975
0

NODAL SOLUTION

STEP=3
SUB =186
TIME=53.4994
UZ       (AVG)
RSYS=0
DMX =2.9203
SMN =-2.91577
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Gambar 4.11. Kondisi Jembatan Krasak pada Menit ke-53 (Simulasi Jembatan Krasak) 

4.1.5. Hubungan Tegangan Regangan 

Pada model ini akan ditampilkan hubungan tegangan-regangan dari 

elemen elemen yang mewakili setiap jenis batang yang mengalami kebakaran dan 

mengalami transformasi, nomor dari elemen-elemen tersebut, yaitu: 910; 914; 

1376; dan 1358. Sedangkan untuk elemen yang di ukur regangan dengan strain 

gage yaitu 2658. Letak elemen-elemen tersebut dapat dilihat pada gambar 4.12 

berikut ini. 

 

 

 

1376 

914 

910 

1358 

2380 
2446 
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Gambar 4.12. Penomoran Elemen yang di Analisa 

4.1.5.1. Tegangan dan Regangan Simulasi Jembatan Model 

Untuk hasil dari hubungan tegangan-regangan pada elemen-elemen 

tersebut, dapat dilihat pada Gambar 4.13 hingga Gambar 4.18 di bawah ini. 

Pada elemen 910: 

 

Gambar 4.13. Hubungan Tegangan-Regangan Elemen 910 (Simulasi Model) 

Pada elemen 914: 

 

Gambar 4.14. Hubungan Tegangan-Regangan Elemen 914 (Simulasi Model) 

Pada elemen 1376: 

 

Gambar 4.15. Hubungan Tegangan-Regangan Elemen 1376 (Simulasi Model) 
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Pada elemen 1358: 

 

Gambar 4.16. Hubungan Tegangan-Regangan Elemen 1358 (Simulasi Model) 

 

Pada elemen 2380: 

 

Gambar 4.17. Hubungan Tegangan-Regangan Elemen 2380 (Simulasi Model) 

 

Pada elemen 2446: 

 

Gambar 4.18. Hubungan Tegangan-Regangan Elemen 2446 (Simulasi Model) 
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jembatan model ini akan ditampilkan hubungan tegangan-regangan dari elemen 

elemen yang mewakili setiap jenis batang yang mengalami kebakaran, 

 

Gambar 4.19. Lokasi Penempatan Strain Gage 

 

Pada elemen 2568: 

 

Gambar 4.20. Regangan Pada Elemen 2568 (Percobaan Model) 

 

 

Gambar 4.21. Regangan Elemen 2568 (Simulasi Model) 

 

 

 

-0.035

-0.03

-0.025

-0.02

-0.015

-0.01

-0.005

0

0.005

0 10 20 30 40 50 60 70 80 90 100

R
eg

a
n

g
a

n
(%

)

Waktu (menit)

CL 
Strain gage 

Kajian keruntuhan..., Rifky Netriady, FTUI, 2012



BAB IV. HASIL SIMULASI DAN ANALISA  77 

RIFKY NETRIADY  07 06 172 582 

Universitas Indonesia 

4.1.5.2. Tegangan dan Regangan Jembatan Krasak (Prototype) 

Pada prototipe ini akan ditampilkan hubungan tegangan-regangan dari 

elemen elemen yang mewakili setiap jenis batang yang mengalami kebakaran, 

nomor dari elemen-elemen tersebut serupa dengan jembatan model. 

Pada elemen 910: 

    

Gambar 4.22. Hubungan Tegangan-Regangan Elemen 910 (Simulasi Jembatan Krasak) 

Pada elemen 914: 

   

Gambar 4.23. Hubungan Tegangan-Regangan Elemen 914 (Simulasi Jembatan Krasak) 

Pada elemen 1376: 

   

Gambar 4.24. Hubungan Tegangan-Regangan Elemen 1376 (Simulasi Jembatan Krasak) 
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Pada elemen 1358: 

   

Gambar 4.25. Hubungan Tegangan-Regangan Elemen 1358 (Simulasi Jembatan Krasak) 

Pada elemen 2380: 

   

Gambar 4.26. Hubungan Tegangan-Elemen 2380 (Simulasi Jembatan Krasak) 

Pada elemen 2446: 

    

Gambar 4.27. Hubungan Tegangan-Elemen 2446 (Simulasi Jembatan Krasak) 
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4.2. HASIL ANALISA SIMULASI 

4.2.1. Analisa Deformasi 

Dalam analisa hasil simulasi ini yang akan dijelaskan yaitu perbandingan 

hasil percobaan model dengan simulasi model serta menjelaskan, dimana dalam 

subbab ini pembahasan akan difokuskan pada nilai dan prilaku deformasi dari 

hasil simulasi. Perbandingan deformasi struktur yang terjadi terhadap kedua 

model (model percobaan dan model simulasi). 

4.2.1.1. Deformasi Jembatan Model 

Dalam analisa hasil percobaan Jembatan Model ini, terjadinya keruntuhan 

disebabkan oleh penurunan kekuatan pada batang utama dari balok gelegar 

memanjang struktur atas yang ditandai dengan terjadinya local bucling, sehingga 

mengakibatkan penurunan secara mendadak sebesar 191 % dari kondisi 

sebelumnya atau pada angka menit ke-90. Lokal bucling tersebut diakibatkan nilai 

temperatur yang sangat tinggi yaitu sebesar 367 oC.   

 

 

Gambar 4.28. Deformasi Jembatan Model dan Model Simulasi 

 

Grafik perbandingan deformasi diatas, merupakan nilai deformasi vertikal 

pada arah sumbu z dari struktur jembatan model dan struktur model simulasi. 

Pada grafik terlihat bahwa pola deformasi pada interval waktu awal sampai 
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dengan menit ke-95, baik jembatan model dan model simulasi memiliki pola 

deformasi yang tidak sama terhadap peningkatan temperatur.   

Perbedaan prilaku deformasi yang terjadi pada model percobaan dan model 

simulasi dikarenakan : 

a. Ketidaksamaan mekanisme sambungan pada struktur rangka dimana pada 

model simulasi mekanisme sambungan berupa pin-joint, sedangkan pada 

model percobaan menggunakan sambungan satu paku ripet dan setelah 

diamati mekanismenya menyerupai semi-jepit (tidak dapat translasi dan 

rotasi tertahan sebahagian). 

b. Ketidaksamaan propertis material struktur rangka disebabkan keterbatasan 

masalah dengan tidak dilakukan uji material terhadap material yang 

digunakan pada model percobaan, sehingga parameter material yang di 

gunakan dalam melakukan simulasi mengacu pada beberapa literatur. 

c. Ketidaksamaan dalam hal pembebanan thermal (api) yang terjadi akibat 

kebakaran dimana keterbatasan alat dalam melakukan pengukuran 

temperatur pada rangka jembatan model percobaan dalam waktu 

bersamaan, sehingga yang dapat dilakukan yaitu melakukan pengukuran 

terhadap pertambahan waktu. 

Tabel 4.2. Deformasi dari Model Percobaan dan Simulasi  

 

Apabila Gambar 4.28 tersebut ditabulasikan seperti terlihat pada Tabel 4.2, 

maka akan terlihat jelas bahwa deformasi penurunan pada model percobaan terus 

bertambah bersamaan dengan meningkatnya nilai temperatur, namun prilaku 

deformasi pada simulasi model terlihat bahwa dengan meningkatnya nilai 

temperatur maka struktur akan berdeformasi berlawanan terhadap gaya gravitasi, 

sehingga sampai menit ke-95 struktur jembatan model simulasi belum mengalami 

keruntuhan atau analisa masih konvergen.  

Suhu Maksimum 

(
o

C)

Waktu 

(menit)

Percobaan 

(mm)

Simulasi 

(mm)

Modulus Elastisitas 

(kg/m
2

)

30 1 -7.2404 -7.2404 1.642E+09

161 30 -7.1604 -7.0166 1.487E+09

244 60 -7.5204 -6.7127 9.909E+08

244 90 -7.4604 -6.8174 9.909E+08

367 95 -40.7204 -6.6375 4.281E+08
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Prilaku deformasi yang terjadi pada sekitar menit ke-95, atau kira-kira 

pada suhu 367 °C, tercatat kenaikan mencapai nilai 40,7 mm (model percobaan); 

6,63 mm (model simulasi). Apabila dibandingkan dengan deformasi awal struktur 

yang terjadi pada suhu 30 °C, maka total perpindahan yang terjadi mencapai 33,48 

mm untuk model percobaan, dan 0,6 mm untuk model simulasi.  

Pada suhu 367 °C tersebut, besar modulus elastisitas aluminium (Ea) 

adalah ± 4,281x108 kg/m2. Nilai tersebut setara dengan 26,08% dari nilai modulus 

elastisitas awal. Turunnya nilai modulus elastisitas ini akan mengakibatkan 

turunnya tegangan  kritis tekuk dari batang profil baja yang mengalami kenaikan 

suhu. Dilihat dari prosentase penurunan modulus elastisitas, maka nilai tegangan 

tekuk kritis pun akan turun sebesar 74,10% untuk model simulasi.  

4.2.1.2. Deformasi Jembatan Krasak (Prototype) 

Deformasi yang di tinjau adalah searah dengan gravitasi atau sumbu z 

pada simulasi. Dalam  grafik terlihat bahwa deformasi yang terjadi pada struktur 

rangka jembatan tidak langsung mengalami penurunan, namun terjadi kenaikan 

(arah z positif) sebelum mengalami penurunan. Hal ini dapat dipastikan dari garis 

pada grafik yang naik mendekati nilai nol.  

 

Gambar 4.29. Perpindahan Nodal 283 arah Z (Simulasi Jembatan Krasak) 

Apabila Gambar 4.29 tersebut ditabulasikan seperti terlihat pada Tabel 4.3, 

maka akan terlihat jelas bahwa kenaikan tersebut terjadi sampai pada sekitar menit 

ke-26, atau kira-kira pada suhu 400 °C. Pada waktu tersebut, tercatat kenaikan 

yang terjadi mencapai nilai 0,048 m. Apabila dibandingkan dengan deformasi 

awal struktur yang terjadi pada suhu 30 °C, maka total perpindahan yang terjadi 
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mencapai 0,157 m. Hal ini dapat dikatakan cukup besar, mengingat nilai tersebut 

setara dengan 0,15 % bentang keseluruhan struktur jembatan (104  m).  

Kecepatan dari kenaikan struktur tersebut mencapai nilai 0,006158 m/menit atau 

0,00042 m/°C. Pada suhu 400 °C ini modulus elastisitas baja bernilai sekitar 

±140000  MPa. Nilai modulus elastisitas tersebut setara dengan 70% dari modulus 

elastisitas awal baja.  

Tabel 4.3. Deformasi Jembatan Krasak (Simulasi Jembatan Krasak) 

 

Pada Gambar 4.29, dapat terlihat bahwa penurunan struktur secara cepat 

mulai terjadi pada sekitar menit ke-43, atau ±600 °C. Pada suhu tersebut, besar 

modulus elastisitas baja (Es) adalah ±62000 MPa. Nilai tersebut setara dengan 

31% dari nilai modulus elastisitas awal. Turunnya nilai modulus elastisitas ini 

akan mengakibatkan turunnya tegangan  kritis tekuk dari batang profil baja yang 

mengalami kenaikan suhu.  

Waktu yang dibutuhkan oleh model simulasi untuk mencapai deformasi 

maksimumnya yaitu sebesar 17 menit. Sehingga dapat disimpulkan bahwa waktu 

keruntuhan yang terjadi telang mendekati nilai yang disebutkan oleh saksi mata. 

Sehingga simulasi model 3D dengan memperhitungkan bentuk sebenarnya dari 

elemen diagonal rangka utama dan pengaku atas jembatan telah dapat 

merepresentasikan kondisi asli dari keruntuhan struktur  Jembatan Krasak. 

 

 

 

 

Temperatur (
o
C)

Waktu 

(menit)

Modulus 

Elastisitas 
(Mpa)

Deformasi 
(m)

30 1 200000 -0.206

100 9.32 200000 -0.194

200 14.67 180000 -0.118

300 19.58 160000 -0.161

400 25.51 140000 -0.014

500 32.90 120000 -0.090

600 42.66 62000 -0.067

650 48.03 44000 -0.838

700 55.97 22000 -6.417
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4.2.2. Analisa Tegangan dan Regangan 

Tegangan yang terjadi pada elemen pengaku rangka atas akibat dari 

temperatur maksimum yang terjadi sebagai penyebab terjadinya mekanisme local 

buckling akan dibandingkan dengan perhitungan tegangan tekuk pada setiap jenis 

penampang seperti yang ada pada tabel 4.4 berikut ini :  

Tabel 4.4. Tegangan Kritis Elemen Rangka Atas Hasil Simulasi Model Percobaan 

 

 

Tabel 4.5. Tegangan Kritis Elemen Rangka Atas Hasil Simulasi Jembatan Krasak 

 

Dari Tabel 4.4 dan Tabel 4.5, dapat dilihat bahwa tegangan hasil simulasi 

pada rangka pengaku atas yaitu elemen 910, 914, 1376 dan 1385  jauh lebih kecil 

dibandingkan dengan tegangan tekuk hasil perhitungan dengan selisih nilai rata-

rata 350 % (simulasi model percobaan) dan 430 % (simulasi jembatan krasak), 

sedangkan tegangan hasil simulasi balok utama yaitu elemen 2380 dan 2446 lebih 

kecil 10 % (simulasi model percobaan) dan lebih besar 80 % (simulasi jembatan 

krasak) dibandingkan dengan tegangan tekuk batang. 

Sedangkan elemen 910, 1358, 1376, 2380 dan 2446 yang diamati 

terjadinya local bucling tidak memberikan hasil yang sama dengan hasil simulasi 

model percobaan atau lebih tepatnya dalam simulasi model elemen rangka yang 

diamati belum terjadi bucling, namun elemen 2380 dan 2446 pada simulasi 

Temperatur E KL/r σ Tekuk σ Simulasi

(
o
C) (Mpa) (Mpa) (Mpa)

910 L10x0.6 217 10929.49 29.412 124.571 21.598

914 L10x0.6 200 12003.61 29.412 136.814 20.996

1376 2L 13.5x0.7 244 9717.95 26.738 134.022 4.816

1358 2L 13.5x0.7 244 9717.95 26.738 134.022 4.389

2380 4L 13.5x0.7 367 4198.72 61.920 10.797 6.805

2446 4L 13.5x0.7 367 4198.72 61.920 10.797 0.070

No. 
Elemen

Profil

Temperatur E KL/r σ Tekuk σ Simulasi

(oC) (Mpa) (Mpa) (Mpa)

910 L150x15 681 32840.00 32.468 307.159 5.076

914 L150x15 681 32840.00 32.468 307.159 103.391

1376 2L 200x20 681 32840.00 25.974 479.937 12.267

1358 2L 200x20 681 32840.00 25.974 479.937 12.892

2380 4L 200x20 681 32840.00 61.824 84.713 150.880

2446 4L 200x20 681 32840.00 61.824 84.713 150.877

No. 
Elemen

Profil
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jembatan krasak memberikan hasil yang mendekati dokumentasi kejadian. Prilaku 

tegangan yang terjadi pada setiap elemen tidak memiliki kesamaan, yang 

disebabkan oleh perbedaan mekanisme sambungan, beban thermal dan properties 

material antara model percobaan dengan model simulasi.   

Efek selanjutnya yang terjadi akibat tegangan pada elemen adalah 

regangan struktur. Efek regangan yang terjadi pada setiap model akan 

dibandingkan dan dianalisa. Perbandingan regangan elemen tersebut dapat dilihat 

pada Tabel 4.5 dan Tabel 4.6. 

Tabel 4.5. Regangan Hasil Simulasi Jembatan Model 

Waktu 
Regangan Jembatan Model 

Elemen No. 

(menit) 910 914 1376 1358 

1 -2E-05 -3,6E-05 9,58E-06 8,67E-06 

30 -0,00032 -0,00029 4,57E-05 9,31E-05 

60 -0,00107 -0,00098 0,000426 0,000413 

90 -0,00014 -0,00023 7,64E-06 7,88E-05 

95 0,000203 0,000223 -0,0001 -4,9E-06 

 

Tabel 4.6. Regangan Hasil Simulasi Jembatan Krasak 

Waktu 
Regangan Jembatan Prototype  

Elemen No. 

(menit) 910 914 1376 1358 

1 -0,00014 -0,00023 4,71E-05 3,79E-05 

160 -0,00049 -0,00047 9,35E-05 0,000143 

320 -0,00126 -0,00119 0,000464 0,000448 

480 -0,0003 -0,00042 6,52E-05 0,000126 

506 -0,00011 -0,0002 1,11E-05 0,000109 

Pada Tabel 4.5 dan 4.6 tersebut dapat dilihat bahwa regangan yang terjadi 

akan naik hingga mencapai rata-rata 43 kali lipat pada menit ke-60 (jembatan 

model) dan 9 kali lipat pada menit ke-320 (jembatan prototype). Dan regangan 

yang akan kembali turun hingga mencapai rata-rata 24 kali lipat pada menit ke-60 

(jembatan model) dan 15 kali lipat pada menit ke-320 (jembatan prototype). 
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4.2.3. Analisa Keruntuhan Jembatan Krasak 

Pada Model Simulasi Jembatan Krasak, dapat terlihat dengan jelas bahwa 

keruntuhan yang terjadi diawali dengan kegagalan balok utama struktur atas 

jembatan dalam menahan besaran gaya yang terjadi, baik akibat beban gravitasi, 

ataupun akibat beban termal. Beban termal tersebut akan menyebabkan 

bertambahnya tegangan akibat efek perpanjangan elemen yang terkekang, 

sehingga tegangan akan meningkat dengan drastis seperti yang sudah dianalisa 

pada pembahasan sebelumnya. Bertambahnya tegangan pada profil tersebut 

disertai dengan berkurangnya kekuatan akan mempercepat proses keruntuhan. 

Efek tekuk yang mulai terjadi pada  batang tersebut mengakibatkan 

kemampuannya dalam menahan beban semakin menurun, hal ini mengakibatkan 

berpindahnya beban yang seharusnya ditahan oleh profil tersebut kepada batang-

batang profil di sekitarnya. Karena batang profil di sekitarnya juga mengalami hal 

yang sama, maka keseluruhan profil yang mengalami kenaikan temperatur 

seakan-akan menghilang, mengakibatkan fungsi utama batang-batang profil lain 

dalam membentuk satu kesatuan struktur jembatan rangka baja menghilang. 

Hal lain yang terlihat dalam proses  keruntuhan adalah efek rotasi yang 

terjadi pada batang profil diagonal yang mengalami kenaikan suhu. Hal ini 

diperkirakan terjadi akibat kombinasi antara efek tekuk dengan pengekangan  

pertambahan panjang dari batang profil tersebut. Selanjutnya, apabila melihat 

kondisi akhir sebenarnya dari Jembatan Krasak pada Gambar 4.43 berikut ini: 

 

Gambar 4.30. Kondisi Jembatan Krasak Sebenarnya Pasca Kebakaran 
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Apabila kondisi sebenarnya tersebut  dibandingkan dengan simulasi model 

jembatan krasak, seperti terlihat pada Gambar 4.31 berikut ini: 

 

 

Gambar 4.31. Kondisi Jembatan Krasak Hasil Simulasi 

 

Secara keseluruhan, dapat disimpulkan bahwa perilaku struktur yang terjadi pada 

hasil simulasi Jembatan Krasak mendekati keadaan sebenarnya, baik nilai ataupun 

pola keruntuhannya, sampai pada keadaan sebelum runtuh, lebih tepatnya sampai 

sekitar menit ke-43, atau ±600 °C.  
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BAB 5 

KESIMPULAN DAN SARAN 

 

5.1. KESIMPULAN 

Sesuai  dengan pembahasan yang ada pada Bab 4, hasil akhir simulasi 

model percobaan yang dilakukan pada tulisan ini tidak menyerupai kondisi pada 

model percobaan. Dimana pola deformasi dan hubungan tegangan regangan yang 

dihasilkan dari percobaan dan analisa tidak menyerupai kondisi sebenarnya. 

Namun hasil simulasi jembatan krasak dan model percobaan memiliki kemiripan 

dalam hal deformasi dengan kondisi atau kejadian sebenarnya, dimana pola 

keruntuhan yang diakibatkan local bucling pada balok utama struktur atas 

jembatan mengakibatkan terjadinya penurunan secara drastis pada struktur 

jembatan.  

Dalam percobaan dan simulasi ini, dapat disimpulkan beberapa hal seperti 

berikut:  

1. Kenaikan suhu pada struktur Jembatan Krasak tidak langsung 

mengakibatkan penurunan struktur jembatan secara keseluruhan. Hal ini 

dapat dilihat pada suhu 400 °C dimana pada bagian tengah bentang 

jembatan mengalami kenaikan maksimumnya, yaitu sebesar 0,157 m atau 

setara dengan 0,15 % terhadap bentang keseluruhan struktur jembatan (104  

m) 

2. Kecepatan dari kenaikan struktur tersebut mencapai nilai 0,006158 

m/menit atau 0,00042 m/°C.  

3. Kegagalan struktur, dimana mulai terjadi titik balik dari proses kenaikan 

menjadi penurunan, yang terjadi pada suhu 600 °C memiliki nilai modulus 

elastisitas sebesar ±62000 MPa.  

4. Sedangkan pada deformasi maksimum, nilai modulus elastisitas dari 

simulasi model jembatan krasak adalah 22000 MPa (11% Es awal).  

5. Waktu yang dibutuhkan oleh simulasi model jembatan krasak untuk 

mencapai deformasi maksimumnya yaitu sebesar 17 menit. 
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6. Kegagalan batang profil baja karena efek tekuk terjadi karena kenaikan 

tegangan sebesar 1,8 kali lipat, sedangkan modulus elastisitas turun hingga 

89%. 

7. Penyebab utama keruntuhan Jembatan Krasak adalah efek domino antara 

kenaikan suhu yang  menyebabkan pengurangan kekuatan material 

(modulus elastisitas), yang kemudian menyebabkan terjadinya perilaku 

tekuk pada balok utama struktur atas disusul dengan tekuk pada batang 

pengaku transversal. Dengan terjadinya tekuk ini mengakibatkan 

pengurangan tahanan gaya dari batang tersebut sampai mendekati nilai nol. 

Pengurangan kemampuan untuk menahan beban ini mengakibatkan beban 

tersebut dipindahkan ke batang di sebelahnya. Pemindahan beban ini 

disertai berkurangnya kekuatan material akan mengakibatkan terjadinya 

perilaku tekuk berikutnya.  

8. Perbedaan hasil antara model percobaan dengan simulasi model percobaan 

disebabkan banyak faktor yaitu ketidaksamaan mekasisme sambungan, 

beban termal akibat pengaruh angin dan perbedaan propertis material 

model percobaan dan dengan simulasi model percobaan. 

9. Diperoleh hasil bahwa prilaku keruntuhan model percobaan menyerupai   

kondisi sebenarnya. Sehingga model percobaan dengan pendekatan 

menggunakan teori keserupaan (similitude theory) sudah dapat 

memberikan gambaran secara fisik penyebab terjadinya keruntuhan pada 

Jembatan Krasak. 

Jembatan model direncanakan berdasarkan ketentuan teori keserupaan 

(similitude theory), namun dalam hal mekanisme sambungan, jembatan model 

hanya menggunakan paku rivet. Diameter baut dan jumlahnya tidak dapat 

menggunakan skala geometri karena keterbatasan ukuran yang tersedia di pasaran. 

Sehingga mekanisme sambungan antara struktur jembatan model dengan 

Jembatan Krasak merupakan salah satu penyebab ketidaksesuaian hasil.  

Hal lain yang sangat mempengaruhi percobaan yang lakukan terhadap 

model jembatan berskala 1:17 yaitu kondisi iklim dan frekuensi angin yang 

terjadi. Karena tingginya temperatur dan lidah api yang dihasilkan dari proses 
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pembakaran, sangat ditentukan oleh frekuensi angin yang masuk kedalam ruang 

bakar yang dalam hal ini yaitu tangki bahan bakar. 

 

5.2. SARAN 

Dalam tulisan ini, masih terdapat beberapa kekurangan yang dapat 

dilengkapi demi melakukan simulasi keruntuhan Jembatan Krasak akibat 

kebakaran dengan keadaan yang lebih menyerupai aslinya. Beberapa hal yang 

dapat dilakukan untuk melanjutkan penelitian ini adalah sebagai berikut: 

1. Memperbaiki mekanisme sambungan pada jembatan model dengan 

mengikuti teori keserupaan. 

2. Melakukan pengukuran temperatur pada setiap batang dalam waktu yang 

bersamaan. 

3. Membuat pendekatan pengaruh turbulensi angin terhadap kompartemen 

atau tangki bahan bakar. 
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LAMPIRAN A 

ELEMEN DAN DIMENSI SATUAN DALAM 

PROGRAM ANSYS V11.0 

 

A.1. ELEMEN  

A.1.1. BEAM188 

BEAM188 is suitable for analyzing slender to moderately stubby/thick 

beam structures. The element is based on Timoshenko beam theory which 

includes shear-deformation effects. The element provides options for unrestrained 

warping and restrained warping of cross-sections. The element is a linear, 

quadratic, or cubic two-node beam element in 3-D.  

BEAM188 has six or seven degrees of freedom at each node. These 

include translations in the x, y, and z directions and rotations about the x, y, and z 

directions. A seventh degree of freedom (warping magnitude) is optional. This 

element is well-suited for linear, large rotation, and/or large strain nonlinear 

applications.  

A.1.2. BEAM188 Input Summary  

Nodes  

I, J, K (K, the orientation node, is optional but recommended)  

Degrees of Freedom  

UX, UY, UZ, ROTX, ROTY, ROTZ if KEYOPT(1) = 0  

UX, UY, UZ, ROTX, ROTY, ROTZ, WARP if KEYOPT(1) = 1 

Section Controls  

TXZ, TXY, ADDMAS  

(TXZ and TXY default to A*GXZ and A*GXY, respectively, where A = 

cross-sectional area)  

Material Properties  

EX, (PRXY,or NUXY), GXY, GXZ  
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ALPX, (or CTEX, or THSX)  

DENS, DAMP  

Surface Loads  

Pressure  

face 1 (I-J) (-z normal direction)  

face 2 (I-J) (-y normal direction)  

face 3 (I-J) (+x tangential direction)  

face 4 (I) (+x axial direction)  

face 5 (J) (-x axial direction)  

I and J denote the end nodes.  

Use a negative value for loading in the opposite direction.  

For faces 1, 2, and 3, offsets apply only if you are using the cubic option 

(KEYOPT(3) = 3).  

Body Loads  

Temperatures --  T(0,0), T(1,0), T(0,1) at each end node  

Special Features  

Plasticity (PLASTIC, BISO, MISO, NLISO, BKIN, MKIN, KINH, 

CHABOCHE, HILL) 

Viscoelasticity (PRONY, SHIFT)  

Viscoplasticity/Creep (CREEP, RATE)  

Other material (USER)  

Stress stiffening  

Large deflection  

Large strain  

Initial state  

Nonlinear stabilization  

Birth and death (requires KEYOPT(11) = 1)  

Automatic selection of element technology  

Generalized cross-section (nonlinear elastic, elasto-plastic, temperature-
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dependent)  

KEYOPT(1)  

Warping degree of freedom:  

0 --  Six degrees of freedom per node, unrestrained warping (default)  

1 --  Seven degrees of freedom per node (including warping). Bimoment 

and bicurvature are output.  

KEYOPT(2)  

Cross-section scaling, applies only if NLGEOM,ON has been invoked:  

0 --  Cross-section is scaled as a function of axial stretch (default)  

1 --  Section is assumed to be rigid (classical beam theory)  

KEYOPT(3)  

Shape functions along the length:  

0 --  Linear (default)  

2 --  Quadratic  

3 --  Cubic  

KEYOPT(4)  

Shear stress output:  

0 --  Output only torsion-related shear stresses (default)  

1 --  Output only flexure-related transverse-shear stresses  

2 --  Output a combined state of the previous two types  

KEYOPT(6), KEYOPT(7), and KEYOPT(9)  

active only when OUTPR,ESOL is active:  

KEYOPT(6)  

Output control for section forces/moments and strains/curvatures:  

0 --  Output section forces/moments and strains/curvatures at integration 

points along the length (default)  

1 --  Same as KEYOPT(6) = 0 plus current section area  

2 --  Same as KEYOPT(6) = 1 plus element basis directions (X,Y,Z)  

3 --  Output section forces/moments and strains/curvatures extrapolated to 

the element nodes  

KEYOPT(7)  
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Output control at integration points (not available when section subtype = 

ASEC):  

0 --  None (default)  

1 --  Maximum and minimum stresses/strains  

2 --  Same as KEYOPT(7) = 1 plus stresses and strains at each section 

point  

KEYOPT(9)  

Output control for values extrapolated to the element and section nodes 

(not available when section subtype = ASEC):  

0 --  None (default)  

1 --  Maximum and minimum stresses/strains  

2 --  Same as KEYOPT(9) = 1 plus stresses and strains along the exterior 

boundary of the cross-section  

3 --  Same as KEYOPT(9) = 1 plus stresses and strains at all section nodes  

KEYOPT(11)  

Set section properties:  

0 --  Automatically determine if preintegrated section properties can be 

used (default)  

1 --  Use numerical integration of section  

KEYOPT(12)  

Tapered section treatment:  

0 --  Linear tapered section analysis; cross-section properties are evaluated 

at each Gauss point (default). This is more accurate, but computationally 

intensive.  

1 --  Average cross-section analysis; for elements with tapered sections, 

cross-section properties are evaluated at the centroid only. This is an 

approximation of the order of the mesh size; however, it is faster.  

KEYOPT(15)  

Results file format:  

0 --  Store averaged results at each section corner node (default).  
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1 --  Store non-averaged results at each section integration point. (The 

volume of data may be excessive. This option is typically useful for built-

up sections with multiple materials only.)  

A.1.3. BEAM188 Output Data  

It is customary in beam design to employ components of axial stress that 

contribute to axial loads and bending in each direction separately; therefore, 

BEAM188 provides a linearized stress output as part of its SMISC output record, 

as indicated in the following definitions:  

SDIR is the stress component due to axial load.  

SDIR = Fx/A, where Fx is the axial load (SMISC quantities 1 and 14) and A is the 

area of the cross-section.  

SByT and SByB are bending-stress components.  

SByT = -Mz * ymax / Izz 

SByB = -Mz * ymin / Izz 

SBzT = Mz * zmax / Iyy  

SBzB = Mz * zmin / Iyy  

where My, Mz are bending moments in the beam coordinate system (SMISC 

quantities 2,15,3,16). Coordinates ymax, ymin, zmax, and zmin are the maximum and 

minimum y, z coordinates in the cross-section measured from the centroid. Values 

Iyy and Izz are moments of inertia of the cross-section. Except for the ASEC type 

of beam cross-section, the program uses the maximum and minimum cross-

section dimensions. For the ASEC type of cross-section, the maximum and 

minimum in each of y and y direction is assumed to be +0.5 to -0.5, respectively.  

Corresponding definitions for the component strains are:  

EPELDIR = Ex  

EPELByT = -Kz * ymax 

EPELByB = -Kz * ymin 

EPELBzT = Kz * zmax  

EPELBzB = Kz * zmin  

Kajian keruntuhan..., Rifky Netriady, FTUI, 2012



99 
 

where Ex, Ky, and Kz are generalized strains and curvatures (SMISC quantities 

7,8,9, 20,21 and 22).  

The reported stresses are strictly valid only for elastic behavior of 

members. BEAM188 always employs combined stresses in order to support 

nonlinear material behavior. When the elements are associated with nonlinear 

materials, the component stresses can at best be regarded as linearized 

approximations and should be interpreted with caution.  

When using KEYOPT(7) with the cubic option (KEYOPT(3) = 3), the integration 

point at the middle of the element is reported last in the integration-point printout.  

A.2. DIMENSI SATUAN 
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LAMPIRAN B 

LANGKAH-LANGKAH SIMULASI DENGAN 

PROGRAM ANSYS V11.0 

 

Dalam lampiran ini akan dibahas langkah-langkah yang dilakukan dalam 

menggunakan program ANSYS untuk keperluan simulasi pada tulisan ini. 

Langkah-langkah ini diusahakan akan dibuat sedetail mungkin, mulai dari 

mempersiapkan gambar struktur, memasukkan beban, serta membaca hasil 

keluaran dari program ANSYS tersebut. Uraian dari langkah-langkah tersebut, 

yaitu: 

 

B.1. Fase PREPROCESSING: Memasukkan Data Struktur 

1. Mengganti direktori folder penyimpanan data input dan output. 

Utility Menu > File > Change Directory ... 

2. Memberikan nama file yang akan disimpan. 

Utility Menu > File > Change Jobname ... 

3. Memberikan judul pekerjaan. 

Utility Menu > File > Change Title ... 

4. Mengubah tipe analisa menjadi struktural dan termal. 

Main Menu > Preferences > Beri tanda  pada 

structural dan thermal > OK 

5. Memasukkan tipe elemen. Karena dalam tulisan ini hanya digunakan 

elemen balok secara 3 dimensi, maka dipilih elemen BEAM188 (balok). 

Preprocessor > Element Type > Add/Edit/Delete > Add > Structural Mass > Beam > 2 

node 188 > OK > CLOSE 

6. Memasukkan data geometri dari tiap profil baja yang digunakan. 

Preprocessor > Sections > Beam > Common Sections > Masukkan data ukuran profil (m) 

> OK  

7. Mengganti unit temperatur. 

Preprocessor > Material Props > Temperature Units > Celcius > OK 

8. Memasukkan data massa jenis material. 

Preprocessor > Material Props > Material Models > Structural > Density > Masukkan 

nilai massa jenis material (DENSITY - kg/m3
) > OK 
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9. Memasukkan data modulus elastisitas dan poisson’s ratio. 

Preprocessor > Material Props > Material Models > Structural > Linear > Elastic > 

Isotropic > Masukkan nilai modulus elastisitas (EX - kg/m2
) dan poisson’s ratio (PRXY) 

> OK 

 

10. Memasukkan data koefisien perpanjangan termal material. 

1

7400

7500

7600

7700

7800

7900

8000

8100

8200

8300

8400

DENS

-1000

-800

-600

-400

-200

0

200

400

600

800

1000

TEMP

(x10**1)        

DENS  FOR MATERIAL     1

MODEL_KRASAK                                                                    

MATERIALS

DENS

1

0

250

500

750

1000

1250

1500

1750

2000

2250

2500

(x10**7)        

EX

0

125

250

375

500

625

750

875

1000

1125

1250

TEMP

EX    FOR MATERIAL     1

MODEL_KRASAK                                                                    

MATERIALS

EX
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Preprocessor > Material Props > Material Models > Structural > Thermal Expansion > 

Secant Coefficient > Isotropic > Masukkan nilai koefisien perpanjangan termal (ALPX - 

°C-1
) > OK 

 

11. Memasukkan data hubungan tegangan-regangan (stress-strain) nonlinear 

material. 

Preprocessor > Material Props > Material Models > Structural > Nonlinear > Inelastic > 

Rate Independent > Isotropic Hardening Plasticity > Mises Plasticity > Multilinear > 

Masukkan nilai hubungan Tegangan (STRESS – kg/m2
) dan Regangan (STRAIN) > OK 

(gunakan TAB “Add Temperature” untuk memasukkan nilai hubungan 

tegangan dan regangan pada keadaan suhu tertentu serta “Add Point” 

untuk menambah titik input hubungan tegangan dan regangan) 
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12. Memasukkan data konduktifitas termal material. 

Preprocessor > Material Props > Material Models > Thermal > Conductivity > Isotropic > 

Masukkan nilai konduktifitas termal (KXX - Watt/m-C) > OK 

(gunakan TAB “Add Temperature” untuk memasukkan nilai konduktifitas 

termal pada keadaan suhu tertentu). 
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13. Memasukkan data kapasitas panas material. 

Preprocessor > Material Props > Material Models > Thermal > Specific Heat > Masukkan 

nilai kapasitas panas (C - J/kg-C) > OK 

 

14. Memasukkan data koordinat nodal (nantinya digunakan untuk 

mendefinisikan letak elemen, dimana sebuah elemen BEAM188 akan 

menghubungkan 2 nodal). 

Preprocessor > Modeling > Create > Nodes > In Active CS > Masukkan nomor nodal 

serta koordinatnya (X,Y,Z - m) > Apply > Ulangi masukkan nomor nodal serta 

koordinatnya sampai semua nodal terdata > OK 

15. Memasukkan data elemen. 

Langkah 1. Setiap akan memasukkan data nomor elemen dan dua nodal 

yang dihubungkannya, harus ditentukan data-data seperti Element Type, Real 

Constant dan Material Number dari elemen tersebut. Cara menentukanya 

dengan melakukan hal berikut: 

Preprocessor > Modeling > Create > Elements > Elem Attributes > Tentukan nomor urut 

Tipe Elemen, Real Constant, dan Material Number dari elemen tersebut > OK 

Langkah 2. Selanjutnya adalah menentukan nomor elemen dan data dua 

nodal yang dihubungkannya. Hal tersebut dilakukan dengan cara seperti 

berikut: 
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Preprocessor > Modeling > Create > Elements > User Numbered > Thru Nodes > 

Masukkan nomor elemen > OK > Masukkan dua nomor nodal yang dihubungkan (Nodal-

1,Nodal-2) > OK 

(Setiap akan memulai memasukkan elemen dengan bentuk profil, jenis 

material, ataupun tipe elemen yang berbeda, maka harus mengulang dari 

langkah 1) 

 

 

B.2. Fase SOLUTION: Memasukkan Data Beban dan 

Menjalankan Perhitungan pada Program ANSYS 

1. Menentukan tipe analisa struktur yang dilakukan. 

Solution > Analysis Type > New Analysis > Transient > OK > Full > OK 

2. Mempersiapkan kondisi kontrol solusi (solution controls) pembebanan dan 

perletakan loadstep 1. 

Solution > Analysis Type > Sol’n Controls > Pada layar yang muncul, isi dengan: 

PADA TAB BASIC 

a. Analysis Options > Large Displacement Transient 

b. Time Control 

Time At End of Loadstep > 1 

Automatic Time Stepping > On 

Number of Substeps > 15 

Max No. Of Substeps > 25 

Min No. Of Substeps > 10 

c. Write Items to Results File 

Frequency > Write every Nth Substep 

Where N= > 1 

PADA TAB TRANSIENT 

Full Transient Options > Ramped Loading 

PADA TAB NONLINEAR 

a. Line Search > On 

b. Maximum Number of Iterations > 25 

PADA TAB ADVANCED NL 

Program Behavior upon Nonconvergence > Terminate but Do Not Exit > OK 

3. Menentukan Perletakan. 

Solution > Define Loads > Apply > Structural > Displacement > On Nodes > Masukkan 

Nomor-nomor nodal yang menjadi perletakan (Nodal-1,Nodal-2,Nodal-n) > OK > DOFs 

to be Constrained (UX,UY,UZ) > Displacement Value > 0 (Nol) > OK 
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4. Memasukkan beban gravitasi (berat sendiri). 

Solution > Define Loads > Apply > Structural > Inertia > Gravity > Pada Global 

Cartesian Z-comp > 1 > OK 

5. Memasukkan beban nodal (Perkerasan beton atau Beban Truk). 

Solution > Define Loads > Apply > Structural > Force/Moment > On Nodes > Masukkan 

Nomor-nomor nodal yang mengalami beban nodal tambahan (Nodal-1,Nodal-2,Nodal-n) 

> OK > Masukkan nilai beban nodal (kg) > OK 

6. Memasukkan beban suhu awal (20 °C) loadstep 1. 

Suhu merata (Uniform Temperature). 

Solution > Define Loads > Settings > Uniform Temp > 20 > OK 

Suhu referensi peregangan elemen (Reference Temperature). 

Solution > Define Loads > Settings > Reference Temp > 20 > OK 

7. Menulis data-data kondisi pembebanan dan kontrol solusi pada file. 

Solution > Load Step Opts > Write LS File > 1 > OK 

8. Mempersiapkan kondisi kontrol solusi (solution controls) pembebanan dan 

perletakan loadstep 2. 

Solution > Analysis Type > Sol’n Controls > Pada layar yang muncul, yang diganti hanya 

bagian waktu: 

PADA TAB BASIC 

Time At End of Loadstep > 38 

Automatic Time Stepping > On 

Number of Substeps > 25 

Max No. Of Substeps > 250 

Min No. Of Substeps > 5 > OK 

9. Memasukkan beban termal pada elemen-elemen yang mengalami kenaikan 

suhu. 

Solution > Define Loads > Apply > Structural > Temperature > On Elements > 

Masukkan Nomor-nomor elemen yang mengalami beban termal (Elemen-1,Elemen-

2,Elemen-n) > OK > Masukkan nilai beban termal (°C) > OK 

10. Menulis data-data kondisi pembebanan dan kontrol solusi pada file. 

Solution > Load Step Opts > Write LS File > 2 > OK 

(Jika terdapat loadstep selanjutnya, maka cukup dilakukan dengan 

mengulang dari langkah-8 hingga langkah-10) 

11. Menjalankan proses perhitungan pada ANSYS. 

Solution > Solve > From LS Files > Pada layar yang muncul > Starting LS file number > 

1 
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Ending LS file number > 3 

File number increment > 1 > OK 

12. Karena proses perhitungan dilakukan dengan menggunakan beberapa 

loadstep dan sejumlah substep, maka proses ini akan cukup memakan 

waktu. Setelah perhitungan selesai akan terdapat pesan pada layar yang 

muncul. 

Solution Is Done! > Close 

 

 

B.3. Fase POSTPROCESSING: Melihat Hasil Perhitungan 

1. Menentukan titik letak pembacaan hasil (pada waktu ke-sekian). 

General Postproc > Read Results > By Time/Freq > Pada layar yang muncul > Value of 

time or freq > Masukkan waktu yang diinginkan > Results at or near TIME > Near TIME 

value > OK 

2. Menampilkan data perpindahan nodal. 

General Postproc > List Results > Nodal Solution > Item to be listed > DOF Solution > 

All DOFs DOF > OK 

3. Menampilkan bentuk (hasil plot) gambar deformasi yang terjadi. 

General Postproc > Plot Results > Deformed Shape > Items to be plotted > Def + 

undeformed > OK 

4. Menampilkan data reaksi perletakan 

General Postproc > List Results > Reaction Solu > Item to be listed > All Items > OK 

5. Menampilkan data pembebanan yang terdapat pada tiap nodal. 

General Postproc > List Results > Nodal Loads > Load to be listed > All Items > OK 

6. Menampilkan nilai tegangan aksial (axial stress - SA) pada seluruh elemen 

dalam substep tertentu. 

Langkah 1. Mendefinisikan tabel data 

General Postproc > Element Table > Define Table > Add > Pada Layar yang muncul > 

User label for item > SA Results data item > By sequence num > LS, 1 > OK 

Langkah 2. Menampilkan data pada tabel 

General Postproc > Element Table > List Elem Table > Items to be listed > SA > OK 

7. Menampilkan nilai regangan aksial (axial strain - EA) pada seluruh elemen 

dalam substep tertentu. 

Langkah 1. Mendefinisikan tabel data 
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General Postproc > Element Table > Define Table > Add > Pada Layar yang muncul > 

User label for item > EA Results data item > By sequence num > LEPEL, 1 > OK 

Langkah 2. Menampilkan data pada tabel 

General Postproc > Element Table > List Elem Table > Items to be listed > EA > OK 

8. Menampilkan nilai perpindahan suatu nodal dalam keseluruhan rentang 

waktu perhitungan. 

Langkah 1. Mendefinisikan variabel data 

TimeHist Postpro > Define Variables > Add > Nodal DOF Result > OK > Masukkan satu 

nomor nodal yang akan ditampilkan datanya > OK > Pada layar yang muncul > User-

Specified Label > UZ_”Nomor Nodal” Data Item > DOF Solution > Translation UZ > 

OK 

Langkah 2. Menampilkan data pada tabel 

TimeHist Postpro > List Variables > 1st Variable to list > UZ_”Nomor Nodal” > OK 

9. Menampilkan nilai tegangan aksial (axial stress - SA) suatu elemen dalam 

keseluruhan rentang waktu perhitungan. 

Langkah 1. Mendefinisikan variabel data 

TimeHist Postpro > Define Variables > Add > ... by seq no. > OK > Masukkan satu 

nomor elemen yang akan ditampilkan datanya > OK > Pada layar yang muncul > User-

Specified Label > SA_”Nomor Elemen” 

Data Item > LS 

Sequence Number > 1 > OK 

Langkah 2. Menampilkan data pada tabel 

TimeHist Postpro > List Variables > 1st Variable to list > SA_”Nomor Elemen” > OK 

10. Menampilkan nilai regangan aksial (axial strain - EA) suatu elemen dalam 

keseluruhan rentang waktu perhitungan. 

Langkah 1. Mendefinisikan variabel data 

TimeHist Postpro > Define Variables > Add > ... by seq no. > OK > Masukkan satu 

nomor elemen yang akan ditampilkan datanya > OK > Pada layar yang muncul > 

User-Specified Label > EA_”Nomor Elemen” 

Data Item > LEPEL 

Sequence Number > 1 > OK 

Langkah 2. Menampilkan data pada tabel 

TimeHist Postpro > List Variables > 1st Variable to list > EA_”Nomor Elemen” > OK 

11. Menampilkan grafik dari suatu variabel yang sudah ditentukan (dapat 

berupa perpindahan nodal, tegangan aksial elemen, atapun regangan aksial 

elemen) terhadap keseluruhan rentang waktu perhitungan. 
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TimeHist Postpro > Graph Variables > 1st Variable to graph > Masukkan nama variabel 

> OK 

 

Demikianlah langkah-langah yang sebagian besar dilakukan dalam 

menggunakan program ANSYS V11.0 untuk keperluan tulisan ini. Hal-hal lain 

yang berhubungan dengan tampilan dan pengaturan-pengaturan lainnya tidak 

dibahas dalam lampiran ini. Untuk keperluan selain seperti yang disebutkan dalam 

langkah-langkah di atas, diharap untuk membaca ANSYS Help ataupun ANSYS 

Tutorial yang terdapat baik dalam program ANSYS itu sendiri ataupun referensi 

referensi lainnya. 
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LAMPIRAN C 

INPUT DATA PROGRAM ANSYS V11.0 

 

Dalam lampiran ini akan diberikan data-data yang digunakan sebagai input 

pada program ANSYS. Data-data tersebut antara lain adalah data koordinat nodal, 

data elemen, serta data pembebanan yang menjadi input dalam simulasi dengan 

program ANSYS v11.0. Data input mengacu pada simulasi jembatan model 

dimensi, karena lebih mendekati model percobaan. Format data disesuaikan 

dengan format program ANSYS itu sendiri, untuk keterangan lebih lanjut dalam 

format data tersebut, diharapkan untuk mengacu pada referensi dari ANSYS Help 

yang disediakan pada Utility Menu. 

 

C.1. Input Data Nodal 

N,Node,X,Y,Z,Thxy,Thyz,Thzx 

N,1,0,0,0,0,0,0 

N,2,0.470588235294118,0,0,0,0,0 

N,3,0.941176470588235,0,0,0,0,0 

N,4,1.41176470588235,0,0,0,0,0 

N,5,1.88235294117647,0,0,0,0,0 

. 

. 

. 

N,1823,5.72549,0.588235294117647,0.547058823529412,0,0,0 

N,1824,5.72549,0.629411764705882,0.547058823529412,0,0,0 

N,1825,5.80392176470588,0.588235294117647,0.547058823529412,0,0,0 

N,1826,5.80392176470588,0.629411764705882,0.547058823529412,0,0,0 

 

C.2. Input Data Elemen 

Node-1, Node-2, 0,0,0,0,0,0, Mat, ElType,Real,Sect,0, ElNumber 

2,332,0,0,0,0,0,0,2,1,2,1,0,1 

332,333,0,0,0,0,0,0,2,1,2,1,0,2 

333,28,0,0,0,0,0,0,2,1,2,1,0,3 

28,334,0,0,0,0,0,0,2,1,2,1,0,4 

334,335,0,0,0,0,0,0,2,1,2,1,0,5 

335,15,0,0,0,0,0,0,2,1,2,1,0,6 
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. 

. 

. 

3565,3566,0,0,0,0,0,0,2,1,1,1,0,5124 

3566,3567,0,0,0,0,0,0,2,1,1,1,0,5125 

3567,3568,0,0,0,0,0,0,2,1,1,1,0,5126 

3568,499,0,0,0,0,0,0,2,1,1,1,0,5127 

 

C.3. Input Data Pembebanan (Loadstep) 

C.3.1. Loadstep 1 (MODEL_KRASAK.S01) 

/COM,ANSYS RELEASE 11.0    UP20070125       11:19:58    07/06/2010 
/NOPR 

/TITLE,MODEL_KRASAK                                                             

_LSNUM=      1 

ANTYPE, 4 

NLGEOM, 1 

TOFFST,  273.000000     

TRNOPT,FULL,,DAMP 

BFUNIF,TEMP,  30.0000000 

 

NSUBST,        15,        25,        10, 

KBC,     0 

KUSE,     0 

TIME,  1.00000000 

TREF,  20.0000000 

ALPHAD,  0.00000000 

BETAD,  0.00000000 

DMPRAT,  0.00000000 

TIMINT,ON  ,STRU 

TINTP,R8.1, 5.000000000E-03,,, 

TINTP,R8.1, -1.00000000    , 0.500000000    ,  5.00000000    ,,,, 

TINTP,R8.1, 5.000000000E-03,  0.00000000 

 

CRPLIM, 0.100000000    ,   0 

CRPLIM,  0.00000000    ,   1 

NCNV,     2,  0.00000000    ,     0,  0.00000000    ,  0.00000000 

LNSRCH,ON 

NEQIT,     0 

 

ERESX,DEFA 
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OUTRES, ALL, ALL, 

ACEL,  0.00000000    ,  0.00000000    ,  1.00000000 

OMEGA,  0.00000000    ,  0.00000000    ,  0.00000000 

DOMEGA,  0.00000000    ,  0.00000000    ,  0.00000000 

CGLOC,  0.00000000    ,  0.00000000    ,  0.00000000 

CGOMEGA,  0.00000000    ,  0.00000000    ,  0.00000000 

DCGOMG,  0.00000000    ,  0.00000000    ,  0.00000000 

IRLF,  0 

 

D,      1,UX  ,  0.00000000    ,  0.00000000     

D,      1,UY  ,  0.00000000    ,  0.00000000     

D,      1,UZ  ,  0.00000000    ,  0.00000000     

D,     14,UY  ,  0.00000000    ,  0.00000000     

D,     14,UZ  ,  0.00000000    ,  0.00000000     

D,     64,UX  ,  0.00000000    ,  0.00000000     

D,     64,UY  ,  0.00000000    ,  0.00000000     

D,     64,UZ  ,  0.00000000    ,  0.00000000     

D,     77,UY  ,  0.00000000    ,  0.00000000     

D,     77,UZ  ,  0.00000000    ,  0.00000000     

D,    127,UX  ,  0.00000000    ,  0.00000000     

D,    127,UY  ,  0.00000000    ,  0.00000000     

D,    127,UZ  ,  0.00000000    ,  0.00000000     

D,    140,UY  ,  0.00000000    ,  0.00000000     

D,    140,UZ  ,  0.00000000    ,  0.00000000     

D,    190,UX  ,  0.00000000    ,  0.00000000     

D,    190,UY  ,  0.00000000    ,  0.00000000     

D,    190,UZ  ,  0.00000000    ,  0.00000000     

D,    203,UY  ,  0.00000000    ,  0.00000000     

D,    203,UZ  ,  0.00000000    ,  0.00000000 

F,    253,FZ  , -8882.17498    ,  0.00000000     

F,    254,FZ  , -8882.17498    ,  0.00000000     

F,    255,FZ  , -8882.17498    ,  0.00000000     

F,    256,FZ  , -8882.17498    ,  0.00000000     

F,    257,FZ  , -8882.17498    ,  0.00000000     

F,    258,FZ  , -8882.17498    ,  0.00000000     

F,    259,FZ  , -8882.17498    ,  0.00000000     

F,    260,FZ  , -8882.17498    ,  0.00000000     

F,    261,FZ  , -8882.17498    ,  0.00000000     

F,    262,FZ  , -8882.17498    ,  0.00000000     
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F,    263,FZ  , -8882.17498    ,  0.00000000     

F,    264,FZ  , -8882.17498    ,  0.00000000     

F,    265,FZ  , -8882.17498    ,  0.00000000     

F,    266,FZ  , -8882.17498    ,  0.00000000     

F,    267,FZ  , -8882.17498    ,  0.00000000     

F,    268,FZ  , -8882.17498    ,  0.00000000     

F,    269,FZ  , -8882.17498    ,  0.00000000     

F,    270,FZ  , -8882.17498    ,  0.00000000     

F,    271,FZ  , -8882.17498    ,  0.00000000     

F,    272,FZ  , -8882.17498    ,  0.00000000     

F,    273,FZ  , -8882.17498    ,  0.00000000     

F,    274,FZ  , -8882.17498    ,  0.00000000     

F,    275,FZ  , -8882.17498    ,  0.00000000     

F,    276,FZ  , -8882.17498    ,  0.00000000     

F,    277,FZ  , -8882.17498    ,  0.00000000     

F,    278,FZ  , -8882.17498    ,  0.00000000     

F,    279,FZ  , -8882.17498    ,  0.00000000     

F,    280,FZ  , -8882.17498    ,  0.00000000     

F,    281,FZ  , -8882.17498    ,  0.00000000     

F,    282,FZ  , -8882.17498    ,  0.00000000     

F,    283,FZ  , -18706.1711    ,  0.00000000     

F,    284,FZ  , -18706.1711    ,  0.00000000     

F,    285,FZ  , -8882.17498    ,  0.00000000     

F,    286,FZ  , -8882.17498    ,  0.00000000     

F,    287,FZ  , -8882.17498    ,  0.00000000     

F,    288,FZ  , -8882.17498    ,  0.00000000     

F,    289,FZ  , -8882.17498    ,  0.00000000     

F,    290,FZ  , -8882.17498    ,  0.00000000     

F,    291,FZ  , -8882.17498    ,  0.00000000     

F,    292,FZ  , -8882.17498    ,  0.00000000     

F,    293,FZ  , -8882.17498    ,  0.00000000     

F,    294,FZ  , -8882.17498    ,  0.00000000     

F,    295,FZ  , -8882.17498    ,  0.00000000     

F,    296,FZ  , -8882.17498    ,  0.00000000     

F,    297,FZ  , -8882.17498    ,  0.00000000     

F,    298,FZ  , -8882.17498    ,  0.00000000     

F,    299,FZ  , -8882.17498    ,  0.00000000     

F,    300,FZ  , -8882.17498    ,  0.00000000     

F,    301,FZ  , -8882.17498    ,  0.00000000     
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F,    302,FZ  , -8882.17498    ,  0.00000000     

F,    303,FZ  , -8882.17498    ,  0.00000000     

F,    304,FZ  , -8882.17498    ,  0.00000000     

F,    305,FZ  , -8882.17498    ,  0.00000000     

F,    306,FZ  , -8882.17498    ,  0.00000000     

F,    307,FZ  , -8882.17498    ,  0.00000000     

F,    308,FZ  , -8882.17498    ,  0.00000000         

/GOPR 

 

C.3.2. Loadstep 2 (MODEL_KRASAK.S02) 

/COM,ANSYS RELEASE 11.0    UP20070125       11:19:58    07/06/2010 
/NOPR 

/TITLE,MODEL_KRASAK                                                             

_LSNUM=      2 

ANTYPE, 4 

NLGEOM, 1 

TOFFST,  273.000000     

TRNOPT,FULL,,DAMP 

BFUNIF,TEMP,  30.0000000 

 

NSUBST,        25,        250,        5, 

KBC,     0 

KUSE,     0 

TIME,  38.00000000 

TREF,  20.0000000 

ALPHAD,  0.00000000 

BETAD,  0.00000000 

DMPRAT,  0.00000000 

TIMINT,ON  ,STRU 

TINTP,R8.1, 5.000000000E-03,,, 

TINTP,R8.1, -1.00000000    , 0.500000000    ,  5.00000000    ,,,, 

TINTP,R8.1, 5.000000000E-03,  0.00000000 

 

 

 

CRPLIM, 0.100000000    ,   0 

CRPLIM,  0.00000000    ,   1 

NCNV,     2,  0.00000000    ,     0,  0.00000000    ,  0.00000000 

LNSRCH,ON 
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NEQIT,     0 

 

ERESX,DEFA 

OUTRES, ALL, ALL, 

ACEL,  0.00000000    ,  0.00000000    ,  1.00000000 

OMEGA,  0.00000000    ,  0.00000000    ,  0.00000000 

DOMEGA,  0.00000000    ,  0.00000000    ,  0.00000000 

CGLOC,  0.00000000    ,  0.00000000    ,  0.00000000 

CGOMEGA,  0.00000000    ,  0.00000000    ,  0.00000000 

DCGOMG,  0.00000000    ,  0.00000000    ,  0.00000000 

IRLF,  0 

 

D,      1,UX  ,  0.00000000    ,  0.00000000     

D,      1,UY  ,  0.00000000    ,  0.00000000     

D,      1,UZ  ,  0.00000000    ,  0.00000000     

D,     14,UY  ,  0.00000000    ,  0.00000000     

D,     14,UZ  ,  0.00000000    ,  0.00000000     

D,     64,UX  ,  0.00000000    ,  0.00000000     

D,     64,UY  ,  0.00000000    ,  0.00000000     

D,     64,UZ  ,  0.00000000    ,  0.00000000     

D,     77,UY  ,  0.00000000    ,  0.00000000     

D,     77,UZ  ,  0.00000000    ,  0.00000000     

D,    127,UX  ,  0.00000000    ,  0.00000000     

D,    127,UY  ,  0.00000000    ,  0.00000000     

D,    127,UZ  ,  0.00000000    ,  0.00000000     

D,    140,UY  ,  0.00000000    ,  0.00000000     

D,    140,UZ  ,  0.00000000    ,  0.00000000     

D,    190,UX  ,  0.00000000    ,  0.00000000     

D,    190,UY  ,  0.00000000    ,  0.00000000     

D,    190,UZ  ,  0.00000000    ,  0.00000000     

D,    203,UY  ,  0.00000000    ,  0.00000000     

D,    203,UZ  ,  0.00000000    ,  0.00000000     

F,    253,FZ  , -8882.17498    ,  0.00000000     

F,    254,FZ  , -8882.17498    ,  0.00000000     

F,    255,FZ  , -8882.17498    ,  0.00000000     

F,    256,FZ  , -8882.17498    ,  0.00000000     

F,    257,FZ  , -8882.17498    ,  0.00000000     

F,    258,FZ  , -8882.17498    ,  0.00000000     

F,    259,FZ  , -8882.17498    ,  0.00000000     
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F,    260,FZ  , -8882.17498    ,  0.00000000     

F,    261,FZ  , -8882.17498    ,  0.00000000     

F,    262,FZ  , -8882.17498    ,  0.00000000     

F,    263,FZ  , -8882.17498    ,  0.00000000     

F,    264,FZ  , -8882.17498    ,  0.00000000     

F,    265,FZ  , -8882.17498    ,  0.00000000     

F,    266,FZ  , -8882.17498    ,  0.00000000     

F,    267,FZ  , -8882.17498    ,  0.00000000     

F,    268,FZ  , -8882.17498    ,  0.00000000     

F,    269,FZ  , -8882.17498    ,  0.00000000     

F,    270,FZ  , -8882.17498    ,  0.00000000     

F,    271,FZ  , -8882.17498    ,  0.00000000     

F,    272,FZ  , -8882.17498    ,  0.00000000     

F,    273,FZ  , -8882.17498    ,  0.00000000     

F,    274,FZ  , -8882.17498    ,  0.00000000     

F,    275,FZ  , -8882.17498    ,  0.00000000     

F,    276,FZ  , -8882.17498    ,  0.00000000     

F,    277,FZ  , -8882.17498    ,  0.00000000     

F,    278,FZ  , -8882.17498    ,  0.00000000     

F,    279,FZ  , -8882.17498    ,  0.00000000     

F,    280,FZ  , -8882.17498    ,  0.00000000     

F,    281,FZ  , -8882.17498    ,  0.00000000     

F,    282,FZ  , -8882.17498    ,  0.00000000     

F,    283,FZ  , -18706.1711    ,  0.00000000     

F,    284,FZ  , -18706.1711    ,  0.00000000     

F,    285,FZ  , -8882.17498    ,  0.00000000     

F,    286,FZ  , -8882.17498    ,  0.00000000     

F,    287,FZ  , -8882.17498    ,  0.00000000     

F,    288,FZ  , -8882.17498    ,  0.00000000     

F,    289,FZ  , -8882.17498    ,  0.00000000     

F,    290,FZ  , -8882.17498    ,  0.00000000     

F,    291,FZ  , -8882.17498    ,  0.00000000     

F,    292,FZ  , -8882.17498    ,  0.00000000     

F,    293,FZ  , -8882.17498    ,  0.00000000     

F,    294,FZ  , -8882.17498    ,  0.00000000     

F,    295,FZ  , -8882.17498    ,  0.00000000     

F,    296,FZ  , -8882.17498    ,  0.00000000     

F,    297,FZ  , -8882.17498    ,  0.00000000     

F,    298,FZ  , -8882.17498    ,  0.00000000     
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F,    299,FZ  , -8882.17498    ,  0.00000000     

F,    300,FZ  , -8882.17498    ,  0.00000000     

F,    301,FZ  , -8882.17498    ,  0.00000000     

F,    302,FZ  , -8882.17498    ,  0.00000000     

F,    303,FZ  , -8882.17498    ,  0.00000000     

F,    304,FZ  , -8882.17498    ,  0.00000000     

F,    305,FZ  , -8882.17498    ,  0.00000000     

F,    306,FZ  , -8882.17498    ,  0.00000000     

F,    307,FZ  , -8882.17498    ,  0.00000000     

F,    308,FZ  , -8882.17498    ,  0.00000000     

BFE,     137,TEMP,       1,  552.722000     

BFE,     139,TEMP,       1,  552.722000     

BFE,     140,TEMP,       1,  552.722000     

BFE,     141,TEMP,       1,  552.722000     

BFE,     142,TEMP,       1,  552.722000     

BFE,     143,TEMP,       1,  552.722000     

BFE,     144,TEMP,       1,  552.722000     

BFE,     156,TEMP,       1,  552.722000     

BFE,     555,TEMP,       1,  552.722000     

BFE,     557,TEMP,       1,  552.722000     

BFE,     558,TEMP,       1,  552.722000     

BFE,     559,TEMP,       1,  552.722000     

BFE,     560,TEMP,       1,  552.722000     

BFE,     569,TEMP,       1,  552.722000     

BFE,     570,TEMP,       1,  552.722000     

BFE,     871,TEMP,       1,  552.722000     

BFE,     872,TEMP,       1,  552.722000     

BFE,     873,TEMP,       1,  552.722000     

BFE,     874,TEMP,       1,  552.722000     

BFE,     875,TEMP,       1,  552.722000     

BFE,     876,TEMP,       1,  552.722000     

BFE,     877,TEMP,       1,  552.722000     

BFE,     878,TEMP,       1,  552.722000     

BFE,     879,TEMP,       1,  552.722000     

BFE,     880,TEMP,       1,  552.722000     

BFE,     881,TEMP,       1,  552.722000     

BFE,     882,TEMP,       1,  552.722000     

BFE,     883,TEMP,       1,  552.722000     

BFE,     884,TEMP,       1,  552.722000     
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BFE,     885,TEMP,       1,  552.722000     

BFE,     886,TEMP,       1,  552.722000     

BFE,     887,TEMP,       1,  552.722000     

BFE,     888,TEMP,       1,  552.722000     

BFE,     889,TEMP,       1,  552.722000     

BFE,     890,TEMP,       1,  552.722000     

BFE,     891,TEMP,       1,  552.722000     

BFE,     892,TEMP,       1,  552.722000     

BFE,     893,TEMP,       1,  552.722000     

BFE,     894,TEMP,       1,  552.722000     

BFE,     895,TEMP,       1,  552.722000     

BFE,     896,TEMP,       1,  552.722000     

BFE,     897,TEMP,       1,  552.722000     

BFE,     898,TEMP,       1,  552.722000     

BFE,     899,TEMP,       1,  552.722000     

BFE,     900,TEMP,       1,  552.722000     

BFE,     901,TEMP,       1,  552.722000     

BFE,     902,TEMP,       1,  552.722000     

BFE,     903,TEMP,       1,  552.722000     

BFE,     904,TEMP,       1,  552.722000     

BFE,     905,TEMP,       1,  552.722000     

BFE,     906,TEMP,       1,  552.722000     

BFE,     907,TEMP,       1,  552.722000     

BFE,     908,TEMP,       1,  552.722000     

BFE,     909,TEMP,       1,  552.722000     

BFE,     910,TEMP,       1,  552.722000     

BFE,     911,TEMP,       1,  552.722000     

BFE,     912,TEMP,       1,  552.722000     

BFE,     913,TEMP,       1,  552.722000     

BFE,     914,TEMP,       1,  552.722000     

BFE,     915,TEMP,       1,  552.722000     

BFE,     916,TEMP,       1,  552.722000     

BFE,     917,TEMP,       1,  552.722000     

BFE,     918,TEMP,       1,  552.722000     

BFE,     919,TEMP,       1,  552.722000     

BFE,     920,TEMP,       1,  552.722000     

BFE,     921,TEMP,       1,  552.722000     

BFE,     922,TEMP,       1,  552.722000     

BFE,    1210,TEMP,       1,  552.722000     
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BFE,    1212,TEMP,       1,  552.722000     

BFE,    1213,TEMP,       1,  552.722000     

BFE,    1215,TEMP,       1,  552.722000     

BFE,    1237,TEMP,       1,  552.722000     

BFE,    1353,TEMP,       1,  552.722000     

BFE,    1354,TEMP,       1,  552.722000     

BFE,    1355,TEMP,       1,  552.722000     

BFE,    1356,TEMP,       1,  552.722000     

BFE,    1357,TEMP,       1,  552.722000     

BFE,    1358,TEMP,       1,  552.722000     

BFE,    1359,TEMP,       1,  552.722000     

BFE,    1360,TEMP,       1,  552.722000     

BFE,    1361,TEMP,       1,  552.722000     

BFE,    1362,TEMP,       1,  552.722000     

BFE,    1363,TEMP,       1,  552.722000     

BFE,    1364,TEMP,       1,  552.722000     

BFE,    1365,TEMP,       1,  552.722000     

BFE,    1366,TEMP,       1,  552.722000     

BFE,    1367,TEMP,       1,  552.722000     

BFE,    1368,TEMP,       1,  552.722000     

BFE,    1369,TEMP,       1,  552.722000     

BFE,    1370,TEMP,       1,  552.722000     

BFE,    1372,TEMP,       1,  552.722000     

BFE,    1373,TEMP,       1,  552.722000     

BFE,    1374,TEMP,       1,  552.722000     

BFE,    1375,TEMP,       1,  552.722000     

BFE,    1376,TEMP,       1,  552.722000     

BFE,    1377,TEMP,       1,  552.722000     

BFE,    1378,TEMP,       1,  552.722000     

BFE,    1379,TEMP,       1,  552.722000     

BFE,    1380,TEMP,       1,  552.722000     

BFE,    1381,TEMP,       1,  552.722000     

BFE,    1382,TEMP,       1,  552.722000     

BFE,    1383,TEMP,       1,  552.722000     

BFE,    1384,TEMP,       1,  552.722000     

BFE,    1385,TEMP,       1,  552.722000     

BFE,    1386,TEMP,       1,  552.722000     

BFE,    1387,TEMP,       1,  552.722000     

BFE,    1388,TEMP,       1,  552.722000     
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BFE,    1389,TEMP,       1,  552.722000     

BFE,    1509,TEMP,       1,  552.722000     

BFE,    1510,TEMP,       1,  552.722000     

BFE,    1511,TEMP,       1,  552.722000     

BFE,    1512,TEMP,       1,  552.722000     

BFE,    1587,TEMP,       1,  552.722000     

BFE,    1592,TEMP,       1,  552.722000     

BFE,    1677,TEMP,       1,  552.722000     

BFE,    1682,TEMP,       1,  552.722000     

BFE,    1856,TEMP,       1,  552.722000     

BFE,    1857,TEMP,       1,  552.722000     

BFE,    1862,TEMP,       1,  552.722000     

BFE,    1863,TEMP,       1,  552.722000     

BFE,    1994,TEMP,       1,  552.722000     

BFE,    1995,TEMP,       1,  552.722000     

BFE,    2000,TEMP,       1,  552.722000     

BFE,    2001,TEMP,       1,  552.722000     

BFE,    2138,TEMP,       1,  552.722000     

BFE,    2139,TEMP,       1,  552.722000     

BFE,    2144,TEMP,       1,  552.722000     

BFE,    2145,TEMP,       1,  552.722000     

BFE,    2282,TEMP,       1,  552.722000     

BFE,    2283,TEMP,       1,  552.722000     

BFE,    2288,TEMP,       1,  552.722000     

BFE,    2289,TEMP,       1,  552.722000     

BFE,    2380,TEMP,       1,  552.722000     

BFE,    2381,TEMP,       1,  552.722000     

BFE,    2382,TEMP,       1,  552.722000     

BFE,    2383,TEMP,       1,  552.722000     

BFE,    2384,TEMP,       1,  552.722000     

BFE,    2385,TEMP,       1,  552.722000     

BFE,    2446,TEMP,       1,  552.722000     

BFE,    2447,TEMP,       1,  552.722000     

BFE,    2448,TEMP,       1,  552.722000     

BFE,    2449,TEMP,       1,  552.722000     

BFE,    2450,TEMP,       1,  552.722000     

BFE,    2451,TEMP,       1,  552.722000     

BFE,    2518,TEMP,       1,  552.722000     

BFE,    2519,TEMP,       1,  552.722000     
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BFE,    2520,TEMP,       1,  552.722000     

BFE,    2521,TEMP,       1,  552.722000     

BFE,    2522,TEMP,       1,  552.722000     

BFE,    2523,TEMP,       1,  552.722000     

BFE,    2590,TEMP,       1,  552.722000     

BFE,    2591,TEMP,       1,  552.722000     

BFE,    2592,TEMP,       1,  552.722000     

BFE,    2593,TEMP,       1,  552.722000     

BFE,    2594,TEMP,       1,  552.722000     

BFE,    2595,TEMP,       1,  552.722000     

BFE,    2738,TEMP,       1,  552.722000     

BFE,    2739,TEMP,       1,  552.722000     

BFE,    2741,TEMP,       1,  552.722000     

BFE,    2742,TEMP,       1,  552.722000     

BFE,    2835,TEMP,       1,  552.722000     

BFE,    2836,TEMP,       1,  552.722000     

BFE,    2913,TEMP,       1,  552.722000     

BFE,    2914,TEMP,       1,  552.722000     

BFE,    2916,TEMP,       1,  552.722000     

BFE,    2917,TEMP,       1,  552.722000     

BFE,    3014,TEMP,       1,  552.722000     

BFE,    3015,TEMP,       1,  552.722000     

BFE,    3101,TEMP,       1,  552.722000     

BFE,    3102,TEMP,       1,  552.722000     

BFE,    3104,TEMP,       1,  552.722000     

BFE,    3105,TEMP,       1,  552.722000     

BFE,    3260,TEMP,       1,  552.722000     

BFE,    3261,TEMP,       1,  552.722000     

BFE,    3263,TEMP,       1,  552.722000     

BFE,    3264,TEMP,       1,  552.722000     

BFE,    3337,TEMP,       1,  552.722000     

BFE,    3338,TEMP,       1,  552.722000     

BFE,    3339,TEMP,       1,  552.722000     

BFE,    3340,TEMP,       1,  552.722000     

BFE,    3341,TEMP,       1,  552.722000     

BFE,    3342,TEMP,       1,  552.722000     

BFE,    3343,TEMP,       1,  552.722000     

BFE,    3344,TEMP,       1,  552.722000     

BFE,    3345,TEMP,       1,  552.722000     
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BFE,    3346,TEMP,       1,  552.722000     

BFE,    3347,TEMP,       1,  552.722000     

BFE,    3348,TEMP,       1,  552.722000     

BFE,    3349,TEMP,       1,  552.722000     

BFE,    3350,TEMP,       1,  552.722000     

/GOPR 

 

C.3.3. Loadstep 3 (MODEL_KRASAK.S03) 

/COM,ANSYS RELEASE 11.0    UP20070125       11:19:58    07/06/2010 
/NOPR 
/TITLE,MODEL_KRASAK                                                             
_LSNUM=      3 
ANTYPE, 4 
NLGEOM, 1 
TOFFST,  273.000000     
TRNOPT,FULL,,DAMP 
BFUNIF,TEMP,  30.0000000 
 
NSUBST,        60,        600,        20, 
KBC,     0 
KUSE,     0 
TIME,  74.0000000 
TREF,  20.0000000 
ALPHAD,  0.00000000 
BETAD,  0.00000000 
DMPRAT,  0.00000000 
TIMINT,ON  ,STRU 
TINTP,R8.1, 5.000000000E-03,,, 
TINTP,R8.1, -1.00000000    , 0.500000000    ,  5.00000000    ,,,, 
TINTP,R8.1, 5.000000000E-03,  0.00000000 
 
 
 
CRPLIM, 0.100000000    ,   0 
CRPLIM,  0.00000000    ,   1 
NCNV,     2,  0.00000000    ,     0,  0.00000000    ,  0.00000000 
LNSRCH,ON 
NEQIT,     0 
 
ERESX,DEFA 
OUTRES, ALL, ALL, 
ACEL,  0.00000000    ,  0.00000000    ,  1.00000000 
OMEGA,  0.00000000    ,  0.00000000    ,  0.00000000 
DOMEGA,  0.00000000    ,  0.00000000    ,  0.00000000 
CGLOC,  0.00000000    ,  0.00000000    ,  0.00000000 
CGOMEGA,  0.00000000    ,  0.00000000    ,  0.00000000 
DCGOMG,  0.00000000    ,  0.00000000    ,  0.00000000 
IRLF,  0 
 
D,      1,UX  ,  0.00000000    ,  0.00000000     
D,      1,UY  ,  0.00000000    ,  0.00000000     
D,      1,UZ  ,  0.00000000    ,  0.00000000     
D,     14,UY  ,  0.00000000    ,  0.00000000     
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D,     14,UZ  ,  0.00000000    ,  0.00000000     
D,     64,UX  ,  0.00000000    ,  0.00000000     
D,     64,UY  ,  0.00000000    ,  0.00000000     
D,     64,UZ  ,  0.00000000    ,  0.00000000     
D,     77,UY  ,  0.00000000    ,  0.00000000     
D,     77,UZ  ,  0.00000000    ,  0.00000000     
D,    127,UX  ,  0.00000000    ,  0.00000000     
D,    127,UY  ,  0.00000000    ,  0.00000000     
D,    127,UZ  ,  0.00000000    ,  0.00000000     
D,    140,UY  ,  0.00000000    ,  0.00000000     
D,    140,UZ  ,  0.00000000    ,  0.00000000     
D,    190,UX  ,  0.00000000    ,  0.00000000     
D,    190,UY  ,  0.00000000    ,  0.00000000     
D,    190,UZ  ,  0.00000000    ,  0.00000000     
D,    203,UY  ,  0.00000000    ,  0.00000000     
D,    203,UZ  ,  0.00000000    ,  0.00000000     
F,    253,FZ  , -8882.17498    ,  0.00000000     
F,    254,FZ  , -8882.17498    ,  0.00000000     
F,    255,FZ  , -8882.17498    ,  0.00000000     
F,    256,FZ  , -8882.17498    ,  0.00000000     
F,    257,FZ  , -8882.17498    ,  0.00000000     
F,    258,FZ  , -8882.17498    ,  0.00000000     
F,    259,FZ  , -8882.17498    ,  0.00000000     
F,    260,FZ  , -8882.17498    ,  0.00000000     
F,    261,FZ  , -8882.17498    ,  0.00000000     
F,    262,FZ  , -8882.17498    ,  0.00000000     
F,    263,FZ  , -8882.17498    ,  0.00000000     
F,    264,FZ  , -8882.17498    ,  0.00000000     
F,    265,FZ  , -8882.17498    ,  0.00000000     
F,    266,FZ  , -8882.17498    ,  0.00000000     
F,    267,FZ  , -8882.17498    ,  0.00000000     
F,    268,FZ  , -8882.17498    ,  0.00000000     
F,    269,FZ  , -8882.17498    ,  0.00000000     
F,    270,FZ  , -8882.17498    ,  0.00000000     
F,    271,FZ  , -8882.17498    ,  0.00000000     
F,    272,FZ  , -8882.17498    ,  0.00000000     
F,    273,FZ  , -8882.17498    ,  0.00000000     
F,    274,FZ  , -8882.17498    ,  0.00000000     
F,    275,FZ  , -8882.17498    ,  0.00000000     
F,    276,FZ  , -8882.17498    ,  0.00000000     
F,    277,FZ  , -8882.17498    ,  0.00000000     
F,    278,FZ  , -8882.17498    ,  0.00000000     
F,    279,FZ  , -8882.17498    ,  0.00000000     
F,    280,FZ  , -8882.17498    ,  0.00000000     
F,    281,FZ  , -8882.17498    ,  0.00000000     
F,    282,FZ  , -8882.17498    ,  0.00000000     
F,    283,FZ  , -18706.1711    ,  0.00000000     
F,    284,FZ  , -18706.1711    ,  0.00000000     
F,    285,FZ  , -8882.17498    ,  0.00000000     
F,    286,FZ  , -8882.17498    ,  0.00000000     
F,    287,FZ  , -8882.17498    ,  0.00000000     
F,    288,FZ  , -8882.17498    ,  0.00000000     
F,    289,FZ  , -8882.17498    ,  0.00000000     
F,    290,FZ  , -8882.17498    ,  0.00000000     
F,    291,FZ  , -8882.17498    ,  0.00000000     
F,    292,FZ  , -8882.17498    ,  0.00000000     
F,    293,FZ  , -8882.17498    ,  0.00000000     
F,    294,FZ  , -8882.17498    ,  0.00000000     
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F,    295,FZ  , -8882.17498    ,  0.00000000     
F,    296,FZ  , -8882.17498    ,  0.00000000     
F,    297,FZ  , -8882.17498    ,  0.00000000     
F,    298,FZ  , -8882.17498    ,  0.00000000     
F,    299,FZ  , -8882.17498    ,  0.00000000     
F,    300,FZ  , -8882.17498    ,  0.00000000     
F,    301,FZ  , -8882.17498    ,  0.00000000     
F,    302,FZ  , -8882.17498    ,  0.00000000     
F,    303,FZ  , -8882.17498    ,  0.00000000     
F,    304,FZ  , -8882.17498    ,  0.00000000     
F,    305,FZ  , -8882.17498    ,  0.00000000     
F,    306,FZ  , -8882.17498    ,  0.00000000     
F,    307,FZ  , -8882.17498    ,  0.00000000     
F,    308,FZ  , -8882.17498    ,  0.00000000     
BFE,     137,TEMP,       1,  801.420000     
BFE,     139,TEMP,       1,  801.420000     
BFE,     140,TEMP,       1,  801.420000     
BFE,     141,TEMP,       1,  801.420000     
BFE,     142,TEMP,       1,  801.420000     
BFE,     143,TEMP,       1,  801.420000     
BFE,     144,TEMP,       1,  801.420000     
BFE,     156,TEMP,       1,  801.420000     
BFE,     555,TEMP,       1,  801.420000     
BFE,     557,TEMP,       1,  801.420000     
BFE,     558,TEMP,       1,  801.420000     
BFE,     559,TEMP,       1,  801.420000     
BFE,     560,TEMP,       1,  801.420000     
BFE,     569,TEMP,       1,  801.420000     
BFE,     570,TEMP,       1,  801.420000     
BFE,     871,TEMP,       1,  801.420000     
BFE,     872,TEMP,       1,  801.420000     
BFE,     873,TEMP,       1,  801.420000     
BFE,     874,TEMP,       1,  801.420000     
BFE,     875,TEMP,       1,  801.420000     
BFE,     876,TEMP,       1,  801.420000     
BFE,     877,TEMP,       1,  801.420000     
BFE,     878,TEMP,       1,  801.420000     
BFE,     879,TEMP,       1,  801.420000     
BFE,     880,TEMP,       1,  801.420000     
BFE,     881,TEMP,       1,  801.420000     
BFE,     882,TEMP,       1,  801.420000     
BFE,     883,TEMP,       1,  801.420000     
BFE,     884,TEMP,       1,  801.420000     
BFE,     885,TEMP,       1,  801.420000     
BFE,     886,TEMP,       1,  801.420000     
BFE,     887,TEMP,       1,  801.420000     
BFE,     888,TEMP,       1,  801.420000     
BFE,     889,TEMP,       1,  801.420000     
BFE,     890,TEMP,       1,  801.420000     
BFE,     891,TEMP,       1,  801.420000     
BFE,     892,TEMP,       1,  801.420000     
BFE,     893,TEMP,       1,  801.420000     
BFE,     894,TEMP,       1,  801.420000     
BFE,     895,TEMP,       1,  801.420000     
BFE,     896,TEMP,       1,  801.420000     
BFE,     897,TEMP,       1,  801.420000     
BFE,     898,TEMP,       1,  801.420000     
BFE,     899,TEMP,       1,  801.420000     

Kajian keruntuhan..., Rifky Netriady, FTUI, 2012



125 
 

BFE,     900,TEMP,       1,  801.420000     
BFE,     901,TEMP,       1,  801.420000     
BFE,     902,TEMP,       1,  801.420000     
BFE,     903,TEMP,       1,  801.420000     
BFE,     904,TEMP,       1,  801.420000     
BFE,     905,TEMP,       1,  801.420000     
BFE,     906,TEMP,       1,  801.420000     
BFE,     907,TEMP,       1,  801.420000     
BFE,     908,TEMP,       1,  801.420000     
BFE,     909,TEMP,       1,  801.420000     
BFE,     910,TEMP,       1,  801.420000     
BFE,     911,TEMP,       1,  801.420000     
BFE,     912,TEMP,       1,  801.420000     
BFE,     913,TEMP,       1,  801.420000     
BFE,     914,TEMP,       1,  801.420000     
BFE,     915,TEMP,       1,  801.420000     
BFE,     916,TEMP,       1,  801.420000     
BFE,     917,TEMP,       1,  801.420000     
BFE,     918,TEMP,       1,  801.420000     
BFE,     919,TEMP,       1,  801.420000     
BFE,     920,TEMP,       1,  801.420000     
BFE,     921,TEMP,       1,  801.420000     
BFE,     922,TEMP,       1,  801.420000     
BFE,    1210,TEMP,       1,  801.420000     
BFE,    1212,TEMP,       1,  801.420000     
BFE,    1213,TEMP,       1,  801.420000     
BFE,    1215,TEMP,       1,  801.420000     
BFE,    1237,TEMP,       1,  801.420000     
BFE,    1353,TEMP,       1,  801.420000     
BFE,    1354,TEMP,       1,  801.420000     
BFE,    1355,TEMP,       1,  801.420000     
BFE,    1356,TEMP,       1,  801.420000     
BFE,    1357,TEMP,       1,  801.420000     
BFE,    1358,TEMP,       1,  801.420000     
BFE,    1359,TEMP,       1,  801.420000     
BFE,    1360,TEMP,       1,  801.420000     
BFE,    1361,TEMP,       1,  801.420000     
BFE,    1362,TEMP,       1,  801.420000     
BFE,    1363,TEMP,       1,  801.420000     
BFE,    1364,TEMP,       1,  801.420000     
BFE,    1365,TEMP,       1,  801.420000     
BFE,    1366,TEMP,       1,  801.420000     
BFE,    1367,TEMP,       1,  801.420000     
BFE,    1368,TEMP,       1,  801.420000     
BFE,    1369,TEMP,       1,  801.420000     
BFE,    1370,TEMP,       1,  801.420000     
BFE,    1372,TEMP,       1,  801.420000     
BFE,    1373,TEMP,       1,  801.420000     
BFE,    1374,TEMP,       1,  801.420000     
BFE,    1375,TEMP,       1,  801.420000     
BFE,    1376,TEMP,       1,  801.420000     
BFE,    1377,TEMP,       1,  801.420000     
BFE,    1378,TEMP,       1,  801.420000     
BFE,    1379,TEMP,       1,  801.420000     
BFE,    1380,TEMP,       1,  801.420000     
BFE,    1381,TEMP,       1,  801.420000     
BFE,    1382,TEMP,       1,  801.420000     
BFE,    1383,TEMP,       1,  801.420000     
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BFE,    1384,TEMP,       1,  801.420000     
BFE,    1385,TEMP,       1,  801.420000     
BFE,    1386,TEMP,       1,  801.420000     
BFE,    1387,TEMP,       1,  801.420000     
BFE,    1388,TEMP,       1,  801.420000     
BFE,    1389,TEMP,       1,  801.420000     
BFE,    1509,TEMP,       1,  801.420000     
BFE,    1510,TEMP,       1,  801.420000     
BFE,    1511,TEMP,       1,  801.420000     
BFE,    1512,TEMP,       1,  801.420000     
BFE,    1587,TEMP,       1,  801.420000     
BFE,    1592,TEMP,       1,  801.420000     
BFE,    1677,TEMP,       1,  801.420000     
BFE,    1682,TEMP,       1,  801.420000     
BFE,    1856,TEMP,       1,  801.420000     
BFE,    1857,TEMP,       1,  801.420000     
BFE,    1862,TEMP,       1,  801.420000     
BFE,    1863,TEMP,       1,  801.420000     
BFE,    1994,TEMP,       1,  801.420000     
BFE,    1995,TEMP,       1,  801.420000     
BFE,    2000,TEMP,       1,  801.420000     
BFE,    2001,TEMP,       1,  801.420000     
BFE,    2138,TEMP,       1,  801.420000     
BFE,    2139,TEMP,       1,  801.420000     
BFE,    2144,TEMP,       1,  801.420000     
BFE,    2145,TEMP,       1,  801.420000     
BFE,    2282,TEMP,       1,  801.420000     
BFE,    2283,TEMP,       1,  801.420000     
BFE,    2288,TEMP,       1,  801.420000     
BFE,    2289,TEMP,       1,  801.420000     
BFE,    2380,TEMP,       1,  801.420000     
BFE,    2381,TEMP,       1,  801.420000     
BFE,    2382,TEMP,       1,  801.420000     
BFE,    2383,TEMP,       1,  801.420000     
BFE,    2384,TEMP,       1,  801.420000     
BFE,    2385,TEMP,       1,  801.420000     
BFE,    2446,TEMP,       1,  801.420000     
BFE,    2447,TEMP,       1,  801.420000     
BFE,    2448,TEMP,       1,  801.420000     
BFE,    2449,TEMP,       1,  801.420000     
BFE,    2450,TEMP,       1,  801.420000     
BFE,    2451,TEMP,       1,  801.420000     
BFE,    2518,TEMP,       1,  801.420000     
BFE,    2519,TEMP,       1,  801.420000     
BFE,    2520,TEMP,       1,  801.420000     
BFE,    2521,TEMP,       1,  801.420000     
BFE,    2522,TEMP,       1,  801.420000     
BFE,    2523,TEMP,       1,  801.420000     
BFE,    2590,TEMP,       1,  801.420000     
BFE,    2591,TEMP,       1,  801.420000     
BFE,    2592,TEMP,       1,  801.420000     
BFE,    2593,TEMP,       1,  801.420000     
BFE,    2594,TEMP,       1,  801.420000     
BFE,    2595,TEMP,       1,  801.420000     
BFE,    2738,TEMP,       1,  801.420000     
BFE,    2739,TEMP,       1,  801.420000     
BFE,    2741,TEMP,       1,  801.420000     
BFE,    2742,TEMP,       1,  801.420000     
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BFE,    2835,TEMP,       1,  801.420000     
BFE,    2836,TEMP,       1,  801.420000     
BFE,    2913,TEMP,       1,  801.420000     
BFE,    2914,TEMP,       1,  801.420000     
BFE,    2916,TEMP,       1,  801.420000     
BFE,    2917,TEMP,       1,  801.420000     
BFE,    3014,TEMP,       1,  801.420000     
BFE,    3015,TEMP,       1,  801.420000     
BFE,    3101,TEMP,       1,  801.420000     
BFE,    3102,TEMP,       1,  801.420000     
BFE,    3104,TEMP,       1,  801.420000     
BFE,    3105,TEMP,       1,  801.420000     
BFE,    3260,TEMP,       1,  801.420000     
BFE,    3261,TEMP,       1,  801.420000     
BFE,    3263,TEMP,       1,  801.420000     
BFE,    3264,TEMP,       1,  801.420000     
BFE,    3337,TEMP,       1,  801.420000     
BFE,    3338,TEMP,       1,  801.420000     
BFE,    3339,TEMP,       1,  801.420000     
BFE,    3340,TEMP,       1,  801.420000     
BFE,    3341,TEMP,       1,  801.420000     
BFE,    3342,TEMP,       1,  801.420000     
BFE,    3343,TEMP,       1,  801.420000     
BFE,    3344,TEMP,       1,  801.420000     
BFE,    3345,TEMP,       1,  801.420000     
BFE,    3346,TEMP,       1,  801.420000     
BFE,    3347,TEMP,       1,  801.420000     
BFE,    3348,TEMP,       1,  801.420000     
BFE,    3349,TEMP,       1,  801.420000     
BFE,    3350,TEMP,       1,  801.420000     
/GOPR 
 
 

C.4. Hal-Hal Yang Harus Diperhatikan Pada Saat Input Data 

Dalam menggunakan program ANSYS V11.0 ini, perlu diketahui bahwa 

ANSYS akan menulis keseluruhan hasil perhitungan pada folder yang sudah 

ditentukan pada awal penggunaan (lihat Lampiran B). Oleh karena itu, sebaiknya 

untuk setiap model yang berbeda, gunakanlah folder yang berbeda pula, hal ini 

untuk memudahkan dalam pembacaan hasil atau apabila ingin mengganti input 

data secara cepat. 

Untuk memperoleh hasil yang selalu konvergen semaksimal mungkin, 

diperlukan selisih waktu ataupun perubahan gaya yang sekecil mungkin. Hal ini 

dapat dilakukan dengan memperbesar jumlah substep dalam setiap step 

pembebanan yang dilakukan. Jumlah substep yang semakin banyak akan 

mengakibatkan waktu perhitungan yang semakin lama. Apabila terjadi ketidak 

korvergenan dalam perhitungan, maka sebaiknya perhitungan tersebut diulang 

dengan jumlah substep 2 kali lipat lebih banyak, hal ini dilakukan secara terus 
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menerus sampai suatu batasan tertentu dimana memang sudah mencapai titik 

maksimalnya. 

Secara default, ANSYS membatasi jumlah substep dalam suatu 

perhitungan hanya mencapai 1000 substep. Jumlah ini dapat ditingkatkan dengan 

menuliskan suatu perintah pada Input Window. Sebaga contoh, apabila jumlah 

tersebut ingin ditingkatkan hingga mencapai 20000, maka cukup dengan 

menuliskan “/CONFIG, NRES, 20000” pada Input Window. Perlu diperhatikan 

bahwa input ini harus dilakukan sebelum tahap Preprocessing. Keterangan lebih 

lenjut mengenai hal ini dapat dibaca pada ANSYS Help yang sudah disediakan 

oleh program itu sendiri. 

Selanjutnya, dalam melakukan proses input data pada ANSYS, dapat 

dilakukan dengan dua hal, yaitu dengan memasukkannya satu persatu dalam 

keadaan program menyala, atau dengan menggunakan text editor seperti Notepad 

dalam keadaan tanpa menyalakan program. Dalam hal ini, penulis menyarankan 

untuk membiasakan memasukkan data secara satu persatu dalam mode GUI 

(Graphical User Interface), selanjutnya menuliskan hasil masukan tersebut dalam 

format “.txt” untuk memperoleh format yang harus diikuti dalam memasukkan 

input data melalui text editor. Hal ini sangat penting karena penggunaan jumlah 

spasi yang berbeda akan menghasilkan arti yang berbeda pula dalam input data 

tersebut. Setelah didapatkan format “.txt” dari ANSYS, maka kita dapat 

menambahkan data-data yang diperlukan sesuai dengan format yang diberikan 

dalam file tersebut. Semakin banyak mencoba maka akan semakin mengerti.  

Untuk hal-hal lain yang berkaitan dengan trik dan tips dalam 

menggunakan ANSYS, penulis hanya dapat mengatakan bahwa pengalaman 

memang guru yang terbaik. Penulis menyarankan untuk menggunakanANSYS 

sesering mungkin agar terbiasa dan fasih dengan fitur serta langkahlangkah dalam 

melakukan input data. Akan tetapi proses otodidak ini pun harus disertai dengan 

panduan berupa buku atau tutorial. 
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LAMPIRAN D 

DOKUMENTASI JEMBATAN KRASAK 

 

Dalam lampiran ini akan ditampilkan foto-foto dalam percobaan jembatan 

model yang dilaksanakan pada tanggal 22 Juli 2010. 

 

 

    

Gambar D.1. Pemasangan Strain Gage (kiri) dan Uji Statik (kanan) 

 

    

Gambar D.2. Tampak Jembatan (kiri) dan Bagian Bawah Jembatan (kanan) 

 

    

Gambar D.3. Pengaku Diagonal Rangka Atas (kiri) dan Modelisasi Beban Truk (kanan) 
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Gambar D.4. Modelisasi Tangki Bahan Bakar (kiri) dan Kondisi Siap Uji (kanan) 

 

    

Gambar D.5. Kebakaran Kondisi Angin Kecil (kiri) dan Efek Angin Dari Sebelah Kiri 

(kanan) 

 

    

Gambar D.6. Kebakaran Pada Diagonal Rangka Atas  

 

    

Gambar D.7. Kondisi Setelah Kebakaran  
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LAMPIRAN E 

DATA LAPANGAN HASIL PERCOBAAN 

 

Dalam lampiran ini akan ditampilkan hasil pencatatan perubahan 

temperatur pada rangka jembatan serta penurunan yang terjadi terhadap waktu-

waktu tertentu. 

 

D.1. Uji Statik 

 

 

 

 

  

 

Delta Ketelitian

[mm] [x 0.01 mm] [mm] [x 0.01 mm] [mm] [x 0.01 mm] [mm] [%]

1 20 0.00 19 89.50 20 0.00 0.105 100

2 20 0.00 19 81.00 20 0.00 0.190 100

3 20 0.00 19 72.00 20 0.00 0.280 100

4 20 0.00 19 63.80 20 0.00 0.362 100

5 20 0.00 19 57.20 20 0.00 0.428 100

6 20 0.00 19 36.50 19 99.20 0.635 100

Delta Ketelitian

[mm] [x 0.01 mm] [mm] [x 0.01 mm] [mm] [x 0.01 mm] [mm] [%]

1 1 3.00 0 94.00 1 3.00 0.090 100

2 1 3.00 0 85.00 1 3.00 0.180 100

3 1 3.00 0 77.00 1 3.00 0.260 100

4 1 3.00 0 69.00 1 3.00 0.340 100

5 1 22.00 0 63.00 1 3.00 0.590 118

6 1 3.00 0 42.00 1 22.00 0.610 84

Posisi 

Beban

Dial Gage-2

Bacaan 1 Bacaan 2 Bacaan 3

Posisi 

Beban
Tanpa Beban (Awal) Dengan Beban Tanpa Beban (Akhir)

Dial Gage-1

Utara 
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D.2. Data Temperatur 

Data temperatur ditampilkan pada halaman berikut ini: 

 

 

 

 

Delta Ketelitian

[mm] [x 0.01 mm] [mm] [x 0.01 mm] [mm] [x 0.01 mm] [mm] [%]

1 20 0.00 19 90.00 20 0.00 0.100 100

2 20 0.00 19 81.00 19 99.40 0.190 100

3 20 0.00 19 72.00 20 1.00 0.280 100

4 20 1.00 19 63.80 19 99.00 0.372 100

5 19 99.00 19 57.20 19 98.00 0.418 100

6 19 98.00 19 36.50 19 98.50 0.615 100

Delta Ketelitian

[mm] [x 0.01 mm] [mm] [x 0.01 mm] [mm] [x 0.01 mm] [mm] [%]

1 1 1.00 0 98.00 1 1.00 0.030 100

2 1 10.80 0 92.50 1 11.00 0.183 100

3 1 11.00 0 83.50 1 11.00 0.275 100

4 1 11.00 0 68.50 1 8.00 0.425 103

5 1 8.00 0 63.00 1 8.00 0.450 100

6 1 10.80 0 59.00 1 10.00 0.518 101

Posisi 

Beban

Dial Gage-2

Bacaan 1 Bacaan 2 Bacaan 3

Posisi 

Beban

Dial Gage-1

Bacaan 1 Bacaan 2 Bacaan 3

Utara 
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Hari/tanggal : Minggu / 20-6-2010

Waktu: 30.30
Waktu Temp. Api Waktu Dial Delta

File Strain: TES001-013.xlsx TES011 & TES012 (menit) (oC) (menit) (mm) (mm)

5 470 0 22 0

Kondisi: Berangin & Cerah 90 0 30 21.92 0.08

Kelembapan: 57.50% 60 22.28 -0.28

90 22.22 -0.22

Volume Premium: 2.5 ltr

Lama pembakaran: 01.28.45

Bagian Depan Waktu: 00.03.15 s/d 00.05.08

                        24                   25                      26                    27                        28                29

No. Suhu No. Suhu No. Suhu

12 13 14         15      16        17          18         19           20     21            22              23 1 56 11 43 21 42

2 51 12 38 22 40

3 39 13 38 23 38

9 10 11 4 40 14 39 24 36

5 42 15 40 25 36

3 4 5 6 7 8 6 45 16 42 26 40

7 43 17 42 27 40

                1                                               2 8 43 18 42 28 36

9 41 19 42 29 35

10 43 20 42

Bagian Atas Waktu: 00.05.46 s/d 00.15.10

                         29                  30                     31                  32                   33                     34

No. Suhu No. Suhu No. Suhu

1 35 12 52 23 156

                    18         19       20          21        22       23       24          25         26        27      28 2 39 13 51 24 161

3 43 14 48 25 117

4 48 15 44 26 92

5 43 16 40 27 74

                      7           8        9          10           11         12      13            14          15        16            17 6 37 17 38 28 65

7 38 18 41 29 58

8 37 19 45 30 63

                      1                    2                          3                     4                       5                       6 9 38 20 58 31 98

10 55 21 75 32 108

11 48 22 80 33 90

34 54

Kajian keruntuhan..., Rifky Netriady, FTUI, 2012



Hari/tanggal : Minggu / 20-6-2010

Waktu: 30.30
Waktu Temp. Api Waktu Dial Delta

File Strain: TES001-013.xlsx TES011 & TES012 (menit) (oC) (menit) (mm) (mm)

5 470 0 22 0

Kondisi: Berangin & Cerah 90 0 30 21.92 0.08

Kelembapan: 57.50% 60 22.28 -0.28

90 22.22 -0.22

Volume Premium: 2.5 ltr

Lama pembakaran: 01.28.45

Bagian Belakang

Waktu: 00.15.32 s/d 00.29.55

                        24                   25                      26                    27                        28                29

No. Suhu No. Suhu No. Suhu

12 13 14         15      16        17          18         19           20     21            22              23 1 35 11 44 21 50

2 35 12 41 22 46

3 36 13 41 23 40

9 10 11 4 37 14 43 24 40

5 41 15 50 25 45

3 4 5 6 7 8 6 48 16 73 26 62

7 43 17 73 27 66

                1                                               2 8 40 18 74 28 55

9 38 19 75 29 49

10 55 20 60
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Hari/tanggal : Minggu / 20-6-2010

Waktu: 30.30
Waktu Temp. Api Waktu

File Strain: TES001-013.xlsx TES011 & TES012 (menit) (oC) (menit)

5 470 0

Kondisi: Berangin & Cerah 90 0 30

Kelembapan: 57.50% 60

90

Volume Premium: 2.5 ltr

Lama pembakaran: 01.28.45

Bagian Depan

                        24                   25                      26                    27                        28                29

12 13 14         15      16        17          18         19           20     21            22              23

9 10 11

3 4 5 6 7 8

                1                                               2

Bagian Atas

                         29                  30                     31                  32                   33                     34

                    18         19       20          21        22       23       24          25         26        27      28

                      7           8        9          10           11         12      13            14          15        16            17

                      1                    2                          3                     4                       5                       6

Waktu: 00.30.01 s/d 00.34.50

No. Suhu No. Suhu No. Suhu

1 63 11 50 21 49

2 58 12 45 22 47

3 46 13 45 23 45

4 47 14 46 24 43

5 49 15 47 25 43

6 52 16 49 26 47

7 50 17 49 27 47

8 50 18 50 28 43

9 48 19 50 29 42

10 50 20 49

Waktu: 00.35.00 s/d 00.45.00

No. Suhu No. Suhu No. Suhu

1 30 12 136 23 161

2 34 13 132 24 217

3 48 14 105 25 220

4 42 15 98 26 132

5 35 16 95 27 59

6 32 17 90 28 45

7 41 18 104 29 43

8 74 19 140 30 46

9 92 20 180 31 54

10 140 21 238 32 54

11 120 22 244 33 45

34 43
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Hari/tanggal : Minggu / 20-6-2010

Waktu: 30.30
Waktu Temp. Api Waktu

File Strain: TES001-013.xlsx TES011 & TES012 (menit) (oC) (menit)

5 470 0

Kondisi: Berangin & Cerah 90 0 30

Kelembapan: 57.50% 60

90

Volume Premium: 2.5 ltr

Lama pembakaran: 01.28.45

Bagian Belakang

                        24                   25                      26                    27                        28                29

12 13 14         15      16        17          18         19           20     21            22              23

9 10 11

3 4 5 6 7 8

                1                                               2

Waktu: 00.45.52 s/d 01.01.50

No. Suhu No. Suhu No. Suhu

1 35 11 32 21 35

2 35 12 32 22 34

3 34 13 32 23 32

4 34 14 32 24 32

5 62 15 34 25 34

6 63 16 99 26 36

7 33 17 102 27 37

8 33 18 93 28 36

9 32 19 85 29 35

10 41 20 40

Kajian keruntuhan..., Rifky Netriady, FTUI, 2012



Hari/tanggal : Minggu / 20-6-2010

Waktu: 30.30
Waktu Temp. Api Waktu

File Strain: TES001-013.xlsx TES011 & TES012 (menit) (oC) (menit)

5 470 0

Kondisi: Berangin & Cerah 90 0 30

Kelembapan: 57.50% 60

90

Volume Premium: 2.5 ltr

Lama pembakaran: 01.28.45

Bagian Depan

                        24                   25                      26                    27                        28                29

12 13 14         15      16        17          18         19           20     21            22              23

9 10 11

3 4 5 6 7 8

                1                                               2

Bagian Atas

                         29                  30                     31                  32                   33                     34

                    18         19       20          21        22       23       24          25         26        27      28

                      7           8        9          10           11         12      13            14          15        16            17

                      1                    2                          3                     4                       5                       6

Waktu: 01.02.05 s/d 01.07.44

No. Suhu No. Suhu No. Suhu

1 49 11 36 21 35

2 44 12 31 22 33

3 32 13 31 23 33

4 33 14 32 24 33

5 35 15 33 25 33

6 38 16 35 26 33

7 36 17 36 27 33

8 36 18 36 28 33

9 34 19 35 29 33

10 36 20 35

Waktu: 01.07.55 s/d 01.24.33

No. Suhu No. Suhu No. Suhu

1 42 12 70 23 52

2 36 13 79 24 91

3 45 14 67 25 77

4 40 15 35 26 62

5 36 16 34 27 60

6 32 17 32 28 48

7 41 18 40 29 43

8 37 19 35 30 45

9 39 20 39 31 50

10 53 21 87 32 52

11 66 22 52 33 43

34 40

Kajian keruntuhan..., Rifky Netriady, FTUI, 2012



Hari/tanggal : Minggu / 20-6-2010

Waktu: 30.30
Waktu Temp. Api Waktu

File Strain: TES001-013.xlsx TES011 & TES012 (menit) (oC) (menit)

5 470 0

Kondisi: Berangin & Cerah 90 0 30

Kelembapan: 57.50% 60

90

Volume Premium: 2.5 ltr

Lama pembakaran: 01.28.45

Bagian Belakang

                        24                   25                      26                    27                        28                29

12 13 14         15      16        17          18         19           20     21            22              23

9 10 11

3 4 5 6 7 8

                1                                               2

Waktu: 01.24.45 s/d 01.28.45

No. Suhu No. Suhu No. Suhu

1 39 11 32 21 33

2 38 12 32 22 33

3 40 13 32 23 32

4 45 14 32 24 33

5 51 15 33 25 33

6 50 16 40 26 71

7 42 17 60 27 38

8 32 18 150 28 33

9 32 19 181 29 33

10 60 20 73

Kajian keruntuhan..., Rifky Netriady, FTUI, 2012
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